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ChipProg Device Programmers

Introduction

ChipProg is a family of device programmers produced by Phyton, Inc. Microsystems and Development
Tools (hereafter Phyton). All modern ChipProg models are driven via a personal computer USB ports.
This line of Phyton programmers has an universal software — ChipProgUSB — that controls all the USB
hosted models available now and those are planned to be introduced soon. The ChipProg programmers
support thousands of programmable memory devices, including EPROM, EEPROM, FLASH, NVRAM
and OTP; programmable microcontrollers and logical devices: PAL, PLD and CPLD. The family includes
four models shown below: ChipProg-48 and ChipProg-40 (top row), ChipProg-G4 and ChipProg-ISP
(bottom row). New ChipProg models will be released soon.

The ChipProg-48 and ChipProg-40 programmers are intended for engineering and small volume
manufacturing. These models allow operating on the devices before they are installed in the equipment
(parallel programming) as well as on the devices already installed in the user's equipment (the method
known as In-System Programming, or ISP, that uses serial data transmission into the programmable
device). The ChipProg-ISP is a low-cost programmer for engineering, field service and manufacturing
uses. The ChipProg-G4 is a gang programmer intended for small and middle-volume production; it has
four programming sockets.

The ChipProgUSB software is intuitive and easy-to-use. See the User Interface topics. The software
package includes an embedded script language that enables the automation of many routine operations —

see the ScriptFiles.

The ChipProgUSB software runs on the IBM PC hardware platform under the control of several

© 2009 Phyton, Inc. Microsystems and Development Tools
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Windows™ versions (see the System requirements).

1.1 Terms and Definitions

Terms used in the document
Target device or Target  The device to be programmed by a programmer either in the programmer
socket or by an additional adapter or by a cable for in-system
programming.

Start and End Addresses A range of the device physical memory for the programming operations

(of the Target device) (Read, Write, Verify, etc.).
Device package or Mechanical characteristics of the target device; ChipProg programmers
Package enable operations on the devices packed in the DIP (DIL) packages with no

additional adapters as well as on most non-DIP packed devices, including
but not limited to the devices in the PLCC, SOIC, SSOP, TSOP, SSOP,
QFP, BGA, QNF and other packages.

Programming socket or A socket installed on a programmer unit or on an adapter (see below) to

Programming ZIF socket accommodate the target device for programming. All ChipProg models use

or ZIF socket ZIF (or Zero Insertion Force) programming sockets that allow for the
temporary installation of the target device in the programmer site and easily
removing it after completing the programming procedure.%CPN%>-40,
ChipProg-48 and ChipProg-G4 are equipped with 40- and 48-pin ZIF
sockets allowing operation on any DIP-packed devices with different
numbers of leads and different widths and also connecting additional
adapters for programming devices in other packages.

Adapter or Package A small transition board with dual-in-line rows of pins pluggable into the

adapter programmer ZIF socket on the bottom side and with a package-specific ZIF
socket (TSOP, PLCC, etc.) on the top. The adapters for in-system
programming by means of the parallel programmers are implemented as
ribbon cables that connect to the target board via a special header. The
adapter boards can carry passive components (ZIF sockets, pins and
cables) and active components (drivers, latches, transistors, etc.).
Hundreds of Phyton brand adapters as well as third party adapters are
available to support devices in most types of mechanical packages.

File In the ChipProg context the term file may represent: a) an image of
information on a PC hard drive or other media that is supposed to be
written into the target device’s physical memory or b) an image read out
from the target device and then stored on the disk or other media. Files in a
ChipProg can be loaded from and saved on a PC hard drive or CD.

Buffer or Memory buffer A memory segment, physically assigned from the computer operational
memory (RAM), for temporarily storing, editing and displaying the data to
be physically written to the target device’s memory or read out from the
device. The program allows opening an unlimited number of buffers of any
size while it is not restricted by the computer memory.

© 2009 Phyton, Inc. Microsystems and Development Tools
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Buffer layer or sub-layer

Buffer size
Buffer start address

Checksum

Parallel or In-socket
programming

ICP or in-circuit
programming
ISP or in-circuit

programming

ISP Mode

ISP JTAG Mode

ISP HV Mode

Project

A buffer may have a few layers (in some topics also known as sub-layers)
that are defined by a particular architecture and memory model of the
target device. For example, for some microcontrollers one buffer can
include the code and data memory layers (see more details below).

The buffers may have different sizes from 128KB to 32GB each.
The address to display the buffer contents from.

An arithmetic sum of the data located within a specified part of the buffer
calculated by the programmer to control the data integrity. The program
enables different algorithms for the checksum calculation and enables
writing the checksum into a specified location of the target device.

Operations on a device being placed into the programmer’s ZIF socket or
into a programming adapter (opposite to the in-system programming
below).

Programming devices mounted on the boards (in the user’'s equipment) via
special adapter-cable connecting the programmer to the target.

Same as above. Programming devices mounted on the boards (in the
user’s equipment) via special adapter-cable connecting the programmer
with the target.

Mode of the in-system programming that is usually defined by the
programming signals voltage or the ISP interface (JTAG, UART, SPI, etc.).
Distinct ISP modes are enabled for different target devices and more than
one mode may exist for one device.

In-system programming via a JTAG interface.

In-system programming that requires applying a relatively high voltage to
the target device, (12V for example).

An integrated set of information in the ChipProgUSB that completely
describes the target device, properties of the data buffers, programming
options and settings, list of the source and destination files with all their
properties, etc.. Each project that has its own unique name can be stored
and promptly reloaded for immediate execution. Usually a user creates a
project to work with one type of device. Working with projects saves a lot of
time for the initial configuration of the programmer every time you start
working with a new device.

File - Buffer - Target structure
Buffers are intermediate layers between the data in files and the data in the target device. The
ChipProg enables no direct interaction between the files and target devices. All the file operations,
such as loading and saving files are applicable to the buffers only. All the physical manipulations with
the target device memory content pass through the buffers as well. This is a fundamental principle of

© 2009 Phyton, Inc. Microsystems and Development Tools
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1.2

the programmer operations with data and devices
Examples of the buffer's layer structures of different devices:

1. In the Intel 87C51FA microcontroller each opened buffer includes two layers: Code and
Encryption table.

2. In the Microchip PIC16F84 microcontroller each opened buffer includes three layers: Code, Data
EEPROM and Identifier locations.

Each buffer layer can be opened for watching or editing by clicking its tab on the top of the buffer
window.

System Requirements

To run ChipProgUSB and to control a ChipProg programmer, you need an IBM PC-compatible computer
with the following components:

Pentium-111 CPU or higher

Windows 98/2000/XP/Vista OS for the ChipProg-48, ChipProg-40 and ChipProg-ISP programmers
Windows 2000/XP/Vista for the ChipProg-G4 programmer

256MB of RAM

At least one USB port

A hard drive with at least 200MB of free space

© 2009 Phyton, Inc. Microsystems and Development Tools



12

ChipProg Device Programmers

2

2.1

ChipProg Family Brief Description

The Phyton family of the ChipProg programmers at the moment of making this Help Manual included:

¢ ChipProg-48
¢ ChipProg-40
¢ ChipProg-G4
e ChipProg-ISP

New ChipProg programmer models will be added soon.

Comparisson matrix

Programmer Model

ChipProg-G4

ChipProg-48

ChipProg-40

ChipProg-ISP

Major features

Primarily intended for

Production and chip
replication

Engineering and low
volume production

Engineering and low
volume production

Engineering, low
volume production
and field service

Method of writing /

Multi-site, concurrent,

Single-site, parallel,

Single-site, parallel,

Single-site, serial, in

third party adapters

third party adapters

third party adapters

reading information parallel, in socket in socket in socket system

Target devices FLASH,EPROM, FLASH,EPROM, FLASH,EPROM, FLASH,EEPROM,
EEPROM,NVRAM, EEPROM,NVRAM, EEPROM,NVRAM, MCU with ISP
MCU,PLD MCU,PLD MCU capability only

Universality in terms of Yes Yes Yes Yes

the target support

PC interface USB,2.0 USB,2.0 USB,2.0 USB,2.0

Multi-programming mode, | Yes, Yes, Yes, Yes,

Number of programmers | Unlimited Unlimited Unlimited Unlimited

driven from one PC

PC interface USB,2.0 USB,2.0 USB,2.0 USB,2.0

Programming socket or 4 by 48 pin, DIL 48pin, DIL 40pin, DIL Programming cable,

cable 14 pin max

Adapters availability Phyton brand and Phyton brand and Phyton brand and Phyton brand cables

Software update

Lifetime free of
charge

Lifetime free of
charge

Lifetime free of
charge

Lifetime free of
charge

Technical characteristics

Built-in microcontroller,
Fclk

Yes, 32-bit, 60 MHz

Yes, 32-bit, 60 MHz

Yes, 32-bit, 60 MHz

Yes, 8-bit, 10 MHz

Built-in FPGA, Fclk

Yes, up to 100 MHz

Yes, up to 100 MHz

Yes, up to 100 MHz

Yes, up to 10 MHz

Logical pin drivers

Universal,
1.8V to 5.5V

Universal,
1.8V to 5.5V

Universal,
1.8V to 5.5V

Universal,
1.8V to 5.5V

Analog drivers

Universal, 10-bitDAC

Universal, 10-bit
DAC

Not universal

Not universal

Adjustability of the write
impulses edges’ slopes

Yes

Yes

Yes

Yes
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2.2

Capability to support new
target devices

Unlimited

Unlimited

Limited by
implementation ofthe
analog drivers

Limited by
implementation of the
analog drivers

In-system programming | Yes, with additional | Yes, with additional | Yes, with additional | Yes
capability cables cables cables

Chip insertion auto detect | Yes Yes Yes No
capability

Correct chip insertion Yes Yes Yes Yes
testing

Checking bad contact in Yes Yes Yes No
the programming socket

Project management by Yes Yes Yes No
the software shell

Serialization of the Yes Yes Yes No
programmed devices

Writing signatures into Yes Yes Yes No
the programmed devices

Logging programming Yes Yes Yes No

sessions to files

Host computer and
operation system

IBMPC, Windows
2000/XP/Vista

IBMPC, Windows
98/ME/
2000/XP/Vista

IBMPC, Windows
98/ME/
2000/XP/Vista

IBMPC, Windows
98/ME/
2000/XP/Vista

Compare the programming + verification time for the selected devices (min:

sec)

M25P20 00:07
SST39VF016Q 00:45 00:45 00:45 02:50
MX28F640C3BB 00:56 00:56 00:56 02:27
MX29LVO17A 00:23 00:23 00:23 02:56
MX29LV160CT 00:16 00:16 00:16 01:17
SST49LFO008A 00:19 00:19 00:19 01:43
PIC18LF8722 00:11 00:11 00:11 00:19
AT89S51 00:01 00:01 00:01 00:01
ChipProg-48

The ChipProg-48 universal programmer can be effectively used for both engineering and low-volume
manufacturing. It supports in-socket and in-system programming of thousand of devices and has no
valuable limitations in supporting future devices. The unlimited future device support differs ChipProg-48
from the simplified and less expensive ChipProg-40 model.
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221

The programmer has a 48-pin DIP ZIF socket that enables inserting any wide or narrow DIP-packed
devices with up to 48 leads without the necessity to use any additional adapters. Programming of other
devices requires the use of additional adapters available from Phyton and a few selected vendors. The
programmer has three LEDs for displaying the programming status (“Good”, “Busy”, “Error”) and the
“Start” button for fast launch of the pre-programmed command chains. The palm-size programmer has a
wall-plugged power adapter that is not shown on the picture above.

Standard package contents:

One programmer unit

One power adapter 12V/1A+

One USB link cable

One CD with the ChipProgUSB software

Optionally the package may include one or more programming adapters (if ordered with the programmer)
and a “QuickStart” printed manual. See also for more details:

Major features
Hardware characteristics

Software features

Major features

1. Equipped with a 48 pin ZIF socket that allows insertion of the DIP-packed devices with the package
width from 300 to 600 mil (7.62 to 15.24 mm) and the number of leads up to 48 without additional
adapters.

. Links to a PC USB 2.0 compatible port, e.g. slower USB connection is also supported.

3. Provides fast programming; for example, completely writes a 64M bit NOR FLASH in less than 50

sec.

N
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. Can program target devices in the programmer ZIF socket as well as the devices installed in the

equipment (ISP mode).

. An unlimited number of ChipProg-48 tools can be driven from multiple USB ports of one computer (or

via a USB hub) to provide concurrent programming of multiple devices of the same type.

. Has a button for fast manual launch of any single operation or a bunch of operations.
. Has three LEDs for displaying the programming status (“Good”, “Busy”, “Error”).

2.2.2 Hardware characteristics

1.

8.
9.

The programmer has a 48-pin ZIF socket with a lever that enables the insertion and clamping of any
DIP-packed devices with the package width from 300 to 600 mil (7.62 to 15.24 mm) and with the
number of leads up to 48.

. Adapters for programming devices in the SDIP, PLCC, SOIC, SOP, PSOP, TSOP, TSOPII, TSSOP,

QFP, TQFP, VQFP, QFN, SON, BGA, CSP and other packages are available from Phyton and many
third parties.

. The programmer is built on the base of a very fast and productive 32-bit embedded microcontroller and

FPGA. These resources allow adding new targets to the device list by a simple software update.

. Most timing-critical parts of the programming algorithms are implemented on the FPGA devices and

do not involve any operations on the embedded microcontroller that would slow down the programming
speed.

. Implementation in the FPGA devices logical drivers enables outputting logical signals of any level (low,

high, Pullup, Pulldown and external clock generator) to any pin of the programming ZIF socket.

. The tool hardware features 10-bit digital-to-analog converters for accurate settings of the analog

signals.

. The tool hardware enables accurate programming of the rising and falling edges of the generated

analog signals.

The tool hardware automatically adjusts the generated analog signals.

The generated analog signals for both the target supplying and programming can be outputted to any
pins of the device being programmed.

10.The tool hardware can connect any pin of the device being programmed to the “Ground” level.
11.The tool hardware checks if every pin of the target device is reliably fixed by a ZIF socket’s contacts

(“bad contact” checking).

12.The tool hardware protects itself and the target device against incorrect insertions and other issues

that cause a sharp increase in the currents though the target device circuits. This “over current”
protection is very fast and reliable.

13.The target device pins are protected against the electrostatic discharge.
14.The tool's hardware has a programmable clock generator.
15.The self-testing procedure automatically executes at any time the programmer is powered on.

2.2.3 Software features

N

. Works under control of Windows 95/98/ME/2000/XP/Vista.
. Friendly, intuitive graphic user interface.
. Includes a set of basic commands: Blank Check, Erase, Read, Write, Verify, Lock, Set Configuration

Bits, Data Memory Support, etc., executed by a single mouse click or via menu.

. Enables programming a batch of the commands above executed one after one either by a manual

start or by a mouse click or automatically upon the device insertion into the programming socket.

. Allows serialization of the programming devices with auto incrementing the device numbers and

storing a serialization log.

. The program can calculate checksums of the selected data array and then write the checksum into a

specified memory location of the target device. Several methods of the checksum calculation can be
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2.3

used.

7. The program allows writing a unique signature into a specified memory location of the target device for

the device identification.

. Project support speeds up and simplifies switching between different programming tasks.

9. The software allows pre-programming a particular operation (or a chain of operations), which is
supposed to be automatically triggered when the programmer hardware detects insertion of the target
device into the programming socket.

10. An unlimited number of memory buffers can be opened in the main ChipProgUSB window.

11. The software supports a multiple programming mode for concurrent programming of the same type of
target devices on the same type of programmers connected to one cluster. The cluster size has no
influence on the programming speed.

12. The software includes a full-scale binary editor allowing manual modification of the data in buffers as
well as such helpful functions as Search and Replace, Fill, Compare, Copy, Invert, Calculate
Checksum, and OR, AND, XOR logical operations on the blocks of data.

13. Loading and saving files in several standard and proprietary formats: Binary, Standard Extended Intel
HEX, Motorola S-record, POF, JEDEC, PRG, Holtek OTP, ASCII HEC, ASCII OCTAL, Angstrem
SAV. Special non-standard formats can be added on request.

14. The software is featured by a script language and a mechanism of handling the script scenarios for
automation of the routine operations and chip replications.

[00]

ChipProg-40

The ChipProg-40 universal programmer can be effectively used for both engineering and low-volume
manufacturing. It supports in-socket and in-system programming of thousand of devices. The
programmer hardware has some limitations for supporting certain devices. It does not support any PLDs.
This is a difference between the cheaper ChipProg-40 and the enhanced ChipProg-48 model.
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The programmer has a 40-pin DIP ZIF socket that enables inserting any wide or narrow DIP-packed
devices with up to 40 leads without the necessity to use any additional adapters. Programming of other
devices requires use of additional adapters available from Phyton and a few selected vendors. The
programmer has three LEDs for displaying the programming status (“Good”, “Busy”, “Error”) and the
“Start” button for fast launch of the pre-programmed command chains. The palm-size programmer has a
wall-plugged power adapter that is not shown on the picture above.

Standard package contents:

e One programmer unit

e One power adapter 12V/1A+

e One USB link cable

e One CD with the ChipProgUSB software

Optionally the package may include one or more programming adapters (if ordered with the programmer)
and a “QuickStart” printed manual. See also for more details:

Major features
Hardware characteristics

Software features

2.3.1 Major features

1.

N

Equipped with a 40 pin ZIF socket that allows insertion of any DIP-packed devices with the package
width from 300 to 600 mil (7.62 to 15.24 mm) and the number of leads up to 40 without additional
adapters.

. Links to a PC USB 2.0 compatible port, e.g. slower USB connection is also supported.
. Provides fast programming; for example, completely writes a 64M bit NOR FLASH in less than 50

SecC.

. Can program target devices in the programmer ZIF socket as well as the devices installed in the

equipment (ISP mode).

. An unlimited number of ChipProg-40 tools can be driven from multiple USB ports of one computer (or

via a USB hub) to provide concurrent programming of multiple devices of the same type.

. Has a button for fast manual launch of any single operation or a batch of operations.
. Has three LEDs for displaying the programming status (“Good”, “Busy”, “Error”).

2.3.2 Hardware characteristics

1.

The programmer has a 40-pin ZIF socket with a lever that enables the insertion and clamping of any
DIP-packed devices with the package width from 300 to 600 mil (7.62 to 15.24 mm) and with the
number of leads up to 40.

. Adapters for programming devices in the SDIP, PLCC, SOIC, SOP, PSOP, TSOP, TSOPII, TSSOP,

QFP, TQFP, VQFP, QFN, SON, BGA, CSP and other packages are available from Phyton and many
third parties.

. The programmer is built on the base of a very fast and productive 32-bit embedded microcontroller and

FPGA. These resources allow adding new targets to the device list by a simple software update.

. Most timing-critical parts of the programming algorithms are implemented on the FPGA devices and

do not involve any operations on the embedded microcontroller that would slow down the programming
speed.

. Implementation in the FPGA devices logical drivers enables outputting logical signals of any level (low,

high, Pullup, Pulldown and external clock generator) to any pin of the programming ZIF socket.

. The tool hardware features 10-bit digital-to-analog converters for accurate settings of the analog

signals.
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2.3.3

2.4

7. The tool hardware enables accurate programming of the rising and falling edges of the generated
analog signals.

8. The tool hardware automatically adjusts the generated analog signals.

9. The generated analog signals for both the target supplying and programming can be outputted to any
pins of the device being programmed.

10. The tool hardware can connect any pin of the device being programmed to the “Ground” level.

11. The tool hardware checks if every pin of the target device is reliably fixed by a ZIF socket’s contacts
(“bad contact” checking).

12. The tool hardware protects itself and the target device against incorrect insertions and other issues
that cause a sharp increase in the currents through the target device circuits. This “over current”
protection is very fast and reliable.

13. The target device pins are protected against the electrostatic discharge.

14. The tool's hardware has a programmable clock generator.

15. The self-testing procedure automatically executes at any time the programmer is powered on.

Software features

[ERN

. Works under control of Windows 95/98/ME/2000/XP/Vista.

. Friendly, intuitive graphic user interface.

3. Includes a set of basic commands: Blank Check, Erase, Read, Write, Verify, Lock, Set Configuration
Bits, Data Memory Support, etc., executed by a single mouse click or via menu.

4. Enables programming a batch of the commands above executed one after one by a manual start, by a
mouse click or automatically upon the device insertion into the programming socket.

5. Allows serialization of the programming devices with auto incrementing the device numbers and
storing a serialization log.

6. The program can calculate checksums of the selected data array and then write the checksum into a
specified memory location of the target device. Several methods of the checksum calculation can be
used.

7. The program allows writing a unique signature into a specified memory location of the target device for

the device identification.

. Project support speeds up and simplifies switching between different programming tasks.

9. The software allows pre-programming a particular operation (or a chain of operations), which is
supposed to be automatically triggered when the programmer hardware detects insertion of the target
device into the programming socket.

10. Unlimited number of memory buffers can be opened in the main ChipProgUSB window.

11. The software supports a multiple programming mode for concurrent programming of the same type of
target devices on the same type of the programmers connected to one cluster. The cluster size has
no influence on the programming speed.

12. The software includes a full-scale binary editor allowing manual modification of the data in buffers as
well as such helpful functions as Search and Replace, Fill, Compare, Copy, Invert, Calculate
Checksum, and OR, AND, XOR logical operations on the blocks of data.

13. Loading and saving files in several standard and proprietary formats: Binary, Standard Extended Intel
HEX, Motorola S-record, POF, JEDEC, PRG, Holtek OTP, ASCII HEC, ASCII OCTAL, Angstrem
SAV. Special non-standard formats can be added on request.

14. The software is featured by a script language and a mechanism of handling the script scenarios for

automation of the routine operations and chip replications.

N

[00]

ChipProg-G4

The ChipProg-G4 is a 4-site gang programmer based on four ChipProg-48 tools enclosed in one case
and driven from the ChipProgUSB software. It is intended for middle- and low-volume manufacturing. It
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supports in-socket and in-system programming of thousand of devices and has no valuable limitations for
supporting future devices.

Standard package contents:

One programmer unit

One power cable

One USB link cable

One CD with the ChipProgUSB software

Optionally the package may include one or more programming adapters (if ordered with the programmer)
and a “QuickStart” printed manual. See also for more details:

Major features
Hardware characteristics

Software features

2.4.1 Major features

1.

N

Based on four ChipProg-48 tools enclosed in one case and connected to a PC via an embedded USB
hub.

. Allows independent and concurrent programming of up to four devices of the same type.
. 48 pin ZIF sockets allow insertion of any DIP-packed devices with the package width from 300 to 600

mil (7.62 to 15.24 mm) and the number of leads up to 48 without additional adapters.

. Links to a PC USB 2.0 compatible port via one link cable.
. Provides fast programming; for example, completely writes a 64M bit NOR FLASH in less than 50

SecC.

. Can program target devices in its socket as well as devices installed in the equipment (ISP mode).
. Each programming site has a 'Start' button for fast manual launch of any single operation or a batch of

operations.

. Each programming site has three LEDs for displaying the programming status (“Good”, “Busy”,

“Error”).
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2.4.2 Hardware characteristics

[N

. Enclosed in a durable steel case to be used in an industrial environment.

. The tool gets power from a standard outlet 110-240V, 50-60 Hz.

3. Each programming site based on a single ChipProg-48 programmer has a 48-pin ZIF socket with a
lever that enables the insertion and clamping of any DIP-packed devices with the package width from
300 to 600 mil (7.62 to 15.24 mm) and with the number of leads up to 48.

4. Adapters for programming devices in the SDIP, PLCC, SOIC, SOP, PSOP, TSOP, TSOPII, TSSOP,
QFP, TQFP, VQFP, QFN, SON, BGA, CSP and other packages are available from Phyton and many
third parties.

5. Single ChipProg-48 programmers inside of the tool enclosure are connected to an embedded USB 2.0
hub

6. Each programming site is built on the base of a very fast and powerful 32-bit embedded
microcontroller and FPGA. These resources allow adding new targets to the device list by a simple
software update.

7. Most timing-critical parts of the programming algorithms are implemented on the FPGA devices and
do not involve any operations on the embedded microcontroller that would slow down the programming
speed.

8. Implementation in the FPGA devices logical drivers enable outputting logical signals of any level (low,
high, Pullup, Pulldown and external clock generator) to any pin of the programming ZIF socket.

9. The tool hardware features 10-bit digital-to-analog converters for accurate settings of the analog
signals.

10. The tool hardware enables accurate programming of the rising and falling edges of the generated
analog signals.

11. The tool hardware automatically adjusts the generated analog signals.

12. The generated analog signals for both the target supplying and programming can be outputted to any
pins of the device being programmed.

13. The tool hardware can connect any pin of the device being programmed to the “Ground” level.

14. The tool hardware checks if every pin of the target device is reliably fixed by a ZIF socket’s contacts
(“bad contact” checking).

15. The tool hardware protects itself and the target device against incorrect insertions and other issues
that cause a sharp increase in the currents though the target device circuits. This “over current”
protection is very fast and reliable.

16. The target device pins are protected against the electrostatic discharge.

17. The tool's hardware has a programmable clock generator.

18. The self-testing procedure automatically executes at any time the programmer is powered on.

N

2.4.3 Software features

[N

. Works under control of Windows 2000/XP/Vista.

2. Friendly, intuitive graphic user interface allows monitoring the programming sites statuses and can
zoom in on operations on each of four programming sites.

3. Includes a set of basic commands: Blank Check, Erase, Read, Write, Verify, Lock, Set Configuration
Bits, Data Memory Support, etc., executed by a single mouse click or via menu.

4. Enables programming a batch of the commands above and executed one after one by a manual start,
by a mouse click or automatically upon the device insertion into the programming socket.

5. Allows serialization of the programming devices with auto incrementing the device numbers and
storing a serialization log.

6. The program can calculate checksums of the selected data array and then write the checksum into a
specified memory location of the target device. Several methods of the checksum calculation can be
used.

7. The program allows writing a unique signature into a specified memory location of the target device for

the device identification.
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8. Project support speeds up and simplifies switching between different programming tasks.

9. The software allows pre-programming a particular operation (or a chain of operations), which is
supposed to be automatically triggered when the programmer hardware detects insertion of the target
device into the programming socket.

10. Unlimited number of memory buffers can be opened in the main ChipProgUSB window for each of
four programming sites.

11. The software includes a full-scale binary editor allowing manual modification of the data in buffers as
well as such helpful functions as Search and Replace, Fill, Compare, Copy, Invert, Calculate
Checksum, and OR, AND, XOR logical operations on the blocks of data.

12. Loading and saving files in several standard and proprietary formats: Binary, Standard Extended Intel
HEX, Motorola S-record, POF, JEDEC, PRG, Holtek OTP, ASCII HEC, ASCII OCTAL, Angstrem
SAV. Special non-standard formats can be added on request.

13. The software is featured by a script language and a mechanism of handling the script scenarios for
automation of the routine operations and chip replications.

2.5 ChipProg-ISP

The ChipProg-ISP is a low-cost universal programmer specifically created for programming devices
without removing them from the equipment where they are installed. This type of programming is known
as “in-system” or “in-circuit”. The ChipProg-ISP supports serial EPROM and EEPROM flash memory
devices and embedded microcontrollers with the code and data memory programmable via different
types of serial ports: UART, JTAG, SPI and other types, including proprietary interfaces.

The programmer has three LEDs for displaying the programming status (“Good”, “Busy”, “Error”) and the
“Start” button for fast launch of the pre-programmed command chains. The tool shown on the picture is
very small and requires no power adapter for the operations - it gets power from the USB computer port.

Connecting ChipProg-ISP to the target

The programmer has a 14-pin output connector BH-14R. A variety of Phyton adapting cables allow
connecting to the target. A simple pin-to-pin ribbon cable is supplied with the programmer by default,
and other cables (adapters) can be ordered on demand. The BH-14R connector output information
signals for the chip programming and some service signals that enable using the programmer in the
automated programming and testing equipment. See the BH-14R pinout:
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ChipProg-ISP BH-
14R connector Logical signal

1 Target specific*
2 Target specific*
3 Target specific*
4 Target specific*
5 Target specific*
6 Target specific*
7 Target specific*
8 Target specific*
9 GND

10 Target specific*
11 /Start

12 [Error

13 /Good

14 /Busy

Signals on the pins #1 to #9 and on the pin #10 are used for transmitting and receiving information and
synchro impulses to and from the target device. These signals are target specific and depend on the
type of target device or a family in general (AVR, PIC, etc.) - see here. They also are shown in the
adapters wiring diagrams; see the file adapters.chm included in the ChipProgUSB set.

The pin #9 must be connected to the target's ground.
The signals on the output pins #12, #13 and #14 represent the programmer statuses - logical '0' means
an active status, logical '1' - passive. E.g.:

/Error — the operation has failed;
/Good — the operation completed successfully;
/Busy — the programmer is in a process of executing some operation.

An active signal on the input pin #11 (log.'0") starts the preset operation, the device programming by
default. Activation of this signal, e.g. a falling edge, is equivalent to pushing the "Start" button on the
programmer.

Read also In-System Programming for different devices.

Standard package contents:

One programmer unit

One universal ribbon cable wired pin-to-pin
One USB link cable

One CD with the ChipProgUSB software
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Optionally the package may include one or more programming cable-adapters (if ordered with the
programmer) and a “QuickStart” printed manual. See also for more details:

Major features
Hardware characteristics

Software features

25.1 Major features

. Has a 14 pin socket for connecting to the target equipment by means of several cable-adapters.

. Protects itself and the target equipment against incorrect wiring.

. Links to a PC USB 2.0 compatible port, e.g. slower USB connection is also supported.

. An unlimited number of ChipProg-ISP tools can be driven from multiple USB ports of one computer (or
via a USB hub) to provide concurrent programming of multiple devices of the same type.

. Has a button for fast manual launch of any single operation or a batch of operations.

. Has three LEDs for displaying the programming status (“Good”, “Busy”, “Error”).

A OWDNP

o Ol

2.5.2 Hardware characteristics

[N

. Has a standard 14 pin connector.

. Adapters for programming devices with in-system programming capability.

3. The programmer is built on the base of a very fast and productive 32-bit embedded microcontroller and
FPGA devices. These resources allow adding new targets to the device list by a simple software
update.

4. Most timing-critical parts of the programming algorithms are implemented on the FPGA devices and
do not involve any operations on the embedded microcontroller that would slow down the programming
speed.

5. Implementation in the FPGA devices logical drivers enable outputting logical signals of any level (low,
high, Pullup, Pulldown and external clock generator) to any pin of the programming connector.

6. The tool hardware features 10-bit digital-to-analog converters for accurate settings of the analog
signals.

7. The tool hardware enables accurate programming of the rising and falling edges of the generated
analog signals.

8. The tool hardware automatically adjusts the generated analog signals.

9. The generated analog signals for both the target supplying and programming can be outputted to any
pins of the device being programmed.

10. The tool hardware protects itself and the target device against incorrect connection.

11. The target device pins are protected against the electrostatic discharge.

12. Can be started from the external signal.

13. Three status signals “Good”, “Busy”, “Error” are outputted to the programmer connector.

14. The self-testing procedure automatically executes at any time the programmer is powered on.

N

2.5.3 Software features

1. Works under control of Windows 95/98/ME/2000/XP/Vista.

. Friendly, intuitive graphic user interface.

3. Includes a set of basic commands: Blank Check, Erase, Read, Write, Verify, Lock, Set Configuration
Bits, Data Memory Support, etc., executed by a single mouse click or via menu.

4. Enables programming a batch of the commands above executed one after one by a manual start, by a
mouse click or automatically upon the device insertion into the programming socket.

5. Allows serialization of the programming devices with auto incrementing the device numbers and

N
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storing a serialization log.

6. The program can calculate checksums of the selected data array and then write the checksum into a
specified memory location of the target device. Several methods of the checksum calculation can be
used.

7. The program allows writing a unique signature into a specified memory location of the target device for

the device identification.

. Project support speeds up and simplifies switching between different programming tasks.

9. The software allows pre-programming a particular operation (or a chain of operations), which is
supposed to be automatically triggered when the programmer hardware detects insertion of the target
device into the programming socket.

10. Unlimited number of memory buffers can be opened in the main ChipProgUSB window.

11. The software supports a multiple programming mode for concurrent programming of the same type of
target devices on the same type of the programmers connected to one cluster. The cluster size has
no influence on the programming speed.

12. The software includes a full-scale binary editor allowing manual modification of the data in buffers as
well as such helpful functions as Search and Replace, Fill, Compare, Copy, Invert, Calculate
Checksum, and OR, AND, XOR logical operations on the blocks of data.

13. Loading and saving files in several standard and proprietary formats: Binary, Standard Extended Intel
HEX, Motorola S-record, POF, JEDEC, PRG, Holtek OTP, ASCII HEC, ASCII OCTAL, Angstrem
SAV. Special non-standard formats can be added on request.

14. The software is featured by a script language and a mechanism of handling the script scenarios for
automation of the routine operations and chip replications.

[00]
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3 Quick Start

This chapter includes the topics that describe:

How to install the ChipProgUSB software
How to install the ChipProg USBdrivers

How to install the ChipProg hardware and to start up the ChipProg programmers of different type.

Itis highlyrecommended to read all the manual basic topics included in the chapters Graphical User
Interface and Operating with ChipProg programmers before starting to use the tool.

It is assumed that you are an experienced user of MS Windows and basic Windows operations.
3.1 Installing the ChipProgUSB Software

Insert the distributive ChipProgUSB disc into a CD drive of your PC, click the install button and then follow the
series of prompts that will lead you through the installation process.

Accept the terms of license agreement
E,-, Phyton ChipProgLPT Programmer v. 4.53.00 Installation LI

License Agreement

Fleaze read the following license agreement carefully.

MOTICE: -~
Phiytan licenses the accompanying software to you only upon the condition that you accept all of the
terms contained in this license agreement. Please read the terms carefully before continuing

inztallation, as prezsing the "yes'" buttar will indicate your azsent ta them. IF you do nat agree to

these termz, pleaze press the "no’' button to exit install.

LICEMSE AMND WARBAMT Y ll

% | accept the terms of the license agreement

| do not accept the tems of the license agresment

s

Choose the folder to install
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-E,-, Phyton ChipProgLPT Programmer v. 4.53.00 Installation il

Installation Folder

Fleaze choose the folder ta inztall Phyton ChipProglPT Programmer below. | the folder specified does not
exist, it will be created.

Falder:

[E g | [

Wait for installation...
-_"3.—';» Phyton ChipProgLPT Programmer v. 4.53.00 Installation llil

Inztallation Progress

C:%Program FileshChipproglpth4_53 00MD rivershestB9re. div
I 63%

Dizk zpace uzed: 15,984,378 Butes

Phyton ChipProgUSB folder

At the end the installer will create a folder with ChipProgUSB tools' and documents' shortcuts:
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fAl Adapters Connection List

Rt ChipProglISB On-Line Help

@ Phyton ChipProglISE

@ Phyton ChipProgUSE — Gang Mode

[#f Phyton ChipProgUSE Demo

|'_a7|_. Phyton WEB site

Ifﬁ] Revision History

@Uninstall Phyton ChipProgUSE Programmer

Phyton Programming Adapter List - opens the adapters.chm file that list all the Phyton
programming adapters with their short descriptions and wiring diagrams.

ChipProgUSB On-Line Help - opens the programmer on-line Help document.

Phyton ChipProgUSB - invokes the ChipProgUSB executable file and starts operations for the
ChipProg-48, ChipProg-40 and ChipProg-ISP programmers working in a single programming mode.

Phyton ChipProgUSB -- Gang Mode - invokes the ChipProgUSB executable file and starts
operations for the ChipProg -G4 gang programmer or the ChipProg-48, ChipProg-40 and ChipProg-ISP
programmers working in a multiprogramming mode.

Phyton ChipProgUSB Demo - invokes a demo version of the ChipProgUSB software that allows
evaluating the product without its hardware.

Phyton WEB site - opens an Internet browser with the www.phyton.com website.

RevisionHistory - opens the ChipProgUSB versions history file.

Uninstall Phyton ChipProgUSB Programmer - starts a process of removing the ChipProgUSB
program from your computer.

3.2 Installing the USB Drivers

In a process of the ChipProgUSB software installation from a distributive disc the program installs the drivers
for the USB devices used in all types of the ChipProg programmers working under control of the Windows
2000/XP/Vista operating systems. Only the ChipProg-48, ChipProg-40 and ChipProg-ISP
programmers working under control of the and hardware which work under control of the Windows 98/ME
operating systems require the USB drivers to be installed after the software installation is completed.
The guidelines below are for the Windows 98/ME operating systems only.

To invoke the USB drivers installation procedure connect a ChipProgUSB to the USB port of your computer
via the included USB cable. You should see the Found New Hardware Wizard dialog:
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Found Hew Hardware Wizard

%

Welcome to the Found New
Hardware Wizard

Windows will search for cument and updated software by
loaking an your computer, on the hardware installation CD, or on
the Windows Update Web site fwith your permission).

Bead our privacy policy

Can Windows connect to Windows Update to search for
software?
™ Yes, this time only

™ Yes, now and every time | connect a device

Click Mext to continue.

< Back I Next > I Cancel

Select the 'No, not this time' option and click the Next button. The wizard below will appear:

Found Mew Hardware Wizard

5

Thig wizard helps you install software for:

FTDI FTBUZK Device

£ l'j i your hardware came with an installation CD

-

~ai= or floppy disk. insert it now.

‘What do you want the wizard to da?

" Install the software automatically (Recommended)
' Install from a list or speciic location (Advanced)

Click Next to continue.

< Back Mext = Cancel

Select the 'Install from a list or specific location' option and click the Next button. The screen below will

appear:
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Found Hew Hardware Wizard

Please choose your search and installation options.

& Search forthe best driver in these locations.

Use the check boxes below to limit or expand the default seanch, which includes local
paths and removable media. The best driver found will be installed.

[" Search removable media floppy, CO-ROM..)
¥ Include this location in the search:

|D:"-.DHIVEF-:S.USB =] Browse |

" Dont search. | will choose the driverto install.

Choose this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

< Back Next > Cancel |

Browse to the DRIVERS.USB folder on the Phyton CD and click the Next button (certainly the drive letter can
be other than D:). This will start the drivers installation.

Hardware Installation

! 5 The software wou are installing far this hardware:

FTDI FTELUZ=x Device

has not passed Windows Logo testing to werify its compatibility with
Windows XF. (Tell me why this testing is impartant.)

Continuing your installation of this software may impair or
destabilize the correct operation of your system either
immediately or in the future. Microsoft strongly recommends
that you stop this installation now and contact the hardware
vendor for software that has passed Windows Logo testing.

Caontinue Anyaway H STOR Installation

Click the Continue Anyway button to complete the installation; you will soon get the last prompt:
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

%

The wizard has finished installing the software for:

% FTDI FT8UZXX Device

Click Finish to close the wizard.

< Back I Finish I Canzel

Click the Finish button. Now you can use the ChipProg connected to your computer.

3.3 Hardware installation

It is a mandatory for you to use the original power adapter 12V/1A received with the ChipProg-40 or
ChipProg -48 programmer and an original power cord for the ChipProg-G4 gang programmer. Any
substitutions should be agreed to with Phyton. It is also highly recommended to use the USB link
cables received with the programmers.

The hardware installations for different programmer models vary. Select the topic to see:

The ChipProg-48 hardware installation
The ChipProg-40 hardware installation
The ChipProg-G4 hardware installation
The ChipProg-ISP hardware installation

3.3.1 ChipProg-48

For the programmer to be used in a single-programming mode:
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Powering the Plug the power adapter to the ~110/240V outlet. Connect a plug of the

programmer power adapters to the coaxial connector on the rear panel of the
programmers and make sure that the "Good" green LEDs on each of
them are on.

Connecting to a PC  Connect the USB port of your PC to the USB connector on the rear panel
of the programmer by means of the USB cable. It is highly recommended
to connect the programmer to a USB slot on the computer main unit and
do not connect it through a USB hub, especially through a passive hub.

Starting up Start the Phyton ChipProgUSB program; if the programmer passes the
startup test successfully the first dialog prompts you to choose one of the
programmers to work with: ChipProg-48, ChipProg-40 or ChipProg-ISP.
Select the ChipProg-48 and continue. The ChipProgUSB main window
will open and you will be able to work with the tool.

For the programmers to be used in a multi-programming mode, e.g. connected to one

computer:

Powering the Plug the power adapters of each programmer to be connected in one

programmers programming cluster to the 110/240V outlets. Connect plugs of the power
adapters to the coaxial connectors on the rear panels of all the
programmers and make sure that the "Good" green LEDs on each of
them are on.

Connecting the Connect the USB ports of your PCs to the USB connectors on the rear

programmers to a panels of the programmers by means of the USB cables. It's highly

cluster recommended to connect the programmers to USB slots on the computer
main unit and do not connect them through a USB hub, especially
through a passive hub.

Starting up Start the Phyton ChipProgUSB - Gang Mode program; if all the

programmers pass the startup test successfully the first dialog prompts
you to assign the number from one to N to each programmer included in
the cluster. To assign the number push a Start button on a top panel of
each programmer one by one. Then the ChipProgUSB main window will
open and you will be able to work with the tool.

Read about the Multi-Programming mode.

3.3.2 ChipProg-40

For the programmer to be used in a single programming mode, e.g. alone:
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3.3.3

Powering the
programmer

Connecting to a PC

Starting up

For the programmers to
computer:

Powering the
programmers

Connecting the
programmers to a
cluster

Starting up

Plug the power adapter to the ~110/240V outlet. Connect a plug of the
power adapter to the coaxial connector on the rear panel of the
programmer and make sure that the "Good" green LED on the
programmer is on.

Connect a USB port of your PC to a USB connector on the rear panel of
the programmer by means of the USB cable. It's highly recommended to
connect the programmer to a USB slot on the computer main unit and not
connect it through a USB hub, especially through a passive hub.

Start the Phyton ChipProgUSB program; if the programmer passes the
startup test successfully the first dialog prompts you to choose one of the
programmers to work with: ChipProg-48, ChipProg-40 or ChipProg-ISP.
Select the ChipProg-40 and continue. The ChipProgUSB main window
will open and you will be able to work with the tool.

be used in a multi-programming mode, e.g. connected to one

Plug the power adapters of each programmer to be connected in one
programming cluster to the 110/240V outlets. Connect plugs of the power
adapter to the coaxial connectors on the rear panels of all the
programmers and make sure that the "Good" green LEDs on each of
them are on.

Connect USB ports of your PCs to USB connectors on the rear panels of
the programmers by means of the USB cables. It's highly recommended
to connect the programmers to USB slots on the computer main unit and
not connect them through a USB hub, especially through a passive hub.

Start the Phyton ChipProgUSB - Gang Mode program; if all the
programmers pass the startup test successfully the first dialog prompts
you to assign the number from one to N to each programmer included in
the cluster. To assign the number push a Start button on a top panel of
each programmer one by one. Then the ChipProgUSB main window will
open and you will be able to work with the tool.

Read about the Multi-Programming mode.

ChipProg-G4

Powering the
programmer

Plug the power cord to a power connector on the rear panel of the
programmer, then plug an opposite site to the ~110/240V outlet. Make
sure that all four "Good" green LEDs on the programmer are on.
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3.34

Connecting to a PC

Starting up

ChipProg-ISP

Connect a USB port of your PC to a USB connector on the rear panel of
the programmer by means of the USB cable. It's highly recommended to
connect the programmer to a USB slot on the computer main unit and not
connect it through a USB hub, especially through a passive hub. Use of
the passive USB hubs for connecting the ChipProg-G4 programmer is not
allowed.

Important! When you start the programmer first time wait for about
20 seconds to allow the USB driver to be setup. Then, every time
when you start the programmer, wait for 5...10 sec before
launching the ChipProgUSB software.

Start the Phyton ChipProgUSB - Gang Mode program; if all the
programmers pass the startup test successfully the first dialog prompts
you to assign the number from one to N to each programming site. To
assign the number push an appropriate Start button on a top panel of the
programmer one by one. Then the ChipProgUSB main window will open
and you will be able to work with the tool.

For the programmer to be used in a single programming mode, e.g. alone:

Connecting to a PC

Starting up

Connect a USB port of your PC to a USB connector on the rear panel of
the programmer by means of the USB cable. Make sure that the "Good"
green LED on the programmer is on. It's highly recommended to connect
the programmer to a USB slot on the computer main unit and not connect
it through a USB hub. Use of the passive USB hubs for connecting the
ISP programmers is not allowed.

Start the Phyton ChipProgUSB program; if the programmer passes the
startup test successfully the first dialog prompts you to choose one of the
programmers to work with: ChipProg-48, ChipProg-40 or ChipProg-ISP.
Select the ChipProg-ISP and continue. The ChipProgUSB main window
will open and you will be able to work with the tool.

For the programmers to be used in a multi-programming mode, e.g. connected to one

computer:
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Connecting the Connect USB ports of your PCs to USB connectors on the rear panels of
programmers to a the programmers by means of the USB cables. Make sure that the
cluster "Good" green LEDs on all the programmers are on. It's highly

recommended to connect the programmers to USB slots on the computer
main unit and not connect them through a USB hub. The ChipProg
programmers get power from the computer's USB port; that is why it's
important not to overload the ports. Use of the passive USB hubs for
clustering the ISP programmers is not allowed.

Starting up Start the Phyton ChipProgUSB - Gang Mode program; if all the
programmers pass the startup test successfully the first dialog prompts
you to assign the number from one to N to each programmer included in
the cluster. To assign the number push a Start button on a top panel of
each programmer one by one. Then the ChipProgUSB main window will
open and you will be able to work with the tool.

Read about the Multi-Programming mode.

3.4 Getting Assistance
3.4.1 On-line Help

The ChipProgUSB software has a pretty comprehensive context-sensitive on-line Help. To access it press
the F1 key or use the Help menu. Almost every ChipProgUSB dialog, message box and menu has its own
context-sensitive help, which can be invoked for the active dialog or menu by pressing F1.

In most cases you can find the necessary topic by searching for a keyword. For example, if you type "Verify"
in the first box of the Find tab, the third box will list the topics related to the programming verification.
Choose an appropriate topic from this list and press Display.

3.4.2 Technical Support

During a product’s warranty period Phyton provides technical support free of charge. Though we have been
selling the ChipProg programmers for many years the product software may contain minor bugs and some
programming algorithms may not be stable on some of the supported devices. We kindly ask you to report
bugs when you get an error message or have a problem with programming a particular device or devices.
We commit to prompt checking of your information and fixing the detected bugs.

To minimize difficulties operating with ChipProgUSB it is highly recommended to get familiar with the
manual before using the programmer. The ChipProgUSB - user interface is quite standard and intuitive,
however it includes some specific functions and controls that the user should learn about.

Before contacting Phyton
e Make sure that you use the latest ChipProgUSB version that is always available for free download from
the http://www.phyton.com.
e Make sure the detected error can be reproduced in the same working environment and is not a casual
glitch.
When contacting us
Please, provide our technical support specialists with the following information:
e Your name, the name of your company, your contact telephone number and your e-mail address.

e Name of the ChipProg model and its serial number, if one exists.
e Date of purchase, the Phyton invoice number, if available.
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Software version number taken from the About information box.

Basic parameters of your computer and operating system.

The device type, mechanical package and the type of the adapter if one is used.
Descriptions of detected errors, relevant bug reports and error screen shots.

Please send your requests or questions to support@phyton.com. This is the easiest way to get
professional and prompt help. Also, see Contact Information.

3.4.3 ContactInformation

Phyton Inc., Microsystems and Development Tools

7206 Bay Parkway, 2nd floor
Brooklyn, New York 11204
USA

Web address: www.phyton.com

E-mail contacts:

Generalinquiry: info@phyton.com

Sales: sales@phyton.com

Technical Support: support@phyton.com

Tel: 1-718-259-3191
Fax: 1-718-259-1539

35
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4.1

Graphical User Interface

The ChipProgUSB graphical user interface (GUI) elements include:

e Menus - global and local

e Windows

e Toolbars - global and local

e Setting Dialogs

e Hot Keys

¢ Context-sensitive help prompts

GUI featured with several useful additions specifically created for the ChipProg operations.

To make your operations with the ChipProgUSB program easier we highly recommend to learn the
chapters Menus and Windows in full. You will be able to use the ChipProg tools much more effectively.

User Interface Overview

ChipProgUSB features the standard Windows interface with several useful additions:

1. Each window has its own local menu (the shortcut menu). To open this menu, click the right mouse
button within the window area or press Ctrl+Enter or Ctrl+F10. Each command in the menu has a hot
key shortcut assigned to the Ctrl+<letter> keys. Pressing the hot key combination in the active window
executes the corresponding command.

2. Each window has its own local toolbar. The window’s toolbar buttons give access to most of the
window's local menu commands. The specialized window toolbar buttons operate only within the
specialized window. The main ChipProgUSB window has several toolbars that can be turned on or off
(in the Environment dialog, the Toolbar tab).

3. Each toolbar button has a short prompt: when you place the cursor over a toolbar button for two
seconds, a small yellow box appears nearby with a short description of the button’s function.

4. To save screen space, you can hide any window’s title bar. To do this, use the Properties command of
the local menu. You can identify the ChipProgUSB windows by their contents and position on the
screen (and, if you wish, by color and font). When the title bar is hidden, you can move the window as if
the toolbar were the title bar: place the cursor on the free space of the toolbar, press the left mouse
button and drag the window to a new position.

5. You can open any number of windows of the same type. For example, you can open several Buffer
windows.

6. Every input text field of any dialog box has a history list. ChipProgUSB saves them when you close a
development session. Then a previously entered string can be picked from the history list.

7. All input text boxes in the dialogs feature automatic name completion.

8. All check boxes and radio buttons in the dialogs work in the following way: a double-click on the check
box or radio button is equivalent to a single click on the box or button, followed by a click on the OK
button. This is convenient when you need to change only one option in the dialog and then close it.
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4.2 Toolbars

The ChipProgUSB program opens a few toolbars on top of the main window (see below).

B ChipProg-48 [Spansion SZ9ALODEhoBi0)2] - Demanstration

File WView Projsct Configure Commands Scripts Window Help

@ d &i : CidH w [ = ﬂ j H3 [ | Check Program Verify Read Erase Auto
%Selecf Device | Spansion 52841 008 B2 || 0 AutoDetect

DHE S BB BR& R R ||

The top line, shown right under the ChipProg main window title, includes the Main menu submenus. A
second line under the Main menu line displays icons and buttons of most frequently used commands on
files and target devices (Open project, Load file, Save file... Check, Program, Verify, etc.). There is an
indicator of the ChipProgUSB status (Ready, Wait, etc.). The third line displays a target device selector.
The fourth line, which is not displayed by default, includes an embedded editor options and commands
for scripts. The default toolbars can be customized. Read also the topics: The Configure Menu, The
Environmentdialog, Toolbar.

Besides the toolbars positioned on a top of the main window, each particular window has its own local
toolbar with the buttons presenting the most popular commands associated with the window. See for
example the Bufferwindow's toolbar below.

Buffer #0 - Code (1 MB}, words: 00000000 [00000000] EIETEI]

| Code | %

Acldr | Load | Save |C|:|nfiqure Eiuffer| Setup | View Mudif-,f| EiII:u::I-:]
File: Mane B
Checkzum: FFFE0000 =
00000000: FFFF FFFF FFFF FFFF FFFF FFFF |

4.3 Menus

The ChipProgUSB Main menu bar includes the following pull-down sub-menus:
e Filemenu

e View menu

e Project menu
¢ Configuremenu

¢ Commands menu

e Scripts menu
e Window menu

e Helpmenu

To access these menus, use the mouse or press Alt+letter, where "letter” is the underlined character in
the name of the menu item.
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4.3.1 The File Menu

The File menu's commands control the file operations. For those commands that have a toolbar button,
the button is shown in the first column of the table below. If there is a shortcut key for a command, the
shortcut key is shown at the right of the command in the menu.

Button Command Description
i : Load ... Opens the Load file dialog that specifies all the parameters of the

file to be loaded and the file destination.

,ﬁ Reload Reloads the most recently loaded file with the most recently
e specified parameters.
- _J Save... Saves the file from the currently active window to a disk. Opens
the Save file from buffer dialog.
Configuration Files Gives access to operations with configuration files.
Exit Closes ChipProgUSB. Alternatively, use the standard ways to
=E| close a Windows application (the Alt+F4 or Alt+X keys

combination).
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4.3.1.1 Configuration Files

Onexit ChipProgUSB automatically saves its configuration data in several configuration files with the
name UPROG. On start, it restores its configuration from the last saved configuration files. In addition, you
can save and load any of these files at any time using the Configuration Files command of the File menu.
You can have several sets of configuration files for different purposes.

o The Desktop file contains data about the display options and the screen configuration, and the
positions, dimensions, colors and fonts of all the opened windows. The extension of this file is .dsk.
The default file name is UPROG.dsk.

e The Options file stores the target device type, file options, etc. The extension of this file is .opt. The
default file name is UPROG.opt.

e The Session file, which stores session data and specifies the desktop and options; it can also be
saved and loaded by means of the Save session or Load session sub command of the Configuration
Files command. The extension of this file is .ses. The default file name is UPROG.ses.

e The History file, which contains all the settings entered in the text boxes of all the ChipProgUSB
dialogs. This file is hidden from users, but the settings stored earlier are available for prompt pick up
from the History lists. The extension of this file is .hst. The default file name is UPROG.hst.

4.3.2 The View Menu

This menu controls access to the ChipProgUSB windows:

Button Command Description
K Program Opens the Program Manager dialog.
A0 M
anager
1t Device and Opens the Device and Algorithm Parameters dialog.
Algorithm
Parameters

Buffer Dump Opens the Buffer dialog.

Opens the Device Information dialog.

=
@ Device

Information
Console Opens the Console dialog.

Local window menus
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Each window has its own local (shortcut) menu. To open a local window menu, either click the right
mouse button within the window or press Ctrl+Enter or Ctrl+F10.

Most, but not all, of the local menu commands are duplicated by local toolbar buttons that are usually
displayed at the top of every window.

4.3.3 The Project Menu

This menu contains commands for working with projects.

Button Command Description

ﬁ New Opens the Project Options dialog.

ﬁ Open Opens the Open Project dialog for loading an existing project file.
ﬁ Close Saves and closes a currently opened project

w Save Saves the currently opened project. Note that when you close a

project, create a new project or just exit, the current project will be
saved automatically.

CopyAs Opens the Save project dialog. Duplicating projects is helpful for
making project clones and other purposes.
= Repository Opens the Project Repository dialog.
a Options Opens the Project Options dialog for reviewing or changing the

project parameters.

4.3.3.1 The Project Options Dialog

This dialog is used to define the project options.

Element of dialog Description

Project File Name Specifies the project file name. The project name does not include a
path. The extension may be omitted.

Project Description Here you can enter your custom comments for the project.

(optional)

Two radio buttons which allow you to choose if the project has its own

Deskto
P desktop or if there is one desktop for all projects.
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Files to Load to Buffers File or list of files to load into the buffers.

Addfile Opens the LoadFile dialog.

. Remove the selected file from field Files to Load to Buffers.
Remove file
Editfile options Opens the LoadFile dialog.

Here you can enter the script name to be executed before loading the

Script to execute before ) .
files to the project.

loadingfiles:

Here you can enter the script name to be executed after loading the

Script to execute after ) .
files to the project.

loadingfiles:
4.3.3.2 The Open Project Dialog

This dialog is used to open the project which was previously created.

Element of dialog Description

Project File Name Specifies the project file name. The project name does not include a
path. The extension may be omitted.

Project Open History Lists the previously opened projects. Double-clicking a line in the list
opens a corresponding project.

Remove from list Deletes the selected project from the Project Open History list.

4.3.3.3 Project Repository

The Project Repository tree is a small database that stores records with links to the project files.
You can use this database to sort and group the projects as needed for better presentation and easier
access. The ChipProgUSB program displays the repository in a tree-like form that is similar to
Windows Explorer’s. Operations with the repository do not change the project files themselves. The
repository works only with records about the projects (links to the project files). A tree branch may
show projects and other branches. Any branch may contain different projects with the same names.
Different branches may contain links to the same project.

To open the Project Repository dialog invoke the Repository command of the Project menu. Each
tree branch displays the name of a particular project file without a path and the project description
shown in square brackets. The ChipProgUSB remembers the state of the tree branches (expanded /
collapsed) and restores it next time you open the dialog.

When you install a new version of the ChipProgUSB software and copy the working environment from
the previously installed version, the new version will inherit the existing project repository (file repos.
ini).
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Element of dialog Description

Add New Branch Opens the Add New Branch dialog to specify the name of a new
branch. When OK is pressed, the new branch is attached to the
selected branch.

Add a Project to Branch Opens the Open Project dialog to select a project to be added. When
Open is pressed, the selected project is added to the selected branch.

Add Current Project to Adds the currently opened project to the selected branch.

Branch

Remove Project/Branch Deletes the selected project or branch from the repository. When

deleting a branch, all branches that "grow" from this branch and all
projects located on it will be deleted.

When deleting a project from the repository, the ChipProgUSB deletes
only the repository record about the project, and does not delete the
project from the disc.

Edit Branch Name Opens the Edit Branch Name dialog for the selected branch.

Move Up Moves a selected project or branch up the tree within the same level of
hierarchy. The branch moves together with all branches that "grow"
from it and all its projects.

Move Down Moves the selected project or branch down the tree within the same
level of hierarchy. The branch moves together with all branches that
"grow" from it, and all their projects.

Save Repository Writes the repository to a disc file.

Browse Project Folder Opens MS Windows Explorer with the opened folder of the selected
project.

Open Project Writes the repository to the disk file and opens the selected project.

Close Closes the dialog. If the repository is changed, ChipProgUSB will ask

whether to save it.

4.3.4 The Configure Menu

This menu gives access to all the ChipProgUSB configuration dialogs.

Button Command Description

,m Select device ... Opens the Select Device dialog.
Device selection Lists the previously selected devices.
history

ﬁ Buffers Opens the Buffers dialog.
Serialization, Opens the Serialization, Checksum, Log File
Checksum, Log
file

© 2009 Phyton, Inc. Microsystems and Development Tools



Graphical User Interface 43

T Preferences
i

Ej Environment
A

4.3.4.1 The Select Device dialog

Opens the Preferences dialog.

Opens the Environment dialog with tabs: the Fonts tab, the
Colors tab, the Key Mappings tab, the Toolbar tab and the
Misc tab.

The dialog allows specification of the device to work with; it has a few groups of settings.

Element of dialog

Description

Devicestolist:

Manufacturer

Search mask:

Devices

Packages/Adapters

4.3.4.2 The Buffers dialog

Element of dialog

In this field you can check the box or boxes to specify the target
device type. All the devices are divided in three functional groups: a)
EPROM, EEPROM, FLASH; b) PLD, PAL, EPLD; c)
Microcontrollers - check one, two or all three boxes. Two check
boxes below specify a method of programming - in the programmer
socket or in the target system - some devices can be programmed
in either way, some only in one certain way.

It is recommended to narrow down the searchable database and
speed up the search by specifying the device properties if possible.

The box lists the device manufacturers in alphabetic order.

Here you can enter a mask to speed up the device search. The
character "*' masks any number of any characters in the device part
number. For example, the mask 'PIC18*64' will bring up all the
PI1C18 devices ending with the '64"'.

The file displays all the devices for a chosen manufacturer that
match to the search criteria specified in the Devices to list, Search
mask and Packages/Adapters fields.

This field lists all types of the chosen device's mechanical packages
that can are supported by the the ChipProg and appropriate
adapters.

Description

Bufferlist:

Add...

Delete

Edit...

Displays names, sizes and sub-layers of all currently open buffers

Opens the Buffer Configuration dialog to create a new buffer

Deletes the buffer highlighted in the 'Buffer list' box.

Opens the Buffer Configuration dialog for editing.
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Switches control to window displaying the buffer highlighted in the
'‘Buffer list' box. If this window is hidden under others it will be
brought to the foreground.

View

This drop down menu allows limiting the memory size allocated from
the computer RAM to each buffer. The free memory currently
available for the allocation is shown here in this screen area.

Memory Allocation

If the RAM space is limited the ChipProgUSB can use some space
on the PC drives by temporary writing the buffer image to the drive.
You can select the drive or allow the program to swap the files
automatically.

Swap Files

Checking this box enables you to swap files on the network drives
connected to your computer.

Use network drives

Here you can limit the space on the drive which will be never

Amount of space to leave ) .
affected by the file swapping.

free on each drive (GB):

4.3.4.2.1 The Buffer Configuration dialog

The Buffer Configuration dialog allows the setup of sub-layers in the buffers and to make their
presentation easier to work with.

The dialog includes as many tabs as number of sub-layers exist for a particular device. Every buffer
has at least one main layer, so the tab 'Code’ is always displayed on the dialog foreground. If a
chosen device has other address spaces (‘Data’, 'User’, etc.) the buffer has additional sub-layers
available for setting up by clicking the appropriate tabs.

4.3.4.2.1.1 Main Buffer Layer

The tab opens the dialog for configuring the main buffer layer - the '‘Code' layer.

Element of dialog Description

Here you can type in a name for the buffer or pick it from the history
list. By default the first opened buffer gets the name "Buffer #0".
Then you can open the "Buffer #1", etc. or give the buffer any name
you wish.

Buffer Name

Here you can assign a size of the 'Code' layer from the drop-down

Size of sub-layer 'Code’
menu - from 128KB to 32MB.

The program fills the buffer sub-layers with some default information,
usually by the 'FF's or zeros. By checking these boxes you specify
when the layer 'Code' should be filled with the default information -

before loading the file or right after the device type has been chosen.

Fill sub-layer'Code’ with
data:

These two toggled radio buttons define if the sub-layer 'Code’ will be
filled with some default information, specific for the selected device,
or by the custom bit pattern.

Data to fill sub-layer with:
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The buffer size usually exceeds the target device 'Code’ size. By
checking this box you downsize the buffer to match the target
device and to free some computer memory.

Shrink buffer size when
device is selected

4.3.4.2.1.2 Buffer Layers

The tab opens the dialog for presetting the buffer sub-layers.

Element of dialog Description

Fill sub-level ID location' By checking these boxes you specify when the chosen sub-layer
with data: should be filled with the default information - before loading the file or
right after the device type has been chosen..

These two toggled radio buttons define if the chosen sub-layer will
be filled with some default information, specific for the selected
device, or by the custom bit pattern..

Datato fill sub-level with:

4.3.4.3 The Serialization, Checksum and Log dialog
The dialog includes the following tabs:
Serial Number,

Checksum,

Signature String,

Log File.

4.3.4.3.1 Device Serialization

The dialog allows set up of the procedure of giving a unique humber to any single device belonging to a
series of devices being programmed.

Element of dialog Description

Write S/N to address in sub- 1 is option enables writing a unique device serial number into the
level: sub-layer specified here and at the address in the sub-layer also
specified here.

Current serial number-: Specify the current serial number in this box.

SIN size, in byte: Stpecify a size of the serial number in bytes, for example: 1, 2, 4,

etc.

Byte Order These two toggled radio buttons define an order of bytes that
represent the serial number (if it occupies more than one byte) -
either the least significant byte (LSB) follows the most significant
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Display S/N as:
Increment serial number
by:

Use script to increment
serial number:

4.3.4.3.2 Checksum

Element of dialog

Write checksum to
address:
insub-layer:

Address range to calculate
checksum for:

Start:
End:

Use algorithm to calculate
checksum:

Use script to calculate
checksum:

Size of summation result

Operation on summation
result

Size of data being summed

Byte Order

byte (MSB) or vise versa.

These radio buttons set the serial number display format - decimal or
hexadecimal.

By checking this radio button you set incrementing the serial
number by the fixed value specified here, for example: 1, 2, 10, etc.

By checking this radio button you specify the increment value as a
result of executing some script file, which can be put in the box
here.

The dialog allows to automatically calculate checksums of the data in buffers. Since there are several
more or less standard algorithms for the checksum calculation the dialog enables you to set one
standard algorithm or to create some custom, complex algorithms by using a script.

Description

By checking this box you begin automatically calculating the
checksum in accordance to other settings below and to write it to a
specified location in the chosen sub-layer.

The Start and End addresses define the range of buffer addresses
for which the program calculates the checksum.

One of two toggled radio buttons. If checked, one of the preset
algorithms of the checksum calculation can be picked from the drop-
down list.

This radio button sets an alternative method of the checksum
calculation by means of a custom made script.

These radio buttons allow the selection of the checksum size: one,
two or four bytes.

These radio buttons allow the application of some operation to the
raw result of the data summation: Negate, Compliment or do not
apply any operation.

These radio buttons allow to select the source data size: one, two or
four bytes

These two toggled radio buttons define an order of bytes that
represent the checksum - either the least significant byte (LSB)
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4.3.4.3.3 Signature string

follows the most significant byte (MSB) or vice versa.

The dialog allows set up of the procedure of giving a signature to the devices being programmed. The
signature string may include some generic data like the date when the device has been programmed
and some unique data like the device serial number.

Element of dialog

Description

Write Signature String to
address:
insub-layer:

Max. size signature string:

Use Signature String
template:

Use script to create
Signature String:

Template String Specifiers:

4.3.4.3.4 Log file

By checking this box you automatically writing a preset string to a
specified location in the chosen buffer sub-layer.

This field reserves a maximum length of the signature string in the
number of characters.

One of two toggled radio buttons. If checked, the string pattern
preset in the Template String Specifiers window will be programmed
into the target device.

This radio button sets an alternative method of composing the
signature string by means of a custom made script.

The list of the signature string specifiers to be placed into the Use
Signature String template field. It usually includes the date and time
of the device programming, its serial number and checksum.

The dialog allows set up of a log or logs of the device programming.

Element of dialog

Description

Enable logfile
Separate log file for each

device

File Name (Generated
Automatically)

Checking this box enables the device programming log.

These two toggled radio buttons set if the logs will be separated by
a manufacturer or by the target device type or a single log that will
be kept for all the devices being programmed.

Another two toggled radio buttons that set what specifier will be
included into the log file name: both the manufacturer and device
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Folderforlogfile:

Single log file for all device

types

File Name

LogFile Contents

Gang mode: Socket #

Date/Time

Events (device type change,
file names, etc.)

Device operation

Detailed Device operation

Operation Result

Device#/Gooddevices/Bad
devices

Serial Number

Signature string

Checksum

Buffer name

Programming address

Programming options

type (for example: Atmel AT89C51, Microchip PIC18F2525, etc.) or
just the device type (for example: AT89C51, PIC18F2525, etc.).

This is a field for entering a full path to the folder where the log file
will be kept. There is also a button for the path browsing.

By checking this radio button you select keeping one common log
for all types of the devices being programmed.

This is a field for entering a full path to the folder where the common
log file will be kept. There is also a button for the path browsing.

A set of the log file options.

If the device programming was conducted in the Gang
(multiprogramming) mode and if this box is checked the socket
number will be logged.

By checking this box you enable logging the date and time of the
device programming.

By checking this box you enable logging of all the events associated
with the device programming, e.g. the target device replacement,
loaded file names, etc.

By checking this box you enable logging of all the events associated
with the device manipulations.

By checking this box you enable more detailed logging of all the
events associated with the device manipulations.

By checking this box you enable logging the results of the
programming operations.

By checking this box you enable logging a full number of the devices
programmed, number of successfully programmed devices and
number of failed ones.

By checking this box you enable logging the serial number read
from the device.

By checking this box you enable logging the signature string read
from the device.

By checking this box you enable logging the checksum value read
from the device.

By checking this box you enable logging the buffer name.

By checking this box you enable logging the ranges of the device
locations which have been programmed.

By checking this box you enable logging all the programming
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LogFile Format

Log File Overwrite Mode

Warn if size exceeds

Immediately write log file to

disk, no buffering

4.3.4.4 The Preferences dialog

Element of dialog

options.

A pair of toggled radio buttons: one sets the plain text format of the
log file, the second sets the tabulated text to be viewed in the
Microsoft Excel format.

A pair of toggled radio buttons, checking the top one sets the mode
of appending new records to a specified log file and checking the
second overwrites the old log every time the ChipProg re-starts.

If this box is checked then every time when the log size exceeds a
specified value the ChipProgUSB issues the warning.

If this box is checked then the ChipProgUSB does not buffer the log
to the computer RAM but writes it straight to the drive.

Description

Options
Reload last file on start-up
Execute Power-On test on
start-up

Sounds

Device operation error:

Device operation complete:

Device operation complete
(Gang Mode):

Programming start
(AutoDetectMode):

4.3.45 The Environment dialog

By checking this box you enable re-loading to the open buffer(s) the
last loaded file every time when you start the ChipProg.

This box is checked by default. By un-checking it you disable
executing the start-up ChipProg self-testing.

All programmable sounds can be picked from the preset
ChipProgUSBsounds

Select the sound for error operations.

Select the sound for successful completion of the programming
operations in a single programming mode (one ChipProg is in use).

Select the sound for successful completion of the programming
operations in a gang programming mode (either a few single site
programmers are connected to one PC for multi-device programming
or when the ChipProg-G4 gang programmer is in use).

Select the sound for indicating the start of the device programming
when the ChipProg automatically detects the device insertion into
the programming socket.

The Environment dialog includes the following tabs:
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Fonts tab,
Colors tab,

Mapping HotKeys tab,

Toolbar tab,

Miscellaneous Settings tab.

4.3.4.5.1 Fonts

The Fonts tab of the Environment dialog opens a sub dialog for setting fonts and some appearance
elements in the ChipProgUSB windows. Only mono-spaced (non-proportional) fonts (default is
Fixedsys) are used to display information in windows. To improve appearance of the windows, you can
set up either another font for all windows, or individual fonts for each particular window.

The Windows area lists the types of windows. Select a type to set up its options. The set options are
valid for all windows of the selected type, including the already opened windows.

Element of dialog Description

Window Title Bar Toggles the title bar for windows of the selected type. If the box is checked it
adds a toolbar at the position specified by the Windows Toolbar Location
option. To save screen space uncheck the box. Also, see notes below.

Window Toolbar Sets the toolbar location for the selected window.

Location

Grid Turns on/off the display of the vertical and horizontal grids in some window
types, and permits adjusting the column width (when the vertical grid is
allowed).

AdditionalLine Provides additional line spacing, which will be added to the standard line

Spacing spacing. Supply a new value or choose from the list of most recently used
values.

DefineFont Opens the Font dialog. The selected font is valid for all windows of the
selected type.

Use This Font for All Applies the font of the chosen window type to all ChipProgUSB windows.

Windows

Notes

1. To move a window without the title bar, place the cursor on its toolbar, where there are no buttons, and
then operate as if the toolbar were the window title bar. Also, you can access the window control
functions through its system menu by pressing the Alt+<grey minus> keys.

2. Each window has the Properties item in its local menu, which can be invoked by a right click. The Title
and Toolbar items of the Properties sub-menu toggle the title bar and toolbar on/off for the individual
active window.

4.3.4.5.2 Colors

The Colors tab of the Environment dialog opens a sub dialog for setting colors of such window elements
as window background, font, etc.. By default, most colors are inherited from MS Windows; however you
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can set other colors if you prefer them.

Element of dialog Description

Color Scheme Specifies the color scheme name. Your can type in a name or choose a
recently used one from the list.

The Save button saves the current scheme to the disc; later you can restore
color settings by just a mouse click. The Remove button removes the current

scheme.
Colors Lists the names of color groups. Each group consists of several elements.
Inherit Windows When this box is checked, the selected color is taken from MS Windows. If
Color later you change the MS Windows colors through the Windows Control Panel,

this color will change accordingly. This option is available only for the
background and text colors.

Use Inverted Text/ When this box is checked, the program inverts the selected window colors

Background Color (for text and background). For example, if the Watches window background
color is white and the text color is black, then the line with the selected
variable will be highlighted with black background and white text.

Edit Opens the Color dialog if the Inherit Windows Color and Use Inverted Text/
Background Color boxes are unchecked for this type of window.

The Color dialog also opens if you double-click a color in the Colors list.

Spread Sets the selected color for all windows. This option is useful for text and
background colors. For example, if you choose blue background and yellow
text for the Source window and then click the Spread button, these colors will
be set as the text and background colors for all windows.

Font For syntax highlighting in the Source window, you can specify additional font
attributes - Bold and ltalic.

In some cases when synthesizing bold fonts, MS Windows increases the size
of characters and the font becomes unusable, because the bold and regular
characters should be of the same size. In these cases, the Bold attribute is
ignored.

Sometimes this effect occurs with the Fixedsys font. If you need to use Bold
fonts, choose the Courier New font.

4.3.4.5.3 Mapping Hot Keys

The Key Mapping tab of the Environment dialog opens a sub dialog for assigning hot keys for all
commands in the ChipProgUSB. The Menu Commands Tree column displays a tree-like expandable
diagram of all commands. The Key 1 (Key 2) columns contain the corresponding hot—key combinations for
the commands. The actions apply to the currently selected command.
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Element of dialog Description
Define Key 1 Opens the DefineKey dialog. In the dialog, press the key combination you
Define Key 2 want to assign to the selected command, or press Cancel.

Alternatively, double-click the "cell* in the row of this command and the Key 1
(Key 2) column.

Erase Key 1 Deletes the assigned key combination from the selected command.
Erase Key 2 Alternatively, right click the "cell" in the row of this command and the Key 1 (
Key 2) column.

4.3.4.5.4 Toolbar

The Toolbar tab of the Environment dialog controls the presence and contents of toolbars of the

windows.

Element of dialog Description

Toolbar Bands Lists the ChipProgUSB toolbars. To enable/disable a toolbar check its box.
Buttons/Commands Lists the buttons for the toolbar selected in the Toolbar Bands list. To enable/

disable a button on the toolbar check its box.

"Flat" Local Window Toggles between the "flat" and quasi-3D appearance of the local toolbar
Toolbars buttons for the specialized windows.

Toolbar Settings are Employs the current settings from this dialog for other projects or files
the Same for Each opened later.
Project/Desktop File

4.3.4.5.5 Messages

Check messages that program should display, uncheck messages that you do not want to be
displayed.

4.3.4.5.6 Miscellaneous Settings

The Miscellaneous tab of the Environment dialog allows the setting of miscellaneous parameters of the
ChipProgUSB windows and messages.

Elementof dialog Description

Main Window Status Controls presence and location of the <%CM%> window status line.
Line

Quick Watch Turns the Quick Watch function on or off.

Enabled
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Highlight Active
Tabs

Double Clickon
Check Box or Radio
ButtoninDialogs

Show Hotkeys in
Pop-up Descriptions

Do notDisplay Box if
Console Window
Opened

Always Display
Message Box

Automatically Place
Cursor at OK Button

Audible Notification
for Error Messages

Log Messages to
File

Overwrite Log File
After Each Start

Append Messages
toLogFile

Turns highlighting on/off for the currently active tab (the MS Windows-style) in
windows that have tabs.

Sets the mouse’s double click function equal to a single click, plus pressing
the OK button in that dialog.

Turns the Hotkeys display on/off in the short prompts for toolbar buttons.

If the Console window is open, messages will be displayed there. Otherwise,
the message box will display messages.

All issued messages will be displayed in the message box.
The Console window also displays these messages.

The cursor will always be on the OK button when the message box opens
and this box is checked.

If you prefer you may press the Enter key instead of using the mouse to click
OK.

If you select this option, there will be a beep along with the error message.
Information (as opposed to error) messages are always displayed without
the beep.

Specifies the log file name. All messages will be written to this file. The
method of writing is controlled by the radio button with two options:

Specifies erasing the previous log file, if it exists, and creates it afresh for
every session.

Specifies appending messages to the end of an existing log file. In this case,
the log file size will grow endlessly.

4.3.4.6 Configurating Editor Dialog

The ChipProgUSB software includes a built-in editor that is used for editing one type of the objects of the
ChipProgUSB - Scripts Files. The Editor Options dialog includes the following tabs:

General Editor Settings tab,

Key Mapping tab.

4.3.4.6.1 General Editor Settings

The General tab of the Editor Options dialog sets up all common options applicable to every Source

window opened.

Element of dialog

Backspace Unindents

Description
Checking/clearing this box toggles the Backspace Unindent mode.
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Keep Trailing Spaces

Vertical Blocks

Persistent Blocks

Create Backup File

Horizontal Cursor

CR/LF atEnd-of-file

SyntaxHighlighting

Highlight Multi-line
Comments

Auto Word/AutoWatch Pane

Full Path in Window Title

Empty Clipboard Before
Copying

ConvertKeyboard Inputto
OEM

AutoSave Files Each ... min

Tab Size

Undo Count

Automatic Word Completion

Indenting

See below for explanations.

When this box is checked, the editor does not remove trailing
spaces in lines when copying text to the buffer or saving it to a disk.
Spaces are removed when the box is unchecked.

If the box is checked, the Vertical Blocks mode is enabled for block
operations.

If the box is checked, the Persistent Blocks mode is enabled for
block operations.

If the box is checked then <%CM%> creates a *.BAK file each time a
file is saved in the Source window.

If the box is checked it sets the cursor as a horizontal line, like the
DOS command prompt.

If the box is checked, it adds an empty line to the file end when
saving the file to disk (if there is no one yet).

If the box is checked, it forces syntax highlighting of language
constructions.

If the box is checked it enables highlighting of multi-line comments.
By default, the window highlights only single-line comments.

If the box is checked, any new Source window will open with the
Auto Word/AutoWatch pane at its right and the automatic word
completion function will be enabled.

If the box is checked, the Source window caption bar displays the
full path to the opened file.

If the box is unchecked, then previously kept data remains
retrievable after copying to the clipboard.

If the box is checked, the Source window converts the characters
that you input in the window from the MS Windows character set to
the OEM (national) character set corresponding to your national
version of the Windows operating system. Also, see note below.

If the box is checked, <% CM%> will save the file being edited every
‘X' minutes, where ‘X’ is a settable constant chosen by the user.

Sets the tabulation size for the text display. The allowable value
ranges from 1 to 32. If the file being edited contains ASCII tabulation
characters, they will be replaced with a number of spaces equivalent
to the tabulation size.

Sets the maximum number of available undo steps (512 by default).
If this does not suffice, you can set a value of up to 10000 steps.
However, larger values increase the editor's memory requirement.

If the Enable box is checked, it allows the automatic word completion

function. The Scan Range drop-down list sets the number of text
lines to be scanned by the automatic word completion system.

Toggles automatic indenting on/off for a new line that is created
when you press Enter.

Note. You should check the Convert Keyboard Inputto OEM box only if you are going to type something
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in the Source window when working with a file coded in the OEM character set. If you need only to display
such a file, specify the Terminal font for the Source window in the Fonts tab of the Environment dialog:
select Editor in the Windows list and press the Define Font button.

The Backspace Unindent mode establishes the editing result from pressing the Backspace key in the
following four cases, when the cursor is positioned at the first non-space character in the line (there are
several spaces between the first column of the window and the first non-space character):

Backspace Unindent enabled Backspace Unindent disabled

Insert mode Any preceding blank spaces in the One space to the left of the cursor is
line are deleted. The rest of the line deleted. The cursor and the rest of the
shifts left until its first character is in line to the right of the cursor shift one
the first column of the window. position left.

Overwrite mode The cursor moves to the first column Only the cursor moves one position
of the window. The text in the line left. The text in the line remains in
remains in place. place.

4.3.4.6.2 The Editor Key Mapping

You can manage the list of available editor commands with the Key Mappings tab of the Editor Options
dialog. You can add and delete editor commands, assign (or reassign) hot keys for new commands and
for built-in ones.

The left column of the list contains command descriptions. Command types, corresponding to the
command descriptions, are in the second column. (Command means a built-in ChipProgUSB
command; Script ‘XXX’ means an added user-defined command). Two columns on the right specify the
hot key combinations to invoke the command, if any.

Elementofdialog Description

Add Opens the EditCommand dialog for adding a new command to the list and
setting up the command parameters.

Delete Removes a selected user-defined command from the list. Any attempt to
remove a built-in command is ignored.

Edit Opens the EditCommand dialog to change the command parameters. For
built-in commands, you can only reassign the hot keys (the Command
Description and Script Name boxes are not available).

EditScriptFile Opens the script source file of this command in the Script Source window.
Creating new commands

To create a new command, you should develop a script for it. In fact, you add this script to the editor, not
the command. This means that your command is able to perform much more complex, multi-step
actions than a usual editor command. Moreover, you can tailor this action for your convenience, or for a
specific work task or other need. Your scripts may employ the capabilities of the script language with its
entire set of built-in functions and variables, text editor functions and existing script examples.

A script source file is an ASCII file. To execute your command, the editor compiles the script source file.
Note that before you can switch to using the script which you have been editing, you must first save it to
the disk so that ChipProgUSB can compile it.
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Script source files for new commands will reside only in the KEYCMD subdirectory of the ChipProgUSB
system folder. Several script example files are available in KEY CMD. For more information about
developing scripts, see ScriptFiles.

4.3.4.6.2.1 The EditKey Command Dialog

This dialog Editcommand sets parameters for a new command or for existing ones.

Element of dialog Description

Command Enter the command description here (optional). Text placed in this box will be
Description displayed in the list of commands for easier identification of the command.
Script Name The name of the script file that executes this command.

Define Key 1 Opens the specialized dialog box where you can assign two key

Define Key 2 combinations to a couple of hot keys.

The script source files for commands will reside only in the KEYCMD subdirectory of the ChipProgUSB
system folder. Enter the file name only, without the path or extension.

Notes
1. You should not specify the combinations reserved by Windows (like Alt+— or Alt+Tab).

2. We do not recommend assigning the combinations already employed by commands in the Source
window or ChipProgUSB, because then you'll have fewer ways to access these commands. Some
examples are Alt+F, Shift+F1, Ctrl+F7, which are commands that open the application menus.
Others are the local menu hot keys of the editor window.

3. You can use more than one control key in the keystroke combinations. For example, you can use Ctrl
+Shift+F or Ctrl+Alt+Shift+F as well as the Ctrl+F combination.

4. For some built-in commands, the hot keys cannot be reassigned (for example, the keys for moving the
cursor).

435 The Commands Menu

This menu invokes main commands (or functions) that control the programming process, as well as
some service commands.

Command Description
Blank Check This command invokes the procedure of checking the target device

before programming to make sure that it is really blank. Programming
of some memory devices does not require erasing them before re-
programming. For such devices the Blank Check command is
blocked and it is shown grayed out on the screen.

This command invokes the procedure of programming the target
device, e.g. writes the contents of the buffer into the target device’s
cells.

Program
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Verify

Read

Erase

Auto Programming
Local menu

Calculator

4.3.5.1 Calculator

This command invokes the procedure of comparing the information
taken from the target device with the corresponding information in the
buffer.

This command invokes the procedure of reading the content of the
target device’s cells into an active buffer.

This command invokes the procedure of erasing the target device.
Some memory devices cannot be electrically erased. In this case the
Erase command is blocked and is grayed out on the screen

This command invokes the procedure of AutoProgramming.

Opens the local menu of active window.

Opens the Calculator dialog, which performs calculator functions.

Aprime purpose of the embedded calculator is to evaluate expressions and to convert values from one
radix to another. You can copy the calculated value to the clipboard.

Element of dialog

Expression
CopyAs
Signed Values

Display Leading
Zeroes

Copy

Clr
Bs
0x
>>
<<

Mod

Description

The text box for entering an expression or number.
Specifies the format of results that will be copied to the clipboard.

If this box is checked the result of a calculation will be interpreted and
displayed as a signed value (for the decimal format only).

If this box is checked, binary and hexadecimal values retain leading zeroes.

Copies the result to the clipboard in the format set by the Copy As radio
button.

Clears the Expression text box.

Deletes one character (digit) to the left of the insertion point (Backspace).
Inserts "0x".

Shifts the expression result to the right by the specified number of bits.
Shifts the expression result to the left by the specified number of bits.

Calculates the remainder of division by the specified number.

While you are typing the expression in the Expression drop-down list box ChipProgUSB tries to evaluate
the expression and immediately displays the result in different formats in the Result area. Statuses of
the Copy As radio button and two check boxes in this area control the result format.

You can assign values to program variables and SFRs by typing an expression that contains the
assignment. For example, you may type SP = 66h and the value of 66h will be assigned to SP.

Examples of expressions:

0x1234
-126

main + 33h
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(Float) (*ptr + RO)
101100b & OxF

4.3.6 The Script Menu

The ChipProgUSB is featured with the tools known as an embedded script language. This mechanism is
intended for automation of the programming operation, mastering complex operations that include both the
programmer itself and the programmer operator's actions. The ChipProgUSB enables composing scripts
files (SF) and executing them.

This Script menu contains a few commands associated with script files. The commands can be
configured by the ChipProg user and the list can be expanded by adding a new item (command). To add a
new item, place a script file into the current folder or into the ChipProgUSB installation folder. The first non-
empty line of any script file should contain three slashes followed by the text that will appear in the Scripts
menu:

/// Menu item text

When ChipProgUSB builds the Scripts menu, it searches the current folder and its installation folder for all
*.CMD files that contain '///" in the first line (remember that '//' denotes the beginning of the single-line
comment) and inserts the text following '///' into the Scripts menu.

When you select a Scripts menu item and click the Start button, ChipProgUSB launches the selected

script.

Button Command Description

@E Start... Opens the ScriptFiles dialog from which you can
New Script Source Create a new ScriptFile text.

Q Open Watches Opens the Watches window.

window
Addwatch... Add watch to the Watches window .
Editor window Opens a list of the commands to Compose a new, Open, Save,
Save as, Print a script file. of the Editor window.

TextEdit Edit a list of the commands for editing a selected ScriptFile
Example Scripts Invokes the

Help on this menu

Working with scripts is describe in the Script files topics.
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43.7 The Window Menu

This menu lets you control how the windows are arranged within the computer screen. The list of currently
opened windows is shown in the lower part of the menu. By choosing a particular window name in this list
you immediately activate it and bring it to the foreground of the computer screen.

Command Description

Tile Arranges all windows without overlap. Makes the window sizes
approximately equal.

TileHorizontally Arranges the windows horizontally without overlap. Makes the window
size as close to each other as possible.

Cascade Cascades the windows.

Arrange Icons Arranges the icons of the minimized windows.

CloseAll Closes all windows.

4.3.8 The Help Menu

This menu gives access to the help system. See also, How to Get On-line Help.

Command Description

Contents Opens the contents of the help file.

Search for Help on Opens the dialog for searching the tool's help system for the content,
index and keywords.

Phyton Adapters Opens the HTML file, which includes adapters' part numbers, their
short descriptions and wiring diagrams.

Visit Phyton website Open the www.phyton.com site in your default Internet browser.

Check for updates Opens the Update Checking dialog that directly links your computer to
the Phyton download webpage.

Send e-mail message to Opens the default email client to compose a message to Phyton.

Phyton

About ChipProg The box displays: the ChipProgUSB and the ChipProg Windows shell

software version numbers; the selected target device type and the
device manufacturer.

4.4 Windows

The ChipProgUSB enables opening the following types of windows by means of the View menu:

e Program manager
e Device and Algorithm Parameters' Editor
e Buffer
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e Device Information
e Console

Plus it can operate with two types of windows associated with the ChipProgUSB script files:

e Editor
e Watches

44.1 The Program Manager Window

The Program Manager window is the major control object on the screen from which an operator
controls the ChipProg . While some windows can be closed in a process of programming this one is
supposed to be always open and visible.

The window includes three tabs opening three group of settings and status indicators:

The Project Manager tab

The Option tab
The Statistics tab

The Project Manager and Options tabs look different and enable different settings for the ChipProg
programmers working in single-programming and multi-programming modes. These tabs are identical
for the ChipProg-G4 gang programmer and for the ChipProg-48, ChipProg-40 and ChipProg-ISP
programmers when they are configured to work in the multi-programming mode.

44.1.1 The Program Manager tab

The tab serves for setting major programming parameters, executing the programming operations and
displaying the ChipProg statuses.commands while

Element of dialog Description
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Buffer:

Functions

Blank check

Program

Read
Verify

Auto Programming

Addresses

Device start:

Deviceend:

Buffer start:

Execute

Repetitions:

EditAuto

Operation Progress

4.4.1.1.1 Auto Programming

Thefield Buffer displays the active buffer to which the programming
operations (functions) will be applied. A full list of open buffers is
available here via the drop-down menu.

This field lists the tree of the functions relevant to the selected target
device. Some functions represent the ChipProg commands while
others integrate a few sub-functions and can be expand or
collapsed. Double clicking on the function invokes the command and
is equivalent to single clicking the Execute button (see below).

Checks if the target device is blank

Programs the target device (writes the information from an active buffer to
the target device).

Reads out the content of the target device to an active buffer.

Compares the content of the target device and an active buffer

Executes a preset sequence of operations (batch operations) settable in
the Auto Programming dialog. The Edit Auto button opens this dialog.

Here you can set the addresses for the buffer and the target device
to which the programming functions will be applied.

The very first address in the target device's physical memory which will
be programmed or read.

The very last address in the target device's physical memory which will
be programmed or read.

The very first address in the buffer memory from which the data will be
written to the target device or to which the data will be read from the
device.

There are three alternative ways to activate a highlighted function: a)
to click the Execute button; b) to double click on the function line; c) to
push the Enter button on the PC keyboard.

Any function can be executed repeatedly. The number of repetitions
can be set here.

Clicking on this button opens the Auto Programming dialog.

In this field the ChipProgUSB displays the current operation
progress bar and the operation status (OK, failed, etc.).

Each device has its own routine set of programming operations that usually includes: Erasing, Blank
Checking, Programming, Verifying and often Protecting against unauthorized reading. The ChipProgUSB
stores default batches of these programming operations for each single supported device and allows the
invocation of the batch of operations just by a mouse click or pressing the Start button on the programmer
panel. It also enables the customization of a sequence of elementary functions (operations) via the Auto
Programming dialog. To open this dialog click on the Edit Auto button.
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Adding a Command to the Auto Programming Function List

The tree including all the functions available for the chosen target device is shown in the right pane
Available functions. To include a function to the batch highlight it in the right pane and click the Add
button - the function will appear in the left pane Selected functions. The functions will be then
executed in the order in which they are positioned in the Selected functions pane, from the top to the
bottom. To correct the function batch highlight the command to be removed and click the Remove

button.

4.4.1.2 The Options tab

The tab serves for setting additional programming parameters and options:

Element of dialog

Split data

Options

Insert test

Check device ID

Description

The group of radio buttons in the Split data field allows the
programming of 8-bit memory devices to be used in the
microprocessor systems with the 16- and 32-bit address and data
buses. To do this the buffer content should be properly prepared to
split one memory file into several smaller file.

If this box is checked the ChipProgUSB will test whether each of
the device leads is reliably squeezed by the programming socket
contact. If some contact is bad a current operation will be blocked.

By default this option is always on and the ChipProg always
verifies the target device identifier given by the device manufacturer.
If the box is unchecked the program will skip the device ID
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Reverse bytes order

Blank check before
program
Verify after program

Verify after read

Auto-Detect presence of
device in the socket

On Device Auto-Detect or
'Start’ Button:

4.4.1.2.1 Splitdata

checking.

If this box is checked the ChipProgUSB will sweep the byte order
in the 16-bit word while it executes the Read, Program and
Verify operations. This option does not affect the data in the
ChipProg buffers, as they remain the same after the file loading.
If this box is checked the ChipProgUSB will always check if the
target device is blank before programming it.

If this box is checked the ChipProgUSB will always verify the device
content right after it was programmed.

If this box is checked the ChipProgUSB will always verify the device
content right after it was read out.

If this box is checked the ChipProgUSB will test whether each of
the device leads is reliably squeezed by the programming socket
contact. If so a preset programming function (operation) or Auto
Programming will start. Otherwise, if some contact is bad a current
operation will be blocked.

The group of radio buttons. The checked radio button defines what
the ChipProg will do upon the the drive auto-detect or pushing the
'Start' button.

The group of radio buttons in the Option tab in the Split data field allows programming 8-bit memory
devices to be used in the microprocessor systems with the 16- and 32-bit address and data buses. To
do so the buffer content should be properly prepared to split one memory file iinto several smaller files.
The data splitting enable the conversion of the data read from 16- or 32-bit devices to make file images
for writing them to memory devices with the byte organization.

Radio button

Description

No split

Evenbyte

Odd byte

This is a default option. A whole buffer is not split and is considered
as a whole one byte data array.

The data in the buffer are considered as an array of 16-bit words.
The buffer-device operations are conducted with even bytes only.
For example, if the programmer reads the device from the
address=0, the byte with this address will be placed to the buffer
location also with the address=0, the byte from the device with the
address=1 will be placed to the buffer location with the address=2,
etc.

The data in the buffer are considered as an array of 16-bit words.
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The buffer-device operations are conducted with odd bytes only.
For example, if the programmer reads the device from the
address=0, the byte with this address will be placed to the buffer
location also with the address=1, the byte from the device with the
address=1 will be placed to the buffer location with the address=3,
etc.

Byte 0 The data in the buffer are considered as an array of 32-bit words.
The buffer-device operations are conducted with the byte #0 only.
For example, if the programmer reads the device from the
address=0, the byte with this address will be placed to the buffer
location also with the address=0, the byte from the device with the
address=1 will be placed to the buffer location with the address=4,
etc.

Byte 1 The data in the buffer are considered as an array of 32-bit words.
The buffer-device operations are conducted with the byte #1 only.
For example, if the programmer reads the device from the
address=0, the byte with this address will be placed to the buffer
location with the address=1, the byte from the device with the
address=1 will be placed to the buffer location with the address=5,
etc.

Byte 2 The data in the buffer are considered as an array of 32-bit words.
The buffer-device operations are conducted with the byte #2 only.
For example, if the programmer reads the device from the
address=0, the byte with this address will be placed to the buffer
location with the address=2, the byte from the device with the
address=1 will be placed to the buffer location with the address=6,
etc.

Byte 3 The data in the buffer are considered as an array of 32-hit words.
The buffer-device operations are conducted with the byte #3 only.
For example, if the programmer reads the device from the
address=0, the byte with this address will be placed to the buffer
location with the address=3, the byte from the device with the
address=1 will be placed to the buffer location with the address=7,
etc.

4.4.1.3 The Statistics tab

This tab opens the fild displaying the programming session statistical results - Total number of
devices that were programmed during the session, what was the yield (Good) and how many devices
have failed (Bad). Getting such statistics is quite helpful when you need to program a series of same
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type devices. It is important to remember that the statistical counters are affected by executing the
Auto Programming only, as execution of other functions makes no effect on the statistics.

Element of dialog

Clear statistics

Device Programming
Countdown

Enable countdown

Display message when
countdown value reaches
zero

Reset counters when
countdown value reaches
zero

Countonly successfully
programmed devices

Setinitial countdown
value

Description

This button resets the statistics..

Normally the Total counter increments after each Auto
Programming; the , Good and Bad counters also count up. The
ChipProgUSB reverses the counters to decrement their content (to
count down).

If the box is checked the ChipProgUSB will count the number of the
programmed devices down.

If the box is checked the ChipProgUSB will issue a warning when
the counter Total is zeroed.

If the box is checked the ChipProgUSB will reset all the counters
when the counter Total is zeroed.

If the box is checked the ChipProgUSB will count only the
successfully programmed (Good). All other statistics will be
ignored.

Clicking on the button opens the box for entering a new Total
number that then will be decremented after each Auto Programming

4.4.2 The Device and Algorithm Parameters window

The Device and Algorithm Parameters window is intended to display and prepare (where possible)
the device’s internal parameters and settings, which can then be programmed into a target device by
executing the Program command in the Program Manager window.
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The parameters displayed into this window are split in two groups: Device Parameters and Algorithm
Parameters. The groups are separated by a light blue stripe

Device Parameters

Algorithm
Parameters

This group includes parameters that are specific for each selected device, such
as: sectors for flash memory devices, lock and fuse bits, configuration
bits, boot blocks, start addresses and other controls for microcontrollers.
Usually these parameters represent certain bits in a microcontroller’'s Special
Function Registers (SFRs). Some of these SFRs can be set in the ChipProg
buffers in accordance with device manufacturers’ data sheets. But setting the
parameters in the Device and Algorithms Parameters window is much
easier and more intuitive. It is impossible to specify absolutely all features that
may appear in future devices, and, therefore, new parameters for these new
devices.

This group includes parameters of the programming algorithm for the selected
device — including the algorithm type and editable programming voltages.

Any changes made in the ‘Device and Algorithm Parameters’ window do not
immediately cause corresponding changes in the target device. Parameter settings
made within this window just prepare a configuration of the device to be programmed.
Physically, the programmer makes all these changes only upon executing an
appropriate command from the ‘Program Manager’ window.

IMPORTANT NOTE!

The window is separated into three columns: 1) the parameter's name, 2) its value or setting, 3) a short
description. Names of the editable parameters are shown in blue; other names are shown in black.

Default values in the column Value are shown in black; after changing a parameter the new value will be

shown in red. If the value is too long to display the window represents it as three dot signs (*..."). If these
dots are red it means that the parameter has been edited.

In order to edit a parameter, double click its name. Some editable parameters are represented by a set
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of check boxes, some require to be typed in prompt boxes.

The local Device and Algorithm Parameters window's toolbar includes a few buttons positioned on
the top of the window:

Toolbar button Description

Edit C_Iick_ing on this button.opens the editing dialog tp modify t_he

- highlighted parameter in the format, most convenient for this
parameter. A double click on the highlighted parameter also opens
the editing dialog.

If the parameter to be modified has an allowed range in which it may

Min.Value o . L
be set, then clicking on the Min.Value button sets the minimal
allowed value to the highlighted parameter.

Max.Value If the parameter to be modified has an allowed range in which it may
be set, then click on the Max.Value button to set the maximal
allowed value to the highlighted parameter.

Default Click on this button returns the default value to the highlighted
parameter.

All Default Click on this button returns the default values to all the parameters

displayed in the window.

Depending of the parameter's type ChipProgUSB offers the most convenient format for the parameter
editing:

Method of editing Description

When the parameter value may be picked from a few preset values
the dialog offers a drop-down list with these values. Highlight a new
value in the list and click OK to complete the editing. For example,
some microcontrollers can be programmed to work with different
types of the clock generators, so the menu prompts to select one of
them.

Drop-down menu

When some options can be set or reset the dialog appears in a form
of several boxes indicating the default or lately set option statuses.
To toggle the option check or uncheck the box. For example, some
microcontrollers allow the locking of a particular part of the memory
by setting several lock bits, so the menu prompts to check the lock
bits represented as a set of check boxes.

Check Box dialog

Customizing the When the parameter value may be set freely in an a}llowed. range the

parameter dialog offers a box for entering a new value and a history list
displaying a few recently set values. The dialog prompts with the min
and max values that can be set for each parameter and restricts to
enter the value out of the allowed range. This type of editing is in use
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for setting custom values for Vcc and Vpp voltages.

4.4.3 Buffer Dump Window

The Buffer Dump window displays the contents of the memory buffer.

ChipProg supports a flexible buffer structure:

o You can create an unlimited number of buffers. The number of buffers that you can open
is limited only by the available computer RAM.
) Every buffer has a certain number of sub-levels depending on the type of target device.

Each sub-level is associated with a specific section of a target device's address space.
For example, for the Microchip PIC16F84 microcontroller every buffer has three sub-
levels: 1) code memory; 2) EEPROM data memory; 3) user's identification sub-level.

This flexible structure allows for easy manipulation of several data arrays that are mapped to different
buffers. To open a Buffer Dump window, click on the command Main Menu > View > Buffer Dump.
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Several Windows of Same Buffer

The picture above displays three Buffer Dump windows representing three parts of the same buffer:

e #1 (the largest) shows the buffer contents beginning at address Oh;

e #2 shows the same buffer contents beginning at the same address but displaying data in decimal
format;

e #3 window shows the data beginning at address 200h.

The left-most column in the windows above shows absolute addresses of the first cell in a row. The
addresses always increment by one byte: 0, 1, 2.... Each address is followed by a semicolon (:).
When you resize the window it automatically changes the addresses shown in the address column
in accordance with the number of codes or data that go in one line. Some windows may be split into
two panes — left pane for data in a selected format and right pane showing the same data in ASCII
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format. The window has a toolbar for invoking setting dialogs and commands. Right under the toolbar
the program displays a full path to a loaded file and a checksum of the dump.

Local menu and Toolbar

The local menu, which can be opened by the right mouse click, includes the Buffer Dump window
context commands and dialog calls. Most, but not all, of the local menu lines are duplicated by the local
toolbar buttons displayed at the top of the window. Here are the local menu and toolbar items:

Menu Command or Call Toolbar
button
New address... Addr
Load file to buffer... Load
Save datato file... Save
Configure buffer... Configure
buffer
Window setup... Setup
View only, edit disabled View
Modify data Modify
Operations with memory Block
blocks
Swap fields No button

4.4.3.1 The 'Configuring a Buffer' dialog

Description

Opens the Display from address dialog.

Opens the Load window Dump dialog.

Opens the Save window Dump dialog.

Opens the Configuration Window Dump dialog.

Opens the Window Dump Setup dialog.

By default editing in the buffer dump windows is
disabled and you can only view the data. If the box is
unchecked the editor will be enabled. Then you may
overtype the value under the cursor.

Opens the Modify data dialog. This call is enabled only
when the View only, edit disabled is off.

Opens the Operations with memory blocks dialog.

This command allows swapping the cursor position
between the right and left window panes.

The dialog allows configuring the buffer dumps in the most convenient format and name/rename open
buffers. By default the first opened buffer is named ‘Buffer #0'. The next buffer gets the name ‘Buffer
#1', and so on. You can, however, rename the buffer as you wish.
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By default each buffer has a minimal size of 128K RAM in a PC and by default the ChipProguSB
program fills the buffer with a predefined value (usually OFFh). You can customize these buffer settings
- check the Custom radio button and type in the pattern to fill the buffer.

4.4.3.2 The 'Buffer Setup' dialog

The dialog allows controlling the data presentation in the Buffer Dump window. You can open the dialog
using the windows local menu (the Windows Setup command) or by clicking the Setup button on the
window toolbar.

Element of dialog Description

BT The field displays a list of all open buffers. The programming
i functions will be applied to the active one.

Display Format Is represented by three rgdlo buttons_. Here you can select one of
the formats for the data displayed: binary, decimal or hexadecimal.
Is represented by four radio buttons. Here you can select the data

Display DataAs: ” ;
presentation format in the buffer: 1, 2, 3 or 4 Byte.
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Options

ASCll pane

Display checksum

Limit dump to sub-layer
size

Signed decimal and hex
values

Always display '+'or '-'

Leading zeroes for decimal
numbers

Reverse bytes in words
(LSB first)

Reverse words in dwords

Reverse dwords in gwords

Non-printable ASCII
characters

Replace characters
0x00...0x20

Replace characters
0x80...0xFF

The options here customize the display format.

If the box is checked the right pane will display ASCII characters
corresponding to the data in the buffer dump.

If the box is checked the calculated checksum will be displayed in
the blue strip over the data dump, right under the window local
toolbar.

If the box is checked the window dump will display a part of memory
equal to the active sub-layer's size.

If the box is checked the most significant bit (MSB) in the data
shown in the binary or hexadecimal formats will be treated as a
sign. If MSB=1 the data is negative, if MSB=0 they are positive.

This is a sub-setting for the Signed decimal and hex values option. If
both boxes are checked then the signs '+ and '-' will be displayed.

If the box is checked then each decimal data will be shown with a
number of zeros before the first significant digit - for example the
value of 256 will be presented as 00000256.

If the box is checked then the order of bytes in words will be
reversed, e.g. the MSB will follow the LSB.

If the box is checked then the order of 16-bit words in 32-bit words
will be reversed.

If the box is checked then the order of 32-bit words in 64-bit words
will be reversed.

The characters from the ranges 0x00...0x20 and 0x80...0xFF are non-
printable. The options here customize presentations of non-printable
ASCII characters in the ASCII pane of the buffer dump window.

If the box is checked then all the characters belonging to the range
0x00...0x20 will be replaced with the character dot ('.") or space (' ). The
pair of toggling radio buttons Replace with: sets the replacement
character - dot ('.") or space (' ).

If the box is checked then all the characters belonging to the range
0x80...0xFF will be replaced with the character dot ('.") or space (' ). The
pair of toggling radio buttons Replace with: sets the replacement
character - dot (.") or space (' ).
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4.4.3.3 The 'Display from address' dialog

The dialog enables setting a new address that will become the first address of the visible part of the
Buffer Dump window.

Element of dialog Description

Type new address to Here you may enter any address within the allowed range.
display from:

History Displays the list of previously set addresses. Here you can pick one for
displaying the buffer dump.

4.4.3.4 The 'Modify Data' dialog

The dialog enables editting the data in the Buffer Dump window. The dialog can be invoked only when the
View button on the window's toolbar if off, otherwise the editing is blocked. To modify particular data in the
buffer appoint the location by a cursor and click the Modify button on the window's toolbar. Then enter
a new data value in the pop-up box or pick one from the history list. Or, alternatively, appoint the
location by a cursor and type over the new data on the PC keyboard.

4.4.3.5 The 'Memory Blocks' dialog

The ChipProgUSB program allows complex operations with memory blocks. This dialog controls operations
with blocks of data within one selected buffer or between different buffers.
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¢ Operations with memory block llil

— Source — Operation — Destination
Buffer & Fill with value(s): || | Buffer
" Search for data: j €% Buffer #0
£ Copy
" Compare
Sub-Level: " Ivvert Sub-Level:

" Calculate checksum
¥ | Hegate result
I | wirite result bo destination

* Code (16 ME], bytes
1D location [128 KB, bytes
" Data [128 KB). butes

{* Code (16 ME], bytes
™ 1D location [128 KB, bytes
" Diata [128 KB, bytes

£ AND with value: j
Start address: " OF with value: j Start address:
ID j £ HOR with value: j ID j
End address:
C =]
Full range |

7 5

The dialog box splits in three columns. The Source parameters, shown in the left column, specify the source
memory area for the operations shown in the middle column. The operation’s result will be placed in the area
specified by the Destination shown in the right column. By default the destination is equal to the source
space. Two operations — Fill and Search - do not require a destination address so the dialog disables the
Destination radio button if these two operations are chosen.

Element of dialog Description

Start Address The start address of the memory area in the selected Source buffer, to
(of the Source) which the operation will be applied.

End Address The memory area’s end address. It can be set only for the Source. After
(of the Source) the source address range is defined, the program automatically

calculates the destination area’s end address.

FullRange Sets the start and end addresses equal to the entire address space of
(of the Source) the selected target device.

Start Address The start address of the memory area in the Destination buffer where
(of the Destination) the result of the chosen Operation will be placed to.

The following operations are available through this dialog. Each operation starts when you click OK in the
dialog box. (see notes below).

Operation Description
Fill with Value Fills the source buffer with a value (or a sequence of values) specified in

the text box at the right.
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Search for Data

Copy

Compare

Invert

Calculate Checksum

Negate Result

Write Result to

Destination

AND with Value

OR with Value

XOR with Value

Notes

Searches the source memory area for a particular value (or a sequence
of values) specified in the text box at the right.

Copies a specified area of memory to a new destination address. The
block can be copied within the same address space or to another one.

Compares contents of the specified source and destination memory
areas. The sizes of the source and destination areas are equal. If there’s
a mismatch, the mismatch message box will require permission to
continue the comparison.

Inverts the selected source area contents bit-wise and places the results
in the destination area.

Calculates the checksum, as a 32-bit value, for the source area of
memory. The calculation is done by simple addition. See the note below.

If the box is checked then a checksum, calculated as a 32-bit value by
simple addition, will be then subtracted from zero (this is a known
method of the checksum calculation).

If this box is checked a calculated 32-bit checksum will be written to the
destination sub-level beginning at a specified destination Start Address.
If this box is cleared the checksum will be displayed as a message only.

Performs bit-wise AND operation on the contents of the specified source
memory locations with the operand specified in the text box on the right
and places the results in the destination. See notes below.

Performs bit-wise OR operation on the contents of the specified source
memory locations with the operand specified in the text box on the right
and places the results in the destination.

Performs bit-wise XOR operations on the contents of the specified
source memory locations with the operand specified in the text box on
the right and places the results in the destination.

1. The source and destination memory areas may overlap. But, since operations with memory blocks are
carried out using a temporary intermediate buffer, the overlap does not corrupt the results.

2. The Copy and Compare commands use the blocks specified in the Source address space and the
Destination address space.

3. The checksum is calculated as a 32-bit value by simple addition. If a memory space has byte organization,
then 8-bit values will be added. If it has word organization then 16-bit values will be added.

4. Logical operations (AND, OR, XOR) are performed with the contents of the Source address space, while
the operation result will be written to the Destination address space. The program takes care of
converting the operands to the appropriate memory size for a selected type of memory (16-bit for the
Prog, Datal6, Reg and Stack memory, 8-bit for the Data8 memory).

4.4.3.6 The 'Load File' dialog

The dialog defines parameters of the file to be loaded to the buffer.
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Element of dialog

Description

File Name:

File Format:

Buffer to load file to:

Layer to load file to:

Start address for binary
image:

Offset for loading
address:

4.4.3.6.1 File Formats

Enter a full path to the file in this box, pick the file name from a drop-
down menu list or browse for the file on your computer or network.

The format of the file to be loaded can be selected here by checking one
of the radio buttons in the File Format field of the dialog.

Select the buffer in which the file will be loaded by checking one of the
Buffer# radio buttons. There may be just one such button.

The Buffer to load file to can have more than one memory layer. Select
the layer in which the file will be loaded by checking one of the radio
buttons. There may be just a single button available for choosing.

Files in Binary file format do not carry any address information and
are required to define the start address for the loading. If the file to be
loaded is a binary image enter the start address in the box here.

Files in any formats, except the Binary file format, can carry the
information about the start address for the loading. If the file to be
loaded is not a binary image enter the offset for the file addresses in
the box here. The offset can be positive or negative.

The ChipProgUSB program supports a variety of file formats that can be loaded to the ChipProg

buffers.

File format

Standard/Extended Intel

HEX (*.hex)

Binary image (*.bin)

Motorola S-record (*.
hex, *.s, *.mot)

Description

The Intel HEX file is a text file, each string of which includes the
beginning address to load the data to the buffer, the data to load,
checksums for the string and some additional information. The
ChipProgUSB loader supports both Standard and Extended Intel
HEX format.

The binary image includes the data to be loaded only. These data
will be loaded to the buffer beginning from a specified start address.

The Motorola S-record is a text file, each string of which includes
the beginning address to load the data to the buffer, the data to load,
checksums for the string and some additional information. The
ChipProgUSB loader supports all kinds of the Motorola S-records
with the extensions .hex, .s, .mot.
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Altera POF (*.pof)

JEDEC (*.jed)

Xilinx PRG (*.prg)

Holtek OTR (*.otp)

Angstrem SAV (*.sav)

ASCII Hex (*.txt)

4.4.3.7 The 'Save File' dialog

The Altera POF-file is a text file, each string of which includes the
beginning address to load the data to the buffer, the data to load,
checksums for the string and some additional information. The
format is mostly used for programming PALs and PLDs.

This format is used for programming PALs and PLDs. The JEDEC-
file includes the beginning address to load the data to the buffer, the
data to load, test-vectors and some additional information.

The Xilinx PRG-file is a text file, each string of which includes the
beginning address to load the data to the buffer, the data to load,
checksums for the string and some additional information. The
format is used for programming the Xilinx PLDs.

This format is presented by Holtek company. The OTP-file includes
the beginning address to load the data to the buffer, the data to load,
checksums for the string and some additional information.

This format is presented by Angstrem company (Russia). The SAV-
file includes the beginning address to load the data to the buffer, the
data to load, checksums for the string and some additional
information.

The ASCII TXT-file includes the beginning address to load the data to
the buffer, the data to load, checksums for the string and some
additional information.

The dialog defines parameters of the file to be saved from the buffer.

Element of dialog

FileName:

Addresses

File Format:

Buffer to save file from:

Sub-level to save file
from:

Description

Enter a full path to the file in this box, pick the file name from a drop-
down menu list or browse for the file on your computer or network.

Start and End Addresses define the buffer data space that will be
saved in the File. For saving an entire buffer click the All button.

The format of the file to be saved can be selected here by checking
one of the radio buttons in the File Format field of the dialog.

Select the source buffer from which the file will be saved by checking
one of the Buffer# radio buttons. There may be just a single button
available for choosing.

The Buffer to save file from can have more than one memory layer.

Select the source layer by checking one of the radio buttons. There may
be just a single button available for choosing.
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444 The Device Information window

This window displays the type of selected target device and a list of programming adapters that fit all
available packages for the selected device. For example the picture below shows all Phyton adapters
available for the selected PIC microcontroller. The Socket scheme pictograms below show the correct
positions of a DIP-packaged 40-pin PIC chip and the adapter board into a 48-pin ZIF socket (for the
ChipProg -48 programmer).

| Socket Scheme | Motes {:"?

Device: Microchip PICT18LF4439
Adapter(z]: DIF: Hone
PLCC: AE-P44-pl6
PLCC: AE-P44-p16-2
TAQFP: AE-T44-p16
Socket scheme

EEEREEEEREEEEEEEEEEEE
O OO N NN M

The adapter part numbers are linkable and the links being clicked opens the adapters.chm file with a
description and wiring diagram of the chosen adapter. The cable adapters for in-system programming
are also included into the adapters.chm file. There are some peculiarities that such ISP adapters use
depending on the target device type.

4441 Phyton programming adapters

The adapters.chm file includes short descriptions of the Phyton programming adapters and their wiring
diagrams. Having the adapter diagram a ChipProg user can master it is own adapter or to find the
adaptor available from a third party, which can be used as a replacement for the Phyton brand adapter.

The adapters diagram are presented in a table form, where the rows show connections of the elements
installed on the adapter transition board and the columns (from the left to right) represent:

1st column - Pin numbers of the dual-row pins pluggable to the programmer ZIF socket

2nd column - Pin numbers of the ZIF socket installed on the adapter top
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3rd, 4th, 5th, etc. - Pin numbers of the passive and active components installed on the adapter
board.

See an example of the AE-P44-A32/64 adapter connection table below:

Pin# of the dual-row 40- | Pin# of the PLCC 40- 74HC14 Cl(1uF) | C2(.1uF)
pin plug pin adapter socket latch
(ChipProg ZIF socket)

1 2
2 4
3 6
4 28
5 29
6 9
7 10
8 11
9 12
10 40
11 7
12 13
13 14
14 16
15 17
16 18
17 19
18 20
19 21
20 22,30,42 7 1 1
21 24
22 25
23 26
24 27
25 8
26 31
27 32
28 33
29 34
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4.44.2

30 5
31 36
32 35,3,15,23 14 2
33 37
34 38
35 39
36 40
37 41
38 11

- 43 12
39 44 2
40 1

10,13

Adapters for in-system programming

The adapters.chm file includes short descriptions of the Phyton programming adapters for in-system
programming (e.g. the programming in the user's equipment) and their wiring diagrams the schematic of
connecting the adapter cables to the target. The cable adapters may have 10 to 20 pin headers to be
connected to the pins or complimentary connectors installed in the user's equipment. The pin
connection is specific for certain target devices. The connection diagrams are presented in a table form,
where the columns (from the left to right) represent:

1st column
2nd column

- Pin numbers of the cable adapter header inputs and outputs
- Signals of the target device to be connected

As an example see below a schematic of connecting a 10-pin header BH-10 of the Phyton AE-ISP-U1
cable adapter to the Zilog Z8Fxxx microcontroller for in-system programming.

BH10 ZBFEXXXX
1 Vcc
2 RESET
3 GND
4 DBG
5 GND
6
7
8
9
10

As you can see here not all the BH10 lines should be necessarily used. Only five signals are required for
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4.4.5

4.4.6

programming this device and only two of them are used for sending the the programming signals into the
chip - RESET and DBG. The diagrams in the adapters.chm file use the mnemonic of signal from the
device manufacturers' data sheets.

The Console Window

The Console window displays messages generated by the ChipProgUSB program that can be divided

into two groups: the ChipProg error messages and what-to-do prompts. The window stores messages
even if it is closed. You can open it at any time to view the last 256 messages, and get help for any of
them. The error messages are shown in red color, others in black.

The window should be large enough to watch several messages. To save screen space you can close
the Console redirecting all messages to the popping-up message boxes. To do this, go to the
Configure menu > Environment > Misc tab and select the Always Display Message Box option.
Alternatively you can select the Do not open box if Console window opened option, redirecting all
the messages to the Console window.

Click the Help button in the box or to invoke the ChipProg context-sensitive Help topic associated
with the error, or click the Close button and continue after correcting a parameter error.

Local menu and Toolbar

The local menu, which can be opened by the right mouse click, includes the Console window context
commands and dialog calls. Most, but not all, of the local menu lines are duplicated by the local toolbar
buttons displayed at the top of the window. Here are the local menu and toolbar items:

Menu Command or Call Toolbar Description
button

Clear Window Clear Deletes all the messages from the window

Opens the context-sensitive Help topic associated with

Help on message MHel . C -
b 9 P the error or information in the highligted message

Help on window No button Opens the Console window Help topic

Opens the context-sensitive Help topic associated

Help on word under No butt _ ;
0 button — with the word appointed by the cursor

cursor

Windows for Scripts

ChipProgUSB is featured with the windows specifically supporting operations with scripts. That includes:

(Script) Editor windows

Watches windows
User windows
/O Stream windows

These windows cannot be open from the View menu; they can be opened only when you work with
scripts. Operations with these windows are described in the chapter Scripts Files.
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5 Operating with Programmers

The topics included in this chapter briefly describe basic operations with the ChipProg programmers.
5.1 Inserting devices to a programming socket
Inserting devices in DIP (dual-in-line) packages.

The ChipProg-40, ChipProg-48 and ChipProg-G4 programmers are equipped with 40- or 48-pin ZIF
sockets allowing operating on any DIP-packed devices without additional adapters. They can
accommodate DIP-packed devices with different number of leads (from 4 to 48) and different widths of
the package up to 600 mil. Just a few old DIP-packed devices require special adapters to be
programmed by ChipProgs. The Device Information window prompts if some adapter is required for
the selected device and, if so, it displays the adapter type. The pictogram showing a correct insertion
position of the device is on the programmer at the left of the socket as well as in the Device
Information window. Practically all DIP-packed devices can be inserted in the way shown on the
pictogram. However, there are a few old devices with a non-standard insertion positioning. If such a
device is chosen the Device Information window displays how to insert the device.

Inserting devices in non-DIP packages.

Programming of the devices in SOIC, PLCC, QFP, BGA and other non-DIP packages requires special
adapters. The adapters design allows plugging them into the programmer ZIF sockets. The Device
Information window prompts the adapter type for a selected device.

Any adapter is implemented as a small transition board with two rows of dual-in-line pins pluggable
into the programmer ZIF socket on a bottom side and a ZIF socket of a particular type (SOIC, PLCC,
QFP, BGA, etc.) on a top. The adapter transition board is labeled with a "#1 pin" key mark that helps
to properly position the adapter into the programmer socket. The Device Information window
displays the adapter position into the programmer ZIF socket.

5.2 Auto-detecting the device

If you checked the AutoDetect checkbox on the main window toolbar then a ChipProg programmer
will automatically detect insertion of the device into a programming socket and will check if the
device's leads are reliably squeezed by the socket contacts. In case of the bad contact with any
single lead the programmer blocks further operations and issues a warning that indicates the pin
numbers with bad contacts. This prevents destroying the device or incorrect programming.

The AutoDetect signal can be used for triggering a programming operation by checking the Auto-
Detect presence of device in the socket box in the Options tab of the Program Manager
window. One of the following options can be set here:

e Execute the function selected in the 'Function’ list (the Program Manager tab);
e AutoProgramming;
e Execute script.

At this point the AutoDetect trigger replaces the programmer command executed by a mouse click or
pressing the Start button. This significantly speeds up and simplifies programming of the device
series.
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5.3 Basic programming functions

Sub-topics of this chapter describe all the basic ChipProg-40 and ChipProg-48 operations in a single
programming mode, when a device is programming in the programmer socket. Specific operations for
programming more than one device at one time are described in the Multi- and Gang programming

5.3.1 How to check if a device is blank

1. Select the target device type, pressed the button Select Device in the Main toolbar or select the
command Main menu > Configure > Select device.

2. Insertadevice of the selected type into the programmer socket or into the adapter socket.

3. a) Click the Check button on the main toolbar or
b) Double click on the Blank check function line in the Function list of the Program Manager
window or
c) Select the Blank check function line in the Function list of the Program Manager window
and click the Execute button or
d) Select the Main menu > Commands and click on the Blank check line

then wait for the message Checking ... OK in the Program Manager window, or for the warning
message if the device is not blank

5.3.2 How to erase a device

1. Make sure the device is electrically erasable. Some devices are not erasable; these may be
programmable once, UV erasable, or over-writable — in this case the Erase button is blocked (grey
out).

2. If the device is electrically erasable:
a) Click the Erase button on the main toolbar or
b) Double click on the Erase function line in the Function list of the Program Manager window
or
c) Select the Erase function line in the Function list of the Program Manager window and click
the Execute button or
d) Select the Main menu > Commands and click on the Erase line

then wait for the message Erasing ... OK in the Program Manager window or for the warning
message if the device is not blank after erasing.

5.3.3 How to program a device

In order to program a blank device you need to perform a few consecutive operations:

load the file, that you want to write to the device;

edit the file (if necessary);

configure the device to be programmed (if necessary);

write the prepared information into the device and verify the programming.
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5.3.3.1

5.3.3.2

5.3.33

5.3.34

How to load a file into a buffer

Select the Main menu > File > Load or click the Load button on the local toolbar of the Buffer
window.

In the pop-up dialog box enter the source file name, select the file format, addresses, buffer and
sub-level to load the file to.

Wait for the message File loaded: "......" in the Program Manager window or for a warning
message if the file cannot be loaded for some reason.

How to edit information before programming

1.

If you need to modify source data before writing into the target device, then open the Buffer Damp
window. Never forget that the View button should be released to enable editing.

Make necessary changes in the window via the Modify dialog or appoint the data to be modified
and type the new data over the old data.

How to configure the chosen device

If any parameters displayed in the Device and Algorithm Parameters window can be changed by
editing, their names are shown in blue.

Click on the name of the parameters to be changed to open an appropriate dialog. Set a new value
for the parameter or check/uncheck appropriate boxes and click OK. The parameter value will change
its color to red.

Continue for other parameters that should be changed. All preset changes will become effective in
the target device only upon programming via the Program Manager programming function.

How to write information into the device

Click the Options tab in the Program Manager window. Check the options you need. We
recommend that you always check the Blank check before programming and the Verify after
programming check-boxes to make programming more reliable.

Click the Program Manager tab. Select the Program line in the Function box, and double click
it to start programming of the primary memory layer (Code) or click the Execute button to do so.
Alternatively, you can do the same by clicking the big Program button or selecting the command
Menu > Commands > Program.

Wait for the message Programming ... OK in the Operation Progress box of the Program
Manager tab. If an error has occurred the ChipProgUSB issues an error message.

Execution of the main Program function (always shown in the beginning of the Function list)
writes a specified buffer layer content to the Code device memory. However, other buffer layers
may exist for the selected device (Data, User, etc.). If more than one buffer layer exists for the
selected device go down to the list of functions, expand those that are collapsed and execute the
Program functions for as many types of memory as the device has (Data, User, etc.). Skip this if
just one memory layer Code exists for the device.
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5. IMPORTANT! After programming of all the memory layers (Code, Data, User, etc.) you need to
program the options preset in the Device and Algorithm Parameters window, if they have been
modified. Go down to the Device parameters & ID line, expand it if collapsed, select the
Program function and double click it. Continue until every parameter that was changed in the
Device and Algorithm Parameters window is successfully programmed.

6. Some microcontrollers can be protected against unauthorized reading of the written code by setting
a set of Lock bits. Go down to the Lock bits line, expand it if collapsed and double click the lock
bit# lines one by one. You can optionally lock only certain parts of the device memory. Continue
until every lock bit is set.

7. After every operation above make sure that you watch the Ok [xxxxx... Ok] message in the
Operation Progress box of the Program Manager tab. In case you get an error message stop
the programming and troubleshoot the issue.

5.3.4 How to read a device

There are several ways for reading the device content to an active buffer:

a) Click the Read button on the main toolbar or

b) Double click on the Read function line in the Function list of the Program Manager window or
c¢) Select the Read function line in the Function list of the Program Manager window and click
the Execute button or

d) Select the Main menu > Commands and click on the Read line

then wait for the message Reading ... OK in the Program Manager window or for the warning
message if the device could not be read out.

5.3.5 How to verify programming

There are several ways for checking if the device was programmed correctly:

a) Click the Verify button on the main toolbar or

b) Double click on the Verify function line in the Function list of the Program Manager window
or

c) Select the Verify function line in the Function list of the Program Manager window and click
the Execute button or

d) Select the Main menu > Commands and click on the Verify line

then wait after that which wait for the message Verifying ... OK in the Program Manager window
or for the warning message if the device failed during the verification process.

5.3.6 How to save data on a disc

1. After you have read out the device content into the Buffer or a specified Buffer layer you may need
to save the read data on a PC disc. To save the data:
a) Click the Save button on the local toolbar of the Buffer window or
b) Select the Main menu > File > Save

2. In the pop-up dialog specify the destination file name, format, start and end addresses of the
source (the buffer), and the source sub-level, and click OK.
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5.3.7

5.4

54.1

How to duplicate a device

=

Insert the master device to be copied (duplicated) into the programmer socket.

Read it to an active buffer

3.  Wait for the message Reading... OK in the Operation Progress box of the Program
Manager tab in the Program Manager window. Make sure the master device content is in a
currentbuffer.

4. Remove the master device from the socket and replace it with a blank device to be
programmed. If necessary, check to see if it is blank.

5. Program the device. If you need to make more than one copy of the master device repeat the

operations #4 and #5 as may times as necessary.

n

Programming NAND Flash memory

This chapter describes some peculiarities of the NAND Flash memory devices programming. The
NAND Flash and NOR Flash memory architectures and physical implementations are very different
and, therefore, operations with NOR and NAND Flash devices have their own peculiarities. In terms of
the programmer setup and operations, working with the NAND Flash devices is more complex and the
programming results are very sensitive to the accuracy of the programming options setup. Inaccurate
setup causes wrong device programming.

NAND Flash memory architectures

The NAND Flash memory array comprises of the blocks of pages. Each block usually includes 16, 32,
64 and more pages. Conditionally, the NAND Flash devices can be divided in two groups: the "small
page" and "large page" devices. The "small page" size is 512 bytes for the 8-bit devices and 256 bytes
for the 16-bit devices; the "small page” NAND Flash memory devices' capacity varies from 128K to 512K
bits. The picture below shows the "small page” NAND Flash memory architecture of the
STMicroelectronics™ NAND devices.
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The "large page" size is 2048 bytes for the 8-bit devices and 1024 bytes for the 16-bit devices; the "large
page" NAND Flash memory devices' capacity varies from 256K to 32G bit capacity and higher. The
picture below shows the "large page" NAND Flash memory architecture of the STMicroelectronics™
NAND devices. The latest "large page” NAND Flash devices have as large as 4096 byte page size.
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Read also about bad blocks in the NAND Flash memory devices.

5.4.1.1 Invalid blocks

NAND Flash memory devices have invalid memory blocks that cannot be used for storing data because
some memory cells inside of the device have physical defects - either inherent in a process of the device
manufacturing or acquired in a process of the device exploitation and reprogramming in the user's
equipment. Since a percentage of invalid blocks is pretty small inside of the chip (usually less than 1%)
it is possible to use the device for data storing. In order to use NAND devices with bad blocks these
blocks should be marked in a certain way to prevent fetching data from these blocks or writing in it. This
document equally uses both known terms for such blocks: invalid and bad.

Locations of the invalid blocks or the invalid blocks map should be accessible by the application for
skipping the bad blocks or handling them in other way. To keep the invalid block map every NAND Flash
device has a special cell array, known as the Spare Area, for storing addresses of invalid blocks. See
the Spare Area location in the NAND Flash memory architecture diagrams.

The Spare Area in "small page" 8-bit devices is 16 large, 16-bit devices - 8 Words. The Spare Area in
"large page" devices - 64 Bytes and 32 Words respectfully. Though the Spare Area is dedicated for
marking bad blocks it can be also used as a general purpose memory for storing the user's data. To
avoid accidental losing of the bad block map it is recommended to assign a whole entire Spare Area for
storing the invalid block map and do not write in this area anything else.

5.4.1.1.1 Managing invalid blocks

There are three mostly used methods of handling invalid memory blocks:

Skip Block method
Reserved Block Area method
Error Checking and Correction

The ChipProg programmers support all the methods above.

5.4.1.1.1.1 Skippinginvalid blocks

This is the simplest method of managing invalid blocks. The programming algorithm first reads the entire
Spare_Area to collect the addresses of invalid memory blocks. Then, the programming equipment
writes data to the device page by page with checking the block addresses. If the current block's number
is marked as bad the programmer skips this block and write into the next valid one.

5.4.1.1.1.2 Reserved Block Area

This method is based on the idea of replacing invalid blocks with good blocks by re-directing reading
and writing operations to these good blocks. To implement this method the programming equipment
splits the entire memory in three linear memory areas following each other from the start address of
the memory device. Each of these areas may include both good and bad blocks:

e The User Block Area (UBA) - a linear memory array for storing the user's data;
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o The Block Reservoir - a linear memory array that follows right after the User Block Area; good
blocks from the Block Reservoir replaces invalid blocks from the User Block Area;

e The Reserved Block Area (RBA) - this part of the device's memory stores the information about
bad blocks in the User Block Area replaced by good blocks from the Block Reservoir. This map is
represented by pair of addresses of the invalid UBA's blocks and corresponding good blocks from
the data reservoir. The first good block in the RBA stores the the RBA map table, the second a
duplicate of it in case of the RBA table corruption.

The programming algorithm works in the following way:
1) it splits blocks of the device in three areas: User Block Area, Block Reservoir and Reserved

Block Area;

2) it reads the Spare Area and builds the RBA map table with the following structure of the data

fields:

Field: RBAMarker | CountField InvalidBlock Replaced |InvalidBlock Replaced | ....... Invalid Block Replaced
Block Block Block

Size: 26aiTa 2 6ainTa 2 Gaiita 2 Gavita 2 Gaiita 2 gaita | ....... 2 Gaiita 2 Gaiita

where:

RBA Marker - is OFDFEh (there is an equivalent term for this parameter used in some NAND Flash
device data sheets: Transition Field).

Count Field - starts from 1 and increments by one for each page of the map table.

Invalid Block - Number of the invalid block in the UBA being replaced.

Replaced Block - Number of the valid block in the Block Reservoir that replaces the invalid block
above.

The Invalid Block - Replaced Block pairs follow each other till the page break.

When the programming equipment detects an invalid block in the User Block Area it appoints the first
available valid block in the Block Reservoir and updates the RBA table to keep track of relation
between invalid blocks in the User Block Area and replaced good ones in the Block Reservoir.

5.4.1.1.1.3 Error Checking and Correction

To maintain the stored code integrity it is recommended to use known Error Checking and
Correction (ECC) algorithms. Most NAND Flash device manufacturers publish application notes that
describe the ECC algorithms suitable for using their devices in different applications. To implement a
particular ECC algorithm please check the manufacturer's website. All the ECC-related information are
written into the Spare Area.

5.4.1.1.2 Invalid block map

ChipProg programmers create the invalid block map into the buffer layer Invalid Block Map as a
continues bit array. Valid (good) blocks are represented by zeros (0), invalid (bad) - by ones (1). See
the tab Invalid Block Map in the memory buffer:

© 2009 Phyton, Inc. Microsystems and Development Tools



Operating with Programmers 89

Eﬂ Addr | Loacd | Save |

{File: Mone

Buffer Check sun; 00000003

\aoooaooo: EIEIEIEIEIEIEEI 0ooooool Qooooooo oc
nooooooT: DDDDDDDB\D!Z_I__DQ'ﬂﬁ:ED oooooooo oc

(0000000E: - lid blocks #1 and #8 L
00000015: I
D00000LC: o+ oo oo oo e e aC

For example above:

¢ the value 02h (or 00000010B) at the address 0 means that the blocks #0, 2, 3, 4, 5, 6, 7 are valid
while the block #1is invalid;

o the value 01h (or 00000001B) at the address 1 means that all the blocks in the range #9 to #15 are
valid while the block #8 is invalid.

5.4.1.2 Marking invalid blocks

After the device final testing the device manufacturer' programming equipment fills the working memory
cells with the FFh value. Blocks that are considered to be invalid are marked by writing a non FFh
value (usually 00h) at a certain address in first page (page #0). This address in the NAND Flash Spare
Area is the device dependant; it is specified in the manufacturer data sheet.

Memory organization The marker address
in the Spare Area

8-bit array, page size - 512 Byte. 5

16-bit (word) array, page size - 512 Words. 0

8-bit array, page size - 2048 Byte. Oor5

16-bit (word) array, page size - 1024 Words 0

Take in account that the device itself has no special protection against occasional erasing of the Spare
Area cells when you intentionally erase a whole memory array. However, these Spare Area cells may
store the bad blocks markers written ether by the chip manufacturer or by the chip user after
reprogramming. Being lost the bad block map cannot be restored unless you keep the invalid block
map as a file, etc. It is important to keep track of the invalid block map changes by storing the markers
before the memory erasing and restoring them after the chip erasing. The ChipProg programmers

automatically restore the invalid block map unless the Invalid Block Management is not the Do Not
Use.

The ChipProg creates the invalid block map into the buffer layer Invalid Block Map as a continues bit
array. Valid (good) blocks are represented by zeros (0), invalid (bad) - by ones (1). For example:

the value 02h at the address 0 means that the blocks #0, 2, 3, 4, 5, 6, 7 are valid while the block #1is
invalid;
the value 01h at the address 1 means that all the blocks in the range #9 to #15 are valid while the

© 2009 Phyton, Inc. Microsystems and Development Tools



90 ChipProg Device Programmers

block #8 is invalid.

5.4.2 Programming NAND Flash devices by ChipProg

Programming NAND Flash memory devices by a Phyton ChipProg programmer begins from accurate
setting of the programming options and parameters in the Device and Algorithm Parameters window.
The screen capture below shows the window for the NANDO4GW3B2BN device. The Device
Parameters are divided in two setting groups: Access Mode and Access Mode Parameters.

Edit | Min. Value | Max value| Default | Al Default |
Mame Walue Description
Device Parameters
= Access Mode AcoessMode
Itrvalid Block (IB) Management | Skip B ltvalid Block Management
Spare Area Usage Do Mat Lse Spare Area Usage
Guard Solid Area Dizable Usging Special Area Without [nvalid Blocks [nzide
Talerant Verify Feature Dizablz Taleration the specified numbers of single-bit erars in the specified frame size in Yerfication
Irvalid Block Indication Options | 1B Indication YWalue: 00 | Invalid Block Indication 'alue
Access Mode Parameters
Uszer Area - Start Block a0 Start Block of User Area
ger &rea - Mumber of Blocks 4000 MWumber of Blocks in User &rea
Solid &rea - Start Block 0 Start Block of Area without Irevalid Blocks 1
Solid Area - Mumber of Blocks 1 Murnber of Blocks in Area without [rvalid Blocks
RE& &rea - Start Block, 4040 Start Block of Reserved Block Area
RE& Area - Mumber of Blocks 14 Mumber of Blocks of Rezerved Block Area
Accépiéble Fumber of ermors 4 S.ing.jle-Bit.Enol'-s Murnber for Talerant Verification
Algarithm Parameters
Woo 3,00 Power supply voltage
D 28aa
| Socket Scheme | MNates
Device: STHicroelectronics HMANDO4G'W 3B 2EBN .

IMPORTANT NOTE!

Any changes made in the ‘Device and Algorithm Parameters’ window do not
immediately cause corresponding changes in the target device. Parameter settings
made within this window just prepare a configuration of the device to be programmed.
Physically, the programmer makes all these changes only upon executing an
appropriate command from the ‘Program Manager’ window.
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5.4.2.1 AccessMode

The Access Mode line, normally collapsed, can be expanded to invoke setting dialogs for one of the
following modes:

Invalid Block Management
Spare Area Usage

Guard Solid Area

Tolerant Verify Feature

Invalid Block Indication Option

5.4.2.1.1 Invalid Block Management

Here you can specify the algorithm of managing invalid blocks. Clicking the Invalid Block
Management menu line opens the pop-up dialog:

[‘«3 Lipraibiel B e (18 [l g2 %]
(Do Mot Uze

(1 5kip |B with M ap in O-th Block,
() REA [Feserved Block Area)

[# oK. ] [x Eancel] [? Help ]

Select one of four options:

Do Not Use Ignore information about invalid blocks and do not care of the invalid block
management. Writing into invalid blocks is enabled.

Skip 1B Skip invalid blocks

Skip IB with Map in 0-th  |Skip invalid blocks, put the Invalid block map in the block #0.

Block

RBA (Reserved Block Use the RBA algorithm

Area)

5.4.2.1.2 Spare Area Usage

Here you can specify of how to use the Spare Area. Clicking the Spare Area Usage menu line opens
the pop-up dialog:
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|[_<_4?:i SPETEVTETUEHEE (%)

(3 User D ata %
{1 User D ata with |B Info Forced

[# ok ] [x Eancel] [? Help I

Select one of three options:

Do Not Use This default option means: "in no case do not use Spare Area for storing user's
data". Choosing this default option prevents overwriting invalid block markers in the
Spare Area by the user's data. After erasing the device Flash memory markers of the
invalid blocks will be restored in the Spare Area.

User Data The Spare Area can be used for storing the user's data; the invalid block markers
written into the Spare Area will not be protected against overwriting by user's data.
If this option is chosen the programmer writes the data from its buffer into the major
device memory and when this memory is completely full the programmer begins
writing into the Spare Area. The programmer buffer displays merged memory pages,
including the Spare Area.

User Data with|The Spare Area can be used for storing the user's data but the invalid block markers
IB Info Forced |written into the Spare Area will be protected against overwriting by user's data.
Even if the programmer had overwritten the invalid block markers in the Spare Area it
will restore these markers after completion of the programming operation.

5.4.2.1.3 Guard Solid Area

Some applications require fetching the information with strictly linear address range, e.g. the memory
must be free of invalid blocks in this range. In particular, initialization of a microcontroller is possible only
if the loading code is fetching from the memory device with continiously linear address space, so the
source memory must not have invalid blocks. By default the ChipProgUSB disables guarding the
memory area. Clicking the Guard Solid Area menu line opens the pop-up dialog where you can toggle
the options:

[‘wﬁ Gl Snlil] fye 3

) Enable

[t’ k. J [x Eancel] [? Help ]

When you select Enable in the dialog above you should specify this area by setting two parameters in
the Solid Area setting dialog:

Start Block - the address of the first memory block that does not include invalid blocks
Number of Blocks - the number of valid blocks in the specified memory area
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If in a process of the programming verification the ChipProg locates an invalid block within the specified
Solid Area it will issue an error message and stop the current programming operation.

5.4.2.1.4 Tolerant Verify Feature
Here you can enable working with the memory having a certain number of errors within a specified

memory range or disable this feature. By default is is disabled. Clicking the Tolerant Verify Feature
menu line opens the pop-up dialog where you can toggle the options:

..................

[t’ (] 4 ] [x Eancel] [? Help ]

Usually this option is applicable in case of use the Error Checking and Correction (ECC) method of
managing invalid blocks when you can tolerate with some errors in the data fetched from the memory
device. When you select Enable in the dialog above you should specify two parameters in the
Acceptable number of errors dialog:

ECC Frame size (Bytes) - Size of the memory array where you allow to have errors, in Bytes.
Acceptable number of errors - Acceptable number of single bit errors.

5.4.2.1.5 Invalid Block Indication Option

Here you can choose the invalid block presentation in the ChipProgUSB memory buffer. Clicking the
Invalid Block Indication Options menu line opens the pop-up dialog where you can select either the
'00h' value (default) or the 'OFOh":

!‘ﬁ I el i luee 1 i Ui %]

(3B Indication WYalue: 00
{3 |B Indication Walue: FO

[t’ k. J [x Eancel] [? Help ]

5.4.2.2 Access Mode Parameters

This Access Mode Parameters submenu of the Device Parameters menu allows to invoke setting
dialogs for the following parameters:

User Area

Solid Area

RBA Area

ECC Frame size

Acceptable number of errors
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Some of the parameters above are associated with appropriate Access Modes.

5.4.2.2.1 User Area

Some basis programming operations, including Program, Read, and Verify can be set applicable not
to an entire NAND Flash memory device but to a specified part of the device memory - the User Area.
The Erase and Blank Check operations are applicable only to the entire device. The User Area's
boundaries are set by individual setting of a pair of the following parameters:

User Area - Start Block - the first memory block of the User Area.
User Area - Number of Blocks - the number of blocks in the User Area.

To set the User Area first click the User Area - Start Block submenu line. The setting dialog will pop
up:

a28aa
Edit | Min. Valus | Max Value| Default | All Detault |
Mame Walue Drezcription
Device Parameters
= Access Mode Access Mode
Inwvalid Block (IE] Management | Skip IB Invalid Block Management
Spare Area Usage Do Mot Use Spare Area Usage
Guard Solid Area Dizable Uszing Special Area Without Invalid Blocks Inside
Tolerant Yerify Featurs Dizable Toleration the specified numbers of sinagle-bit errars in the specified frame size in Werification
Invalid Block Indication Optionz | |B Indication Value: 00 | Invalid Elock Indication Y alue
Access Mode Parameters
zer Area - Mumber of Blocks 4000 Mumber of Blocks in Uzer Area
Solid &rea - Start Block a | Start Block of Area without [nealid Blocks - _
Solid Area - Numnber of Blocks ! Gt Uszy Siras - Start Blucle (0, i0y7) %]
FIBA Area - Start Block 4040 ! .
RBA Area - Humber of Blocks 14 Tipe new valle:
ECC Frame Size [bytes] 512 12 [
Acceptable number of enors 4 [%

Type the value and click OK. Then click the User Area - Number of Blocks submenu line and enter the
number of blocks into the pop-up dialog; then click OK to complete the User Area settings.

5.4.2.2.2 Solid Area

The Solid Area's boundaries are set by individual setting a pair of the following parameters:

Solid Area - Start Block - the first memory block of the memory area free of invalid blocks.
Solid Area - Number of Blocks - the number of blocks in the Solid Area.

To set the Solid Area first click the Solid Area - Start Block submenu line. The setting dialog will pop
up:
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access Mode Parameters

Uszer rea - Start Block 1] Start Block of User furea
User Area - Number of Blocks 4000  Number of Blocks in User Area

Saolid Area - Murmber of Blocks |1 | Mumber of Blocks in &rea without Irvalid Blocks
REBA Area - Start Block 4040 gl Ll =
B frea - Nurber of Blocks 14 St Sulltl Sz - St Blusi (UL 2U5H8) %]
ECC Frame Size [bytes) | 512 et i
Acceptable number of erors 4

5 E
Weo 300

Hiztary

Type the value and click OK. Then click the Solid Area - Number of Blocks submenu line and enter
the number of blocks into the pop-up dialog; then click OK to complete the Solid Area settings.

5.4.2.2.3 Reserved Block Area

The Reserved Block Area (RBA) boundaries are set by individual setting a pair of the following
parameters:

RBA Area - Start Block - the first memory block of the RBA.
RBA Area - Number of Blocks - the number of blocks in the RBA.

To set the RBA first click the RBA - Start Block submenu line. The setting dialog will pop up:

; Sq!id .-’-_‘uea - Wumber of Blocks :I . Numbel_of Bllocks in .&leg_withnut Imwalid Blocks

! Hé.ﬁAlea Number l:-f Blocks 1:1 . Nurﬁber Df Blncks &Jﬁéserve—c.i E‘Ilock-Area

i ECC Frame Size [bytes) 12 Frame Size for Talerant Verification

i Aoceptable number of enrars 4 i i 5 : = p p—
= G [UE o - St Blusle (U, 4054 3

e 3.00% Type new walue:

4050} V]

Histary

Type the offset value and click OK. Then click the RBA Area - Number of Blocks submenu line and
enter the number of blocks into the pop-up dialog; then click OK to complete the RBA settings.

5.4.2.2.4 ECCFramesize

This parameter of the Tolerant Verify Feature mode defines a size of the memory array where you
allow to have errors. To set a parameter click the ECC Frame size submenu line. Then specify the
parameter in bytes and click OK to complete the setting.

5.4.2.2.5 Acceptable number of errors

This parameter, associated with the Tolerant Verify Feature mode, defines an acceptable number of
single bit errors in the the memory array defined by the ECC frame size. To set the parameter click the
Acceptable number of errors submenu line. Then enter the number and click OK to complete the
setting.
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5.5

Multi- and Gang-programming

This document operates with two programming modes:

e Single-programming mode means programming one device at a time by means of one ChipProg
programmer (excluding the ChipProg-G4 gang programmer).

e Multi-programming or Gang-programming mode means concurrent programming of multiple
devices at a time by:
-- either a multiple single site programmers of one type connected in one programming cluster driven
from one computer;
-- or a special 4-site ChipProg-G4 gang programmer.

The Multi-programming mode differs from the Single-programming mode in the following items:

1. Only the same type of programmers can be used in this mode - either ChipProg-40 or ChipProg-48
or ChipProg-ISG programmers;

2. Only the same type of the device may be selected for every single programmer connected in one
programming cluster;

3. Only the same set of buffers can be opened for every single programmer connected in one
programming cluster;

4. Only the AutoProgramming function can be executed by the ChipProgUSB in this mode. There is
however one exception - ChipProg-G4 gang programmers can be combined with ChipProg-48 tools;

5. The Program Manager tabs and dialogs are very different.

The Multi-programming mode is intended for small- and middle-volume manufacturing. The
programmers in the Multi-programming mode work concurrently, e.g. you can start programming on
one site, insert a new device into a second socket, start the programming, insert a new device into a
third socket, start the programming, remove the first programmed device, etc.. An ability to linearly
increase the programming system productivity by adding a new ChipProg programmer gives you
flexibility and save money.

In terms of the control there is no difference whether the ChipProgUSB controls a ChipProg-G4 gang
programmer or the program drives a cluster of multiple single ChipProg-40 or ChipProg-48 or ChipProg-
ISG programmers connected to one PC. To launch ChipProgUSB program in the Multi-programming
mode it should be invoked either by using the ChipProgUSB-GANG shortcut in the ChipProguUSB
folder or from the command line with the key /GANG.

The first dialog that appears when you started the ChipProgUSB-GANG shortcut (for the case when
only two programmers forms a two-site programming cluster):
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[/ Seecity sie Mumbers =5

Prezs the button on a programmer that you want to aszign to the
site number 1._.

Azzigned Sites

Site M umber[s] Senial Mumber Descriptinn
1 Mot azzigned  Programmer
2 Mot azzigned Programmer

[ x Canicel and exit

Now you should press the Start button on the programmer to which you would like to assign the site #1.
Then the ChipProgUSB will prompt to assign the site #2 to another programmer (in case there are more
than two programmers in the programming cluster), etc. After assigning numbers to the programmers
you will get the Program Manager window that differs from the same window that you get when you
work with one programmer.

55.1 The Program Manager Window

The Program Manager window is the major control object on the screen from which an operator
controls the ChipProg . While some windows can be closed in a process of programming this one is
supposed to be always open and visible. The window appearance differs from the same Program
Manager window that you get when you work with one programmer.

The window includes three tabs, opening three groups of settings and status indicators:

The Project Manager tab

The Options tab
The Statistics tab

The Project Manager and Options tabs look differently and enable different settings for the ChipProg
programmers working in the single-programming and multi-programming modes. These tabs are
identical for the ChipProg-G4 gang programmer and for the ChipProg-48, ChipProg-40 and ChipProg-
ISP programmers when they are configured to work in the multi-programming mode. See:
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5.5.1.1 The Program Manager tab

Since the only AutoProgramming is available in the multi-programming mode this tab serves for manual
AutoProgramming initiation, displaying the site statisticsand information messages generated by the

ChipProgUSB program.

e

; Program Manager

Program Manager | Options | Statistics |

& Execute || & Erecute |

Mo status Mo ztatie
Tatal: O Tatal: O
Good: O Good: O
Bad: 0O |Bad: 0
1 3 |
Feady

5.5.1.2 The Options tab

The tab serves for setting all programming parameters and options for multi-programming mode.

Element of dialog Description

Buffer: Thefield Buffer displays the active buffer to which the programming
' operations (functions) will be applied. A full list of open buffers is
available here via the drop-down menu.

Here you can set the addresses for the buffer and the target device

Addresses
to which the programming functions will be applied.

The very first address in the target device's physical memory which will
be programmed.

Device start:

The very last address in the target device's physical memory which will

Deviceend:
be programmed.
Buffer start: The very first address in the buffer memory from which the data will be
written to the target device.
Split Data The group of'radlo buttons |n.the SpIiF data field allows to program 8-bit
memory devices to be used in the microprocessor systems with the
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16- and 32-bit address and data buses. To do this the buffer content
should be properly prepared to split one memory file into several
smaller files.

Options:

If this box is checked then AutoProgramming will start immediately
after the ChipProg programmer has detected that the device is in the
programming socket.

Device-Auto-Detect

Check device ID By default this option is always on and the ChipProg always verifies
the target device identifier given by the device manufacturer. If the box
is unchecked the program will skip the device ID checking.

Insert test If this box is checked the ChipProgUSB will test whether each of the
device leads is reliably squeezed by the programming socket contact.
If some contact is bad a current operation will be blocked.

Reverse bytes order If this box is checked the ChipProgUSB will sweep the byte order in
the 16-bit word while it executes the Read, Program and Verify
operations. This option does not affect the data in the ChipProg
buffers, they remain the same after the file loading.

If this box is checked the ChipProgUSB will always check if the target

Blank check before program o o9
device is blank before programming it.

Verify after program If this bo>.< is checkgd the ChipProgUSB will always verify the device
content right after it has been programmed.
If this box is checked the ChipProgUSB will always verify the device

Verify after read . .
content right after it has been read out.

5.5.1.3 The Statistics tab

This tab opens the field displaying the programming session statistical results for each programming site
- Total number of devices that were programmed during the session, what was the yield (Good) and
how many devices have failed (Bad).
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Program Managet aaga
| Program Manager | Elptin:nns| Stalighics
Site # Total Remaining = Good _Bad
1 1] ] 0
2 1] 1] 1]
All 1] ] 0

Element of dialog

Clear statistics

Device Programming
Countdown

Enable countdown

Display message when
countdown value reaches
zero

Reset counters when
countdown value reaches
zero

Countonly successfully
programmed devices

Setinitial countdown
value

Description

This button resets the statistics..

Normally the Total counter increments after each Auto
Programming; the, Good and Bad counters also count up. The
ChipProgUSB reverses the counters to decrement their content (to
count down).

If the box is checked the ChipProgUSB will count the number of the
programmed devices down.

If the box is checked the ChipProgUSB will issue a warning when
the counter Total is zeroed.

If the box is checked the ChipProgUSB will reset all the counters
when the counter Total is zeroed.

If the box is checked the ChipProgUSB will count only the
successfully programmed (Good). All other statistics will be
ignored.

Clicking on the button opens the box for entering a new Total
number that then will be decremented after each Auto Programming
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5.6 In-System Programming

The ChipProg programmers generate all the signals necessary for programming devices installed in
the user's equipment (in-system). In order to program devices in-system the programmers connect to
the target via special adapters. When a device to be programmed is chosen, the ChipProgUSB
software displays a part number of the appropriate cable-adapter in the Device Information window.
The adapters.chm file includes wiring diagrams for all cable-adapters, that allows use of the adapters
made by customers themselves.

General requirements for connecting ChipProg programmers to the target system

Connections 1. Connections must be done in accordance to the adapter's wiring
diagram published in the adapters.chm file.

2. The target system should not shunt or overload the logical signals
generated by the programmer.

3. Some IPS algorithms require generating logical signals with the voltage
levels of 10 to 15V exceeding normal voltages used in electronic
systems (3 to 5V). The target system should be tolerant to applying
such "high voltages".

Powering There are two alternative options for powering the targets:

1. The target gets power from the ChipProg. This is possible only if
the target does not consume too much energy. The current supplied
from the programmer may not exceed 80 mA, a capacity of the target
power circuitry should not exceed 50 uF.

2. The target gets power from a built-in or external power supply. In
this case the power output from the ChipProg should not be connected
with the target. The target system should be tolerant to applying logical
signals with the voltage levels exceeding the voltages on the target.

NOTE! It is strictly prohibited to power the target from both the
programmer and built-in or external power supply simultaneously.

Electrical Max current load for the logical signals - 5 mA.
characteristics of the
ChipProg signals Max current load for the Vcc line - 80 mA.

Max current load for the Vpp line - 80 mA.

NOTE! Always carefully check connecting your ChipProg programmer to the target. Wrong
connecting may, and probably will cause destruction of the programmer's and/or the target
system's hardware.
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Most embedded microcontrollers have different algorithms for the ISP procedure. See the following
topics regarding the ISP for popular microcontrollers:

Specifics of the in-system programming of the Microchip PICmicro

Specifics of the in-system programming of the Atmel AVR microcontrollers

Specifics of the in-system programming of the Atmel 8051 microcontrollers
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6 Programming Automation via DLL

Any ChipProg programmer can be controlled not only by an operator from the ChipProgUSB user
interface but also from an external computerized environment, mostly for the programming automation.
This chapter describes how to integrate a ChipProg programmer into an external environment by means
of the Phyton's proprietary Application Control Interface (hereafter ACI).

6.1  Application Control Interface
What is the Application Control Interface?
The Application Control Interface (hereafter ACI) is a set of proprietary Phyton software allowing
integration the ChipProg programmers into an external computerized environment. The ChipProgUSB
software includes three Application Control Interface components:
1) The ACI.DLL file that specifies a set of ACI functions, which can be invoked from external
applications to perform programming operations. This DLL is completely conformable to the

Microsoft's dynamically-linked shared library concept.

2) The aciprog.h header file written in the C/C++ language that lists all the ACI functions exported
to the ACI.DLL.DLL and the structures associated with these functions.

3) A few program examples that control ChipProg programmers from external applications
Requirements and Restrictions
1) The ChipProgUSB software must be installed on the computer that controls the ChipProg

operations (hereafter the instrumental or host computer). The latest ChipProgUSB software version is
available for free download from the http://www.phyton.com/htdocs/support/update.shtml webpage.

2)The ACI.DLL.DLL requires an operational system Windows 98/ME/2000/XP/Vista and newer.

3) It is necessary to position the windows.h file before the aciprog.h file in the application
program.

How does the Application Control Interface works?

The ACI.DLL launches the programmer executable file by means of the ACI_Launch() function and then
controls the ChipProgUSB software by calling other ACI functions. The ChipProg executable, universal
for all USB-hosted programmers, is the UProgNT2.exe.

Each ACI function, being called by an external application, sends back to this application a unique
function return code. The return code constants - ACI_ERR_xxx - are defined into the aciprog.h file
included into the ACI software set.

An external application can call either an ACI function without any parameter (just by the function hame)
or by the function name with adding a pointer to the structure of parameters. The very first parameter of
any structure is always the 'UNIT size' parameter that defines the structure size. This insures
compatibility of different ACI.DLL versions. The only exemption is the function ACI_IDECommand() -
here we sacrificed uniformity of the structure format in behalf of the pseudo-function declaration
simplicity.
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6.2

Names of all the ACI objects (functions and structures) always begin from the prefix ACI. Names of the
structure patterns complete with the suffix _Params.

Numbers of the memory buffers and layers in buffers begin from zero. All addresses have a 64-bit format
and are presented by two 32-bit halves of this address (low and high) to be the compiler-independent.
For example, if the compiler recognizes the uint64 type of data then the function, which assigns a 64-bit
memory buffer address in the structure ACI_Memory_Params, the function call can be presented as:

ACl_Memory_Params params;
*((uint64 *)params.AddressLow) = 0x123456789ABC;

All addresses in the structures are shown in the format specified by the device manufacturer, i.
e. in Bytes, Words, etc. For example, for any 16-bit microcontroller the address format is
always a Word, not a Byte.

In most cases, in a process of the programming being under control of the external application it is not
necessary to make visible the ChipProgUSB graphical user interface (GUI). The ACI allows to hide the
ChipProgUSB GUI. However, it may be necessary to unhide the programmer GUI, or just some windows
and dialogs, for setting up the programming environment and for the debugging purposes (for example,
for selecting the target device, loading the file, etc.). Then the ChipProgUSB user interface can be hidden
to free more display space for the controlling application.

ACI Functions

In order to set up and control a ChipProg tool the program running on the instrumental computer calls
the Application Control Interface functions listed the matrix below. Most of these functions are grouped in
"bidirectional couples” (In-Out or Get-Set). Calling some Application Control Interface functions requires
structures that specify memory locations, pointers and other objects affiliated with the called function
while other functions do not require any structures. Here is the list of the ChipProg Application Control
Interface functions:
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Application Control
Interface function name

Brief description

Associated
windows
and dialogs

Associated Application
Control Interface
structures

ACI functionsthatstartand stop progra

mming sessions

Starts the ChipProgUSB program. This
function must be always the very first in the

ACI_Launch ; Y NA ACI_Launch_Params
e chain of other Application Control Interface

functions that form the programming session.

Closesthe ChipProgUSB program. This

function must always be the last one in the
ACI_Exit chain of other Application Control Interface NA NA

functions. It completes the external control
session.

ACI functionsthat configure the programmer or getitscurrent

configuration

Loads the programmer configuration

ACI_LoadConfigFile parameters from the host computer to the NA ACI_Config_Params
programmer.
Saves the programmer's current

ACI_SaveConfigFile configuration parameters to the host NA ACI_Config_Params

computer.

ACI functions that get the target device properties or set them

ACI_GetDevice

Gets the manufacturer's name (brand) and
the part number of the device being currently
programmed from the programmer to the host
computer.

Select Device

ACI_Device Params

ACI_SetDevice

Sets the manufacturer's name and the part
number of the device to be programmed in
the programmer.

Select Device

ACI_Device Params

ACI functions that get current parameters of the buffers and layers or configure them

Gets the parameters of a specified memory

ACI_GetLayer buffer and layer from the programmer to the | BufferDump | ACI_Layer Params
host computer.

ACI_CreateBuffer Creates a memory buffer with specified Buffer Dump | ACI_Buffer Params

—_— parameters in the programmer.

ACI_ReallocBuffer Changes a size of the layer #0 in a specified Buffer Dump | ACI_Buffer_Params

memory buffer in the programmer.

ACI functions that read the buffer layer or write into it

Reads data from a specified memory buffer

ACI_ReadLayer Buffer Dump | AClI_Memory Params
from the programmer to the host computer.
Writes data into a specified memory buffer

ACI_WriteLayer from the host computer to the programmer Buffer Dump | ACI_Memory Params
memory buffer.

ACI Fillayer Fills a whole selected layer of a specified Buffer Dump | ACI Memory Params

memory buffer with a specified data pattern.

ACI functions that read the content of the buffer layer or write into it
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Application Control Brief description Associated | Associated Application
Interface function name windows Control Interface
and dialogs structures
. Program
ACI_GetProgrammingParams Gets current programming parameters from Manager> | ACI_Programming_Params
the programmer to the host computer. .
Options
- Program
ACI_SetProgrammingParams Sets programming parameters from the host Manager > ACI_Programming_Params
computer to the programmer. ;
Options

ACI functions that get device-specific programming parameters or set them

: : Device and
. fi h _— .
ACI_GetProgOption Gets current programming options from the Algorithm ACI_ProgOption_Params
—_— programmer to the host computer.
Parameters
. Sets programming options from the host Device and .
ACI_SetProgOption Algorithm ACI_ProgOption_Params
computer to the programmer.
Parameters
. Sets default programming options and Device and .
ACI_AllProgOptionsDefault . . ; Algorithm ACI_ProgOption_Params
programming algorithms inthe programmer. Parameters

ACI functionsthatcontrol programming operation

S

Initiates a specified programming operation

ACI_ExecFunction keeping under control its successful _g_l\ljlg)nar\ZZr ACI_Function Params
completion or failure. E—

ACI StartFunction Initiates a specified programming opgratlon Program ACI Function Params

—_— and then does not check the operation result. Manager = =

ACI GetStatus _Gets a c_urrent programmer status Program ACI PStatus Params

- information Manager

ACI_TerminateFunction Terminates a current programming operation. I\I:/)IiaonLargr;r NA

ACI functions that save and load files to the programmer

Saves a specified file from a specified

ACI_FileSave buffer's layer of the programmer into the Buffer Dump | ACI_File_Params
instrumental computer.
Loads a specified file from the instrumental

ACI_FileLoad computer to a specified buffer's layer in the | Buffer Dump | ACI_File_Params

programmer.

ACI functionsthatdisplay programmer’swindows and dialogs for settingup and
debugging external programmingsessions

. . . . i >
ACI_SettingsDialog Displays the programmer Preferences dialog. g?er;]::?:rr]ies NA
ACI_SelectDeviceDialog Displays the Select Device dialog. Select Device | NA
ACI_BuffersDialog Displays the memory buffers setting dialog. Buffer Dump | NA
ACI_LoadFileDialog Displays the file loading dialog. Buffer Dump | NA
ACI_SaveFileDialog Displays the file saving dialog. Buffer Dump | NA
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6.2.1 ACI_Launch
ACI_FUNCACI_Launch(ACI_Launch_Params * params);

Description

This function launches the ChipProgUSB software. Optionally this ACI function can launch the
programmer with a specified command line key and load the file that will configure the ChipProg
hardware.

This ACI function must always be called before any other ACI function !

6.2.2 ACI_Exit
ACI_FUNCACI_EXxit();

Description

Call of this function stops the ChipProgUSB software. In most cases the programmer practically
immediately stops running. Sometimes, after calling the ACI_EXxit function, it continues working for a
while to correctly complete an earlier launched process. After all the ChipProg will stop and quite itself
after finding that the controlling process has ended.

It is possible, however, that the ChipProgUSB software will keep running even after the control process
has completely stopped. This is abnormal situation and, as the result, it will be impossible to re-

establish communication with the programmer hardware by launching the ACI_Launch function. In this
case you should manually close the ChipProgUSB program via the Window Task Manager.

6.2.3 ACI_LoadConfigFile

ACI_FUNCACI_LoadConfigFile(ACI_Config_Params * params);

Description

This function loads the ChipProg configuration parameters that include all the settings available via the
ChipProgUSB dialogs (memory buffer configurations, programming options, test of the device insertion,
etc.).

The ChipProgUSB program automatically saves some programming options and settings including a
type of the selected device, the device parameters, the start and end addresses of the device being
programmed, the buffer start address, and a set of the AutoProgramming commands and then
automatically restores these parameters when the user changes the device type.

See also: ACI_SetProgrammingParams, ACI_SetProgOption, ACI GetProgrammingParams,
ACI _GetProgOption, ACI_SaveConfigFile
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6.2.4

6.2.5

6.2.6

6.2.7

ACI_SaveConfigFile

ACI_FUNCACI_SaveConfigFile(ACI_Config_Params * params);

Description

This function saves the ChipProg options specified in the tab Option of the Program Manager window
(memory buffer configurations, programming options, test of the device insertion, etc.).

The ChipProgUSB program automatically saves some programming options and settings including a
type of the selected device, the device parameters, the start and end addresses of the device being
programmed, the buffer start address, and a set of the AutoProgramming commands and then
automatically restores these parameters when the user changes the device type.

Ci. Takke: ACIl_SetProgrammingParams, ACI_SetProgOption, ACI_GetProgrammingParams,
ACI GetProgOption, ACI LoadConfigFile

ACI|_SetDevice

ACI_FUNCACI_SetDevice(ACI_Device_Params * params);

Description

This function chooses the device to be programmed. Along with the device type the function
automatically loads the device parameters, start and end addresses and the buffer start address. Plus it
restores the AutoProgramming command list if the selected device type has been ever selected earlier
but the parameters listed above were changed in a process of the programming session.

ACI_GetDevice

ACI_FUNCACI_GetDevice(ACI_Device_Params * params);

Description

This function gets the device's part number (name) and the name of the manufacturer of the device being
programmed now (for example: AT89C51, Atmel; 28F128J3C, Numonyx, etc.).

ACI_GetLayer

ACI_FUNCACI_GetLayer(ACI_Layer Params * params);

Description

This function gets the parameters of a specified memory buffer and buffer's layer.
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See also the ACI Layer Params structure description.

6.2.8 ACI_CreateBuffer

ACI_FUNCACI_CreateBuffer(ACI_Buffer_Params * params);

Description

This function creates a buffer with the parameters specified by the ACI_Buffer Params structure. The
ChipProgUSB program automatically assigns the buffer #0 so it is not necessary to create this buffer by
a separate command.

See also the ACI _Buffer Params structure description.

6.2.9 ACI_ReallocBuffer

ACI_FUNCACI_ReallocBuffer(ACI_Buffer_Params * params);

Description

This function changes the size of the layer #0 in the memory buffer specified in the ACI_Buffer_Params
structure.

See also the ACI_Buffer_Params structure description.

6.2.10 ACI_ReadLayer

ACI_FUNCACI_ReadLayer(ACI_Memory_ Params * params);

Description

This function reads data from a specified memory buffer. The data size is limited by 16M Bytes.

Note! This function reads the data from the programmer's memory buffer but does not physically
read out the content of the selected target device. In order to physically read out the device
memory content execute the programmer command (function) Read by means of the
ACI_ExecFunction or ACI_StartFunction with appropriate attributes.

6.2.11 ACI_WriteLayer

ACI_FUNCACI_WriteLayer(ACI_Memory Params * params);

Description
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This function writes data to a specified memory buffer. The data size is limited by 16M Bytes.

Note! This function writes the data to the programmer's memory buffer but does not physically
program the device. In order to physically write data from the buffer to the device's memory execute
the programmer command (function) Program by means of the ACl_ExecFunction or
ACI_StartFunction with appropriate attributes.

6.2.12 ACI_FillLayer

ACI_FUNCACI_FillLayer(ACI_Memory_Params * params);

Description

This function fills a whole active layer of a specified memory buffer with a specified data pattern. This
function works much faster than the ACI_WriteLayer function which writes data to the buffer layer.

Note! This function fills the programmer's memory buffer with a specified data pattern but does not
physically write them to the device being programmed. In order to physically write data from the
buffer to the device execute the programmer command (function) Program by means of the
ACI_ExecFunction or ACI_StartFunction with appropriate attributes.

6.2.13 ACI_GetProgrammingParams

ACI_FUNCACI_GetProgrammingParams(ACI_Programming_Params * params);

Description

This function gets current programming parameters specified in the tab Option of the Program Manager
window (memory buffer configurations, programming options, test of the device insertion, etc.).

See the ACI_Programming Params structure description.

6.2.14 ACI_SetProgrammingParams

ACI_FUNCACI_SetProgrammingParams(ACI_Programming_Params * params);

Description

This function sets programming parameters specified in the tab Option of the Program Manager window
(memory buffer configurations, programming options, test of the device insertion, etc.).

See also the ACI _Programming Params structure description.
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6.2.15 ACI_GetProgOption

ACI_FUNCACI_GetProgOption(ACI_ProgOption_Params * params);

Description

This function gets current settings from the Device and Algorithm Parameters Editor window. As an
example see this window for one of the microcontrollers below.

Edit | Min. value [ Max Value| Default | All Defautt |

MHame Walue | Description

Device Parameters
JCFGT & UCFG2 Usger Configuration REG.#1 & REG.82
SELs i ] JECHE sECUATED]

Boot Status Byte i | %alue for Boot Stat-l:.is.B_l,Jte

Sectors to Eraze Launch 'Eraze’ function to eraze these sectors
Algarithni Parameters

Voo 3.30% | Power supply vaoltage

| Socket Scheme fNotes

Device: NXP/Philips PBILPCI38

Note! This function does not physically read the specified information from the device being
programmed. It reads from some virtual memory locations in the host PC's RAM, associated with
physical locations in the target device's memory and registers. If the option, which you would like to
check, is a property of the device's memory or registers then first you have to execute the programmer
command (function) Read in the command group Device Parameters by means of the
ACI_ExecFunction or ACI_StartFunction with appropriate attributes. Then you can read the execute
the ACI_GetProgOption function.

See also the ACI_ProgOption_Params structure description.

6.2.16 ACI_SetProgOption

ACI_FUNCACI_SetProgOption(ACI_ProgOption_Params * params);

Description

This function sets device-specific options and parameters, which are specified in the Device and
Algorithm Parameters Editor window. As an example see this window for one of the microcontrollers
below.
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6.2.17

Edit | Min. Value | Max Value| Default | All Default |
Hame Walue | Description

Device Parameters
UCFGT & UCFG2 Uzer Configuration REG. #1 & REG.H2
SEEE Jicoe ] oecionsaciainibite

Boot Status Byte |0 [ iu.‘.alul;e“f"c-l Boot \E;tat.ljs'Byte

Sectors to Erase Launch 'Erase’ function to eraze these sectors
Algarithni Parameters

Wi 320 | Power supply voltage

| Socket Scheme | Notes

Device: "NXP/Philips PBILPCI38

Note! This function does not physically write the specified information into the device being
programmed. It actually writes to some virtual memory locations in the host PC's RAM, associated
with physical locations in the target device's memory and registers. In order to complete programming
the device parameters and to physically program them into the device's memory you should execute
anappropriate Program command (function) in the command group Device Parameters by means of
the ACI _ExecFunction or ACI_StartFunction with appropriate attributes.

See also the ACI_ProgOption_Params structure description.

ACI_AllIProgOptionsDefault

ACI_FUNCACI_AIlIProgOptionsDefault();
Description

This function sets default device-specific options and parameters specified in the Device and
Algorithm Parameters Editor window. These default parameter sets vary. They are defined by the

device manufacturers in the device data sheets.

Note! This function does not physically restore the default settings into the device being
programmed. It actually writes to some virtual memory locations in the host PC's RAM, associated
with physical locations in the target device's memory and registers. In order to complete programming
the device parameters and to physically fix them in the device's memory you should execute an
appropriate Program command (function) in the command group Device Parameters by means of
the ACI_ExecFunction or ACI_StartFunction with appropriate attributes.

6.2.18 ACI_ExecFunction

ACI_FUNCACI_ExecFunction(ACI_Function_Params * params);
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Description

This function launches one of the major programming operation (Read, Erase, Verify, etc.) specified by
the ACI_Function_Params. Being executed the ACI_ExecFunction does not allow to call any other ACI
function until the programming operation, initiated by the ACI_ExecFunction function, completes the
job. This differs the ACI_ExecFunction from the ACI_StartFunction that returns the control immediately
after it was called.

6.2.19 ACI_StartFunction

ACI_FUNCACI_StartFunction(ACI_Function_Params * params);

Description

This function launches one of the major programming operation (Read, Erase, Verify, etc.) specified by
the ACI_Function_Params and immediately returns control to the external application no matter whether
the programming operation, initiated by the ACI_StartFunction, has completed or not. This differs the
ACI_StartFunction from the ACI_ExecFunction. It is possible to check if the operation has completed
by the ACI_GetStatus function call. This allows to monitor executing programming operations if they
last for a quite long time.

6.2.20 ACI_GetStatus

ACI_FUNCACI_GetStatus(ACI_PStatus_Params * params);

Description
This function gets the programmer status that includes:

1) The status of the programming operation initiated by the ACI_StartFunction call (whether it has
completed or it is still in progress);
2) The device insertion status (certainly if this option is enabled in the tab Option of the Program

Manager window).

6.2.21 ACI_TerminateFunction

ACI_FUNCACI_TerminateFunction();

Description

This function terminates a current programming operation initiated by the ACI_StartFunction call.
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6.2.22

6.2.23

6.2.24

6.2.25

6.2.26

ACI_FileLoad

ACI_FUNCACI_FileLoad(ACI_File_Params * params);

Description

This function loads a specified file into a specified buffer's layer. The control program running on the host
PC should not worry about the file's format settings - the ChipProgUSB software takes care of this.

ACI_FileSave

ACI_FUNCACI_FileSave(ACI_File_Params * params);

Description

This function saves a specified file from a specified buffer's layer. The ChipProgUSB software enables
saving files in all popular formats: HEX, Binary, etc..

ACI_SettingsDialog

ACI_SettingsDialog();

Description

This macros opens the Configure > Preferences setting dialog. The dialog will be visible regardless of
the ChipProgUSB main window status - the main window can remain closed but the Configure >
Preferences setting dialog will appear on the computer screen allowing manipulations in the dialog.

ACI_SelectDeviceDialog

ACI_SelectDeviceDialog();

Description
This macros sends a command that opens the Select Device dialog. The dialog will appear on the

screen regardless of the ChipProgUSB main window status - the main window can remain closed but
the Select Device dialog will appear on the computer screen.

ACI_BuffersDialog

ACI_BuffersDialog();

Description
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This macros opens the Memory Dump Window Setup dialog. The dialog will be visible regardless of
the ChipProgUSB main window status - the main window can remain closed but the Memory Dump
Window Setup dialog will appear on the computer screen to allow the buffer setup. See the dialog
example below.

Vo iy Wiy ety []
Buffer Options
G A5CH pane

Display buffer checkzum

[ Limit dump to laver size

[15igned decimal and hex values
[] &hways display '+ aor -

Display Data s [ Leading zeroes for decimal numbers

(& Bites [ 1Reverse bytes in words [MSE first]
O Wards (16 bits] [] Reverse words in dwords
) Double Words (32 bits] [ 1Reverse dwords in qwords

() Quad ‘Wards (B4 bitz]
MHonprintable A5 characters

] Replace characters 0x00...0x20

Dizplay Format

O Binary Replace characters 0x30... 0xFF
() Hexadecimal Rieplace with: ) dot)
() Decimal (¥) Space

7

6.2.27 ACI_LoadFileDialog

ACI_LoadFileDialog();
Description
This macros opens the Load File dialog. The dialog will be visible regardless of the ChipProgUSB main

window status - the main window can remain closed but the Load File dialog will appear on the
computer screen. See the dialog example below.
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S Loadl Fila

File Mame:

File: Earmat;

() Standard/E stended Intel HEX, [ hex]
() Binary image [*.bin)

() Motorala S-record [ hex:® 2% mot]
() POF [ paf)

(JEDEC [*jed)

(PRG [*.prg)

(" Haoltek OTP [*.atp]

() dngstrem S8Y [*.sav)

(IASCI Hes [=.tut)

(AL Dctal (= tet)

Start address far binary image: |

Offset for loading addiesses: [

Buffer to load file to:

(%) Buffer #0

Layer ta load file to:

(%) Code (128 KB), bytes

o

6.2.28 ACI_SaveFileDialog

ACI_SaveFileDialog();

Description

This macro sends a command that opens the Save File dialog. The dialog will be visible regardless of
the ChipProgUSB main window status - the main window can remain closed but the Save File dialog
will appear on the computer screen. See the dialog example below.
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a

Addreszes

Start: |0H
End: | 1FFFH

&l

Buffer to zawe file fram:

(#) Buffer #0

& (@]

File: format

(®i5randard/E stended Intel HEX
) Binary image

) Motorola §

{JPOF

{2 JEDEC

() PRG
(0 ASCI Hex

O ASCH Octal

Layer to zawve file from:

{(#) Code [128 KB). butes

6.3 ACI Structures

This chapter describes the structures used by the ACI functions.

Structure The ACI function that uses the structure
ACI_Launch_Params ACI_Launch

ACI Config Params ACI LoadConfigFile, ACI_SaveConfigFile
ACI_Device Params ACI_GetDevice, ACI_SetDevice,
ACI_Layer Params ACI_GetLayer

ACI_Buffer_Params ACI_CreateBuffer, ACl_ReallocBuffer
ACI_Memory Params ACI_ReadLayer, ACI_WriteLayer, ACI_FillLayer
e

ACI ProgOption Params ACI GetProgOption, ACI SetProgOption
ACI_Function_Params ACI_ExecFunction, ACI_StartFunction
ACI_PStatus_Params ACI_GetStatus

ACI_File_Params ACI_FileLoad, ACI_FileSave

Here is an example of the structure syntax:

typedef struct tagACl_Buffer_Params
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{
UINT Size; // (in) Size of structure, in bytes
DWORD LayerOSizelLow; // (in || out) Low 32 bits of layer O size, in bytes
DWORD LayerOSizeHigh; // (in || out) High 32 bits of layer O size, in bytes

// Layer size is rounded up to a nearest value

supported by programmer.
LPCSTR BufferName; // (in) Buffer name
UINT BufferNumber; // For ACI_CreateBuffer(): out: Created buffer number

// For ACI_ReallocBuffer(): in: Buffer number to realloc

UINT NumBuffers; // (out) Total number of currently allocated buffers
UINT NumLayers; // (out) Total number of layers in a buffer

} ACI_Buffer_Params;

Each structure includes a number of parameters (here Size, Layer0SizeLow, NumBuffers, etc.). The

parameter's name follows its format (UINT, DWORD, LPCSTR, CHAR, BOOL, etc.). The comment to the

parameter begins from a bracketed symbol showing the direction of sending this parameter:

¢ (in) - the parameter is sent from the instrumental computer to the programmer;

e (out) - the parameter is sent from the programmer to the instrumental computer;

e (in || out) - the parameter can be sent in either directions depending on the ACI function
context.

6.3.1 ACI_Launch_Params

typedef struct tagACl_Launch_Params

{
UINT Size; // (in) Size of structure, in bytes
LPCSTR ProgrammerExe; // (in) Programmer executable file name
LPCSTR CommandLine; // (in) Optional programmer command-line parameters
BOOL DebugMode; // (in) Debug mode. Programmer window is not hidden

} ACI_Launch_Params;

This is the name of the programmer executable file. If the parameter does not
include a full path then the program will search for the UprogNT2.EXE file into
the folder where the ACI.DLL resides.

Programmertxe The target folder name, where the the UprogNT2.EXE file resides, is defined
by the parameter "Folder" of the ""HKLM\SOFTWARE\Phyton\Phyton
ChipProgUSB Programmer\x.yy.zz" key. It is supposed that multiple
ChipProgUSB versions can be installed on the host computer.

This structure member specifies the command line options. One of the option
is NULL (no keys). If the host computer drives a cluster of multiple
programmers then the only way to launch a certain programmer is to specify
the /N<serial number> for the CommandLine structure member.

CommandLine

This key controls the ChipProgUSB main window visibility. Setting TRUE for
this structure member makes the ChipProgUSB main window visible. Then
DebugMode you can manipulate with the programmer using its user interface - open
windows, set any programmer resources, execute programming operations,

etc..

See also: ACI Launch
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6.3.2 ACI_Config_Params

typedef struct tagACl_Config_Params

{

UINT Size; // (in) Size of structure, in bytes
LPCSTR FileName; // (in) Options file name to load/save configuration

} ACI_Config_Params;

FileName

This is the name of the file that configures the
programmer.

See also: ACI_LoadConfigFile, ACI_SaveConfigFile

6.3.3 ACI_Device Params

typedef struct tagACl_Device_Params

{
UINT Size; // (in) Size of structure, in bytes
CHAR Manufacturer[64]; 7/ (in || out) Device Manufacturer
CHAR  Name[64]; // (in || out) Device Name

} ACI_Device_ Params;

Manufacturer The manufacturer of the device being programmed
Name The device part number as it is displayed in the
programmer's device list

See also: ACI SetDevice, ACI GetDevi

ce

6.3.4 ACI_Layer Params

typedef struct tagACl_Layer_Params

{

UINT Size;

UINT  BufferNumber;
buffer number is O

UINT LayerNumber;
number is 0

DWORD LayerSizelLow;

DWORD LayerSizeHigh;

DWORD DeviceStartAddrLow;
layer

DWORD DeviceStartAddrHigh;
this layer

DWORD DeviceEndAddrLow;
layer

// (in) Size of structure, in bytes
// (in) Number of buffer of interest, the first

// (in) Number of layer of interest, the Ffirst layer
// (out) Low 32 bits of layer size, in bytes
// (out) High 32 bits of layer size, in bytes
// (out) Low 32 bits of device start address for this

// (out) High 32 bits of device start address for

// (out) Low 32 bits of device end address for this
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DWORD DeviceEndAddrHigh;

layer

DWORD DeviceBufStartAddrLow;

// (out) High 32 bits of device end address for this

// (out) Low 32 bits of device memory start address

in buffer for this layer

DWORD DeviceBufStartAddrHigh;

// (out) High 32 bits of device memory start address

in buffer for this layer

UINT UnitSize;
BOOL FixedSize;
ACI_Real locBuffer()

// (out) Size of layer unit, in bits (8, 16 or 32)
// (out) Size of layer cannot be changed with

CHAR  BufferName[64]; // (out) Buffer name

CHAR LayerName[64]; // (out) Layer name, cannot be changed

UINT  NumBuffers; // (out) Total number of currently allocated buffers
UINT  NumLayers; // (out) Total number of layers in a buffer

} ACI_Layer_Params;

The ordinal number of the memory buffer, content of which is required by

BufferNumber the ACI_GetLayer function. Numbers of ChipProg memory buffers begin
from #0.
The ordinal number of the layer in the memory buffer, the content of which
LayerNumber is required by the ACI_GetLayer function. The layer numbers begins from
#0.
LayerSizeLow, Here the function returns the range of the memory layer's addresses in
LayerSizeHigh bytes.
Here the function returns the device's start address for the selected
DeviceStartAddrLow, | M€MOry Iay. er. This address is' the dev!ce‘s property anq s'FrictIy dgpends
DeviceStartAddrHigh on the device type - usually 'FhIS value is zero. Do not mix it up with the'
start address of a programming operation that can be shifted by a certain
offsetvalue.
Here the function returns the device's end address for the selected memory
i layer. This address is the device's property and strictly depends on the
DeviceEndAddrLow, device type. Do not mix it up with the end address of a programming
DeviceEndAddrHigh | operation editable in the setup dialog. The selected layer's address range
can be defined as a difference between the end address and the start
address plus 1.
DeviceBufStartAddrL | Here the function returns the start address for the selected memory buffer -
ow, usually this value is zero.
DeviceBufStartAddrH
igh
UnitSize This structure member specifies formats of the data in memory layer: 8 for
the 8-bit devices, 16 - for 16-bit devices and 32 for 32-bit devices.
This flag, if TRUE, disables resizing the memory layer by the
FixedSize ACI_ReallocBuffer function. There is one restriction on use of this flag:
since the layer #0 is always resizeable the FixedSize is always FALSE
for the layer #0.
BufferName The name of the memory buffer as it was defined in the ChipProg interface
or by the ACI_CreateBuffer function call.
LayerName Reserved name of the memory buffer's layer that cannot be changed by the
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The ordinal number of the memory buffer, content of which is required by

BufferNumber the ACI_GetLayer function. Numbers of ChipProg memory buffers begin
from #0.
ACI.DLL user.

NumBuffers The number of the assigned memory buffers.

The number of layers in the programmer's memory buffers. This is a pre-

NumLayers X ) o .
defined device-specific value that is the same for all memory buffers.

See also: ACI_GetLayer

6.3.5 ACI_Buffer_Params

typedef struct tagACl_Buffer_Params
{
UINT Size; // (in) Size of structure, in bytes
DWORD LayerOSizelLow; // (in/out) Low 32 bits of layer O size, iIn bytes
DWORD LayerOSizeHigh; // (in/out) High 32 bits of layer O size, in bytes
// Layer size is rounded up to a nearest value
supported by programmer.
LPCSTR BufferName; // (in) Buffer name
UINT BufferNumber; // For ACI_CreateBuffer(): out: Created buffer number
// For ACI_ReallocBuffer(): in: Buffer number to realloc
UINT  NumBuffers; // (out) Total number of currently allocated buffers
UINT NumLayers; // (out) Total number of layers in a buffer
} ACI_Buffer_Params;

This structure member represents the buffer layer #0's size in Bytes. This
size lays in the range between 128K Bytes to 32G Bytes (may be
changed in the future). The ChipProgUSB allows assigning buffers with
fixed sizes only (see the list on the picture below). Any intermediate value
will be automatically rounded up to one of the reserved buffer sizes. For
example if you enter '160000' the programmer will assign a 1MB buffer
layer.

LayerOSizelLow,
LayerOSizeHigh

Being used with the ACI CreateBuffer function this structure member
BufferName represents the name of buffer that will be created. This structure member
used with the ACI ReallocBuffer function will be ignored.

After calling the ACI_CreateBuffer function this structure member returns
BufferNumber the created buffer's number. After calling the ACI_ReallocBuffer function -
the number of the buffer, size of which should be changed (re-allocate).

This structure member represents the current number (quantity) of

NumBuff
umsutrers memory buffers being opened.

This structure member represents the number (quantity) of layers in

NumLayers . -
Y memory buffers. This value is the same for all opened buffers.
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See also: ACI CreateBuffer, ACI ReallocBuffer

ACIl_Memory_Params

typedef struct tagACl_Memory_Params

{

UINT Size; // (in) Size of structure, in bytes

UINT  BufferNumber; // (in) Number of buffer of interest, the first buffer
number is O

UINT LayerNumber; // (in) Number of layer of interest, the First layer
number is O

DWORD AddressLow; // (in) Low 32 bits of address, in layer units (natural to
device address)

DWORD AddressHigh; // (in) High 32 bits of address, in layer units (natural
to device address)

PVOID Data; // (in || out) Buffer to data to read to or write from

DWORD DataSize;
max. 16 MB (0x1000000)
DWORD Fillvalue;

only
} ACI_Memory_Params;

// (in) Size of data to read or write, in layer units,

// (in) Value to fill buffer with, used by ACI_FillLayer()

BufferNumber The ordinal number of the buffer to read from or to write into. The buffer
numerical order begins from zero.
LayerNumber The ordinal number of the memory buffer's layer to read from or to write into.
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The layer numerical order begins from zero.

AddressLow,
AddressHigh

The start address in the memory layer to read from or to write into
represented in the units specified by the chosen device manufacturer - Bytes,
Words, Double Words. This structure member is ignored in case of use with
the ACI_FillLayer function.

Data

Being used with different ACI functions this structure member has different
meanings. In case of use with the ACI_ReadLayer function it represents the
pointer to the data read out from the ChipProg buffer's layer. In case of use
with the ACI_WriteLayer - the pointer to the data to be written to the ChipProg
buffer'slayer. The Data is ignored if it is used with the ACI_FillLayer function.

DataSize

This structure member represents the data format given in memory units
specified by the device manufacturer (Bytes, Words or Double Words). The
program ignores the DataSize if it is used with the ACI_FillLayer function.

FillvValue

This is the data pattern that fills an active ChipProg buffer's layer by means of
the ACI_FillLayer function. If, for example, the FillValue is presented in the
DWORD format then the 8-bit memory layers will be filled with the lower byte
of the Fillvalue pattern, the 16-bit layers - with the lower 16-bit word and the
32-bit layers - with a whole FillValue pattern.

See also: ACI_ReadLayer, ACI_WriteLayer, ACI_FillLayer

6.3.7 ACI_Programming_Params

typedef struct tagACIl_Programming_Params

{

UINT  Size; // (in) Size of structure, in bytes

BOOL InsertTest; // (in || out) Test if device is attached

BOOL CheckDeviceld; // (in || out) Check device identifier

BOOL ReverseBytesOrder; // (in || out) Reverse bytes order in buffer

BOOL BlankCheckBeforeProgram; // (in |] out) Perform blank check before
programming

BOOL VerifyAfterProgram; // (in || out) Verify after programming

BOOL VerifyAfterRead; // (in || out) Verify after read

BOOL SplitData; // (in || out) Split data: see ACI_SP_xxx constants

BOOL DeviceAutoDetect; // (in |] out) Auto detect device in socket (not
all of the programmers provide this feature)

BOOL DialogBoxOnError; // (in || out) On error, display dialog box

UINT AutoDetectAction; // (in |] out) Action to perform on device
autodetect or "Start”® button, see ACI_AD_ xxx constants

DWORD DeviceStartAddrLow; // (in || out) Low 32 bits of device start address
for programming operation

DWORD DeviceStartAddrHigh; // (in || out) High 32 bits of device start address
for programming operation

DWORD DeviceEndAddrLow; // (in || out) Low 32 bits of device end address
for programming operation

DWORD DeviceEndAddrHigh; // (in || out) High 32 bits of device end address

for programming operation
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DWORD DeviceBufStartAddrLow; // (in || out) Low 32 bits of device memory start
address in buffer for programming operation

DWORD DeviceBufStartAddrHigh; // (in || out) High 32 bits of device memory start
address in buffer for programming operation
} ACI_Programming_Params;

This is the command to check the device insertion before starting any
InsertTest programming operations on the device. The procedure will check if every chip
leads have good contact in the programming socket.

This is the command to check a unique internal device identifier before the

CheckDeviceld i .

device programming.

This is the command to reverse the byte order in 16-bit words when
ReverseBytesOrder programming the device, reading it or verifying the data. This structure member

does not effect the data value in the ChipProg memory buffers - these data
remain the same as they were loaded.

BlankCheckBeforeProg | This is the command to check whether the device is blank every time before
ram executing the Program command.

This is the command to verify the data written into the device every time after

VerifyAfterProgram i
executing the Program command.
VerifyAfterRead This is the command to verify the data written into the device every time after
executing the Read command.
This is the command to split data in accordance with the value of the constants
SplitData ACI_SP_xxx* in the aciprog.h file (see below). This allows 8-bit memory devices

to be cascaded in multiple memory chips to be used in the systems with 16- and
32-bit address and data buses.

This is the command to scan all the device's leads in a process of the device
insertion into the programming socket. If the DeviceAutoDetect is TRUE the
programmer will check whether all of the device's leads are reliably gripped by
DeviceAutoDetect the programmer socket's sprung contacts. Only when the reliable device
insertion is acknowledged, the program launches a chosen programming
operation, script or a batch of single operations programmed in the
AutoProgramming dialog.

If this structure member is TRUE then any error occurred in a process of any
DialogBoxOnError programming operation will generate error messages and will open associated
dialogs. If this attribute is FALSE the error messages will not be issued.

If the DeviceAutoDetect is TRUE then values of the ACI_AD_xxx** constants in
the aciprog.h file define a particular action triggered either on manual pushing
the Start button or upon auto detecting reliable insertion of the device into the

rogrammer's socket (see below).

AutoDetectAction |What to do (action)

value

_ ACI_AD_EXEC_FUNC | Launch the programming operation (function) currently highlighted

AutoDetectAction TION in the Program Manager tab.

ACI_AD_EXEC_AUT |Launch a batch of single operations programmed in the

O AutoProgramming dialog.

ACI_AD_EXEC_SCRI |Perform the script specified in the Script File dialog.

P'|'

ACI_AD_DO_NOTHIN |Do not act (ignore). Then it is possible to resume operations only by

G executing either the ACI_ExecFunction or ACI_StartFunction.
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This structure member defines a physical start address of the device to perform

DeviceStartAddrLow, ified : i functi F le: " d the chi
DeviceStartAddrHigh a specified programming operation ( unction). For example: "...read the chip
content beginning the address 7Fh". Not all the functions use this parameter.
DeviceEndAddrLow, This .?a:jameter defipes a phy:ical fendtgddrtessl:of the devlic.e:'s to perforrrt]ha .
DeviceEndAddrHigh specified programming operation (function) to. For example: "...program the chip

till the address OFFh". Not all the programmer functions use this parameter.

DeviceBufStartAddrLo | This structure member defines the buffers layer's start address to perform a

w, specified programming operation (function) from. For example: "...read the chip
DeviceBufStartAddrHi | and move the data to the buffer beginning the address 10h". Not all the
gh programmer functions use this parameter.

This is the bit definition from the aciprog.h header file:

* /I ACI Data Split defines
#define ACI_SP_NONE
#define ACI_SP_EVEN_BYTE
#define ACI_SP_ODD_BYTE
#define ACI_SP_BYTE_O
#define ACI_SP_BYTE_1
#define ACI_SP_BYTE_2
#define ACI_SP_BYTE_3

OO0k WNPEF O

** [| AC| Device Auto-Detect or 'Start' button action

#define ACI_AD_EXEC_FUNCTION 0 // Execute the function currently selected in the list
#define ACI_AD_EXEC_AUTO 1 // Execute Auto Programming

#define ACI_AD_EXEC_SCRIPT 2 /] Execute the script chosen in the programmer Script File
dialog

#define ACI_AD_DO_NOTHING 3 // Do nothing

See also: ACI_SetProgrammingParams, ACI_GetProgrammingParams

6.3.8 ACI_ProgOption_Params

typedef struct tagACl_ProgOption_Params

{
UINT Size; // (in) Size of structure, in bytes
LPCSTR OptionName; // (in) Name of the option. For lists, it should be in
the form ""List array name”~List Name', e.g. ""Configuration Bits”Oscillator™
CHAR  Units[32]; // (out) Option measurement units (“'kHz", "'V, etc.)
CHAR OptionDescription[64]; // (out) Description of the option
CHAR ListString[64]; // (out) For ACI_PO_LIST option: Option string for Value.
Listindex
UINT OptionType; // (out) Option type: see ACI_PO_xxx constants
BOOL  ReadOnly; // (out) Option is read-only
union // (in || out) Option value
{
LONG LongValue; // (in || out) Value for ACI_PO_LONG option
FLOAT FloatValue; // (in || out) Value for ACI_PO_FLOAT option
LPSTR String; // (in || out) Pointer to string for ACI_PO_STRING option
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ULONG CheckBoxesValue; // out) Value for ACI_PO_CHECKBOXES option

Gn 11
UINT Statelndex; // (in || out) State index for ACI_PO_LIST option
LPBYTE Bitstream; // (in || out) Pointer to bitstream data for
ACI_PO_BITSTREAM option
} Vvalue;
UINT VSize; // For ACI_SetProgOption():

// in: Size of Bitstream if OptionType ==
ACI_PO_BITSTREAM

// For ACI_GetProgOption():

// in: Size of buffer pointed by Bitstream if
OptionType == ACI_PO_BITSTREAM

// in: Size of buffer pointed by String if OptionType
== ACI_PO_STRING

// out: Size of buffer needed for storing Bitstream
data if OptionType == ACI_PO_BITSTREAM.

// Set Value.Bitstream to NULL to get buffer size
without setting the bitstream data

// out: Size of buffer needed for storing String if
OptionType == ACI_PO_STRING, including the terminating NULL character.

// Set Value.String to NULL to get buffer size
without setting the string

UINT Mode; // (in) For ACIl_SetProgOption(): SEE ACI_PP_MODE ...

constants
} ACI_ProgOption_Params;

The name of the programming option - for example "Vcc". For the ACI_PO_LIST
- type options, where the options are grouped into a list, you should specify both
OptionName the list name and the option name in the following way: <Listname>"<Option
name> (For example, Configuration_bits"Generator. There are no restrictions
on use of uppercase and lowercase characters in the option names.

After executing the ACI_GetProgOption function this structure member returns
Units an abbreviation of the units, in which the programmer represents or measures
the OptionName. For example, for the Vcc structure member, Units = "V".

After executing the ACI_GetProgOption function this structure member returns

OptionDescription . o
the option description.

After executing the ACI_GetProgOption function for the ACI_PO_LIST - type
options this structure member returns a string that describes the current
option's value or status. For example, XT - Standard Crystal for the option
Configuration bits"Generator.

ListString

After executing the ACI_GetProgOption function this structure member returns
the option's presentation format - for example: integer, floating point, list,
bitstream, etc.. See the ACI_PO_xxx* constant description in the aciprog.h
header file below.

OptionType

Setting ReadOnly=TRUE disables modification of the option specified by the

ReadOnl
y ACI_GetProgOption function.

Use of this union depends on the ACI_PO_LONG* option type as it is shown in
the matrix_below:

Value
Option type Use of the Value union
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ACI_PO_LONG

The option is in the Value.LongValue

ACI_PO_FLOAT

The option is in the Value.FloatValue

ACI_PO_STRING

The option is represented as a string, the pointer on which
is in the Value.String. See the note below.

ACI_PO_CHECKBOXES

The option represents a 32-bit integer word, in which you
can individually toggle each bit that represents a particular
flag in the option setting dialog. The option is in the Value.
CheckBoxesValue. See, for example, the Fuse setting
dialog for the ATtiny45 MCU implemented as an array of
check boxes.

ACI_PO_LIST

It represents a list of alternative choices - only one of them
can be selected at a time, so the parameter changes its
value in arange 0, 1, 2 to N. The option is in the Value.
ChecksStatelndex. See, for example, the Oscillators setting
dialog forthe PIC12F509 MCU implemented as an
alternatively chosen radio buttons

ACI_PO_BITSTREAM

Stream of bits. This option type is not in use yet but can be
used for future applications.

VSize Size of the buffer assigned for storing the string if the option type is the
ACI_PO_STRING. See the note below.

Mode of using of the structure member Value (See the description of the
ACI_PP_xxx** constants in the aciprog.h<) header file:

(value)

The Mode setting

Use of the parameter Value

ACI_PP_MODE_VALUE

1) For measuring (getting): use the Value in order to get an
actual Option value;

2) For setting: use the Value to set a particular Option
value.

_VALUE

Mode

AC|_PP_MODE_DEFAULT

1) Being used with the ACI_GetProgOption function it
commands to put the default Option value into the Value.
2) Being used with the ACI_SetProgOption function the
Value will be ignored; the Option will be set to the default
level defined in the ChipProg hardware.

UE

ACI_PP_MODE_MIN_VAL

1) Being used with the ACI_GetProgOption function it
commandsto putthe minimal Option value into the Value.
2) Being used with the ACI_SetProgOption function the
Value will be ignored; the Option will be set to the minimal
level defined in the ChipProg hardware, if it is possible for
the Option of this type.

UE

ACI_PP_MODE_MAX_VAL

1) Being used with the ACI_GetProgOption function it
commands to putthe maximal Option value into the Value.
2) If it is used with the ACI_SetProgOption function the
Value will be ignored; the Option will be set to the maximal
level defined in the ChipProg hardware, if it is possible for
the Option of this type.

This is the bit definition from the aciprog.h header file:

*// ACI Programming Options defines
#define ACI_PO_LONG

#define ACI_PO_FLOAT

#define ACI_PO_STRING

0 // Signed integer option
1 /I Floating point option
2 /I String option
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#define ACI_PO_CHECKBOXES 3 /] 32-hit array of bits

#define ACI_PO_LIST 4 /I List (radiobuttons)

#define ACI_PO_BITSTREAM 5 /I Bit stream - variable size bit array

**/[ ACI Programming Option Mode constants for ACl_GetProgOption()/ACIl_SetProgOption()
#define ACI_PP_MODE_VALUE 0 // Get/set value specified in Value member of the
ACI_ProgOption_Params structure

#define ACI_PP_MODE_DEFAULT_VALUE 1 /I Get/set default option value, ignore Value member
#define AClI_PP_MODE_MIN_VALUE 2 /I Get/set minimal option value, ignore Value
member

#define AClI_PP_MODE_MAX_VALUE 3 /I Get/set maximal option value, ignore Value
member

Note for use of the ACI_GetProgOption:

In order to get the buffer size necessary for storing the Option ACI_PO_STRING make the first call of the
ACI_GetProgOption function with the Value.String= NULL. Then the function will return the VSize equal
to the buffer size, including zero at the string's end. In your program assign the buffer of this size, put the
Value.String into the buffer pointer and call the ACI_GetProgOption again.
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See also: ACI_GetProgOption, ACI_SetProgOption

6.3.9 ACI_Function_Params

typedef struct tagACl_Function_Params

{

UINT Size; // (in) Size of structure, in bytes

LPCSTR FunctionName; // (in) Name of a function to execute. If a function is
under a sub-menu, use """ to separate menu name from function name, e.g. "Lock
Bits"Bit 0"

// To execute Auto Programming, set FunctionName

to NULL, empty string or "Auto Programming'.

UINT  BufferNumber; // (in) Buffer number to use

BOOL Silent; // (in) On error, do not display error message box,

Just copy error string to ErrorMessage

CHAR ErrorMessage[512]; // (out) Error message string if ACl_ExecFunction()
fails
} ACI_Function_Params;

The name of the ChipProg function - one of those listed in the window Functions
of the ChipProgUSB Program Manager tab. They are divided in two group (see the
picture below): the main functions applicable to a majority of the target devices (
Blank Check, Erase, Read, Program, Verify) and the device-specific lower level
functions accessible through expandable sub-menus (for example, Program
Device Parameters, Erase Sectors, Lock Bits > Program Lock Bit 1,
EEPROM > Read, etc.). For such device-specific functions the FunctionName
FunctionName | should be specified in the following way: <List name>"“<Function name> (for
example, Device Parameters”Program).

To launch the AutoProgramming batch set the FunctionName either to NULL,
a blank string, or the "Auto Programming".

There is no restrictions in use of uppercase and lowercase characters in the
function names.

BufferNumber | The ordinal number of the buffer the function operates with.

If this parameter is TRUE, then the error message dialog will be suppressed, the
Silent function execution will be terminated returning the ACI_ERR_FUNCTION_FAILED
code, and the error message will be copied to the ErrorMessage.

ErrorMessage The destination of the error message that will be issued if the function fails.
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See also: AClI ExecFunction, ACI StartFunction, ACl GetStatus

ACI|_PStatus_Params

typedef struct tagACl_PStatus_Params

{

UINT Size; // (in) Size of structure, in bytes

BOOL Executing; // (out) The function started by ACI_StartFunction() is
executing

UINT PercentComplete; // (out) Percentage of the function completion, valid id
Executing '= FALSE

UINT DeviceStatus; // (out) Device/socket status, see the ACI_DS_ XXX
constants

BOOL NewDevice; // (out) New device inserted, no function has been
executed yet. Valid if DeviceAutoDetect is ON.

BOOL FunctionFailed; // (out) TRUE if last function failed

CHAR  FunctionName[128]; // (out) Name of a function being executed if
Executing '= FALSE. ITf a function is under a sub-menu, function name will be like
this: "Lock Bits™Bit 0"

CHAR ErrorMessage[512]; // (out) Error message string if FunctionFailed = FALSE
} ACI_PStatus_Params;

This parameter is TRUE while the ChipProg operation, launched by the

Executin
g ACI_StartFunction, is in progress.

PercentCompl | While the Executing == TRUE this parameter represents a percentage of the
ete function completion - from 0 to 100.

i This structure member defines insertion of the device into the programmer ZIF
DeviceStatus | socket if the device insertion auto detection function is enabled. See the description
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of the ACI_DS_XXX* constants in the aciprog.h file. See the matrix below:

Status Description

ACI_DS_OK The device is in the socket and the device's leads are reliably gripped
by the programmer ZIF socket's sprung contacts.

ACI_DS_OUT_OF_SOCKE | There is no device in the programmer's ZIF socket.
T

ACI_DS_SHIFTED The device's leads are reliably inserted into the socket but the device
is incorrectly positioned in the socket (shifted or inserted upside
down). The same status may indicate that the device type selected in
the Select Device does not correspond to the type of the chip in the
programmer's socket.

ACI_DS _BAD_CONTACT | The device's leads are not reliably gripped by the socket's sprung
contacts. In most cases this is an intermediate situation while an
operator is inserting the chip to the socket or is removing it.

ACI_DS_UNKNOWN Itis impossible to detect the status due to the device insertion auto
detection feature is disabled or this feature is not supported by this
programmer atall.

This structure member is a flag that acknowledges replacing a programmed device
in the programmer's socket by a new, presumably a blank device. It works only
when the device insertion auto detection function is enabled. The NewDevice ==
FALSE while the already programmed chip is still into the socket and has not been
replaced by a new one. After removing the programmed device from the socket the
NewDevice toggles to TRUE.

NewDevice

This is an indicator of the function execution's result. It sets to FALSE when the
FunctionFail | ACI StartFunction launches a programming operation and remains the FALSE

ed while the operation is in progress. If the programming operation fails and the
parameter Executing becomes FALSE the FunctionFailed flag toggles to TRUE.

This is either the name of the programming operation (function) being currently
executed or the name of the failed function, if the FunctionFalied == TRUE.

FunctionName

The destination of the error message if the function fails, i.e. the FunctionFalied

ErrorMessage
== TRUE.

This is the bit definition from the aciprog.h header file:

*// ACI| Device Status

#define ACI_DS_OK 0 // Device detected, pin contacts are ok

#define ACI_DS_OUT_OF_SOCKET 1 // No device in the socket

#define ACI_DS_SHIFTED 2 /I Wrong device insertion is detected (shifted or inserted
upside down)

#define ACI_DS_BAD_CONTACT 3 // Bad pin contact(s)

#define ACI_DS_UNKNOWN 4 [/ Unknown (Auto Detect is probably off)

See also: ACI ExecFunction, ACI StartFunction, ACl GetStatus
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6.3.11 ACI_File_Params

typedef struct tagACl_File_Params

{
UINT Size; // (in) Size of structure, in bytes
LPCSTR FileName; // (in) File name
UINT BufferNumber; // (in) Buffer number
UINT LayerNumber ; // (in) Layer number
UINT Format; // (in) File format: see ACI_PLF_ ... and ACI_PSF_xxx
constants
DWORD StartAddresslLow; // (in) Low 32 bits of start address for ACI_FileSave
0.
// For ACI_FileLoad(): Ignored if Format !=
ACI_PLF_BINARY
DWORD StartAddressHigh; // (in) High 32 bits of start address for ACI_FileSave
0.
// For ACI_FileLoad(): Ignored if Format !=
ACI_PLF_BINARY
DWORD EndAddresslLow; // (in) ACI_FileSave(): Low 32 bits of end address
DWORD EndAddressHigh; // (in) ACI_FileSave(): High 32 bits of end address
DWORD OffsetlLow; // (in) Low 32 bits of address offset for ACI_FilelLoad
O
DWORD OffsetHigh; // (in) High 32 bits of address offset for ACI_FilelLoad
O
} ACI_File_Params;
FileName The name of the file to be loaded to the ChipProg buffer.
BufferNumber The ordinal number of the destination buffer. Buffer numbers begins from zero.
LayerNumber The ordinal number of the memory layer in the buffer. Layer numbers begins
from zero.
= The loadable file's format. See the description of the ACI_PLF_XXX*
ormat ) . )
constants in the aciprog.h header file (see below).
1) Being used with the ACI_FileSave function this parameter specifies the first
(start) address in the source memory layer, from which the file will be saved.
StartAddressLow, |2)Being used with the ACI_FileLoad function, but only when it loads a file in
StartAddressHigh |the binary format (Format == ACI_PLF_BINARY), this parameter specifies
the first (start) address of the destination memory layer, in which the file will
be load into. Binary images do not carry any addresses for the file loading.
EndAddressLow, Being used with the ACI_FileSave function this parameter defines the last
EndAddressHigh (end) address of the source memory layer, from which the file will be saved
OffsetLow, The address offset that shifts the file position in the destination memory layer.
OffsetHigh The offset can be negative as well as positive.

This is the bit definition from the aciprog.h header file:

*// ACI File formats for ACI_FileLoad()

#define ACl_PLF_INTEL_HEX
#define ACI_PLF_BINARY

0 /I Standard/Extended Intel HEX
1 // Binary image
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#define ACI_PLF_MOTOROLA_S 2 // Motorola S-record
#define ACI_PLF_POF 3 /I POF

#define ACI_PLF_JEDEC 4 |l JEDEC

#define ACI_PLF_PRG 5 /I PRG

#define ACI_PLF_OTP 6 // Holtek OTP
#define ACI_PLF_SAV 7 Il Angstrem SAV
#define ACI_PLF_ASCII_HEX 8 // ASCII Hex
#define ACI_PLF_ASCII_OCTAL 9 // ASCII Octal

See also: ACI FileLoad, ACI FileSave.

6.4 Examples of use

The ChipProgUSB software includes a few examples of use the Application Control Interface
functions and structures. The examples reside in the subdirectory AC\Programmer ACIl Examples in
the directory where the ChipProg program is installed.

The examples are written in the C language and are represent the projects that can be compiled by the
Microsoft Visual Studio® 2008. The project sources can be also compiled by other C/C++ compilers,
sometimes with minor adjustments. After building the project you get the Windows consol application
executable file.

In order to adjust the example project (or a part of it) for use in your application you have to set correct
paths to the ACI functions called by the main() function. This includes paths to the ChipProg executable
file, to the file that is supposed to be loaded to the programmer's memory buffer or to be saved from the
buffer. You also have to specify your target device. See an example of the main() function's fragment
below.

[*+ main ° 01.07.09 17:37:24*/

/I Launch the programmer executable
if (Attach("C:\\Program Files\ChipProgUSB\\4_72_00\\UPrognt2.exe","", FALSE)) return-1;

I/ Select device to operate on
if (!SetDevice("Microchip”, "PIC18F242")) return-1;

/I Load .hex file to buffer 0, layer 0
if ('LoadHexFile("C:\\Program\\test.hex", 0, 0)) return-1;

All examples uses the ACI.DLL file that must be either in the same folder where the example executable
file resides or in the folder specified in the variable PATH. In the supplied examples the ACI.DLL file is
already copied into the folders where the MS Visual Studio creates executable files.

Example Descriptions

Each example has a comment header briefly describing the program purposedo. Additionally, some
comments are inserted in the code texts. All examples begin from executing the ACI_Launch() function
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that activate the programmer.
AutoProgramming.c

This is the simplest and frequently used example of the ChipProg external control. The program
launches the programmer, selects the PIC18F242 target device, loads the test.hex file into the
programmer buffer, sets default programming options and then executes a preset AutoProgramming
batch of functions: Erase, Blank Check, Program, Verify.

LongProgramming.c

This example shows how to monitor a process of the AutoProgramming procedure if it may last quite a
long time. The program acts as the the example above. The programming launches by the

ACI _StartFunction then it keeps checking percentage of the operation completion by means of the
ACI GetStatus function. If the operation fails the programmer issues an error message, otherwise it
allows continuing operations.

ProgrammingOptions.c

This example shows how to get, print out and change options settable in the Device and Algorithm
Parameters Editor window. First, the program checks the device insertion into the programmer's socket
by calling the ACI GetStatus(&Status) function. Then, after detecting correct and reliable insertion of the
device into the programmer's socket, the program reads the current set of options by the

ACI GetProgOption function and print them out. Then it changes the Vpp value from the default to 10.5V
and disables the device Brown-out Reset feature.

SaveMemory.c

This example shows how to save a binary image of the device in a file. First, the program checks the
device insertion into the programmer's socket by calling the ACI GetStatus(&Status) function. Then,
after detecting correct and reliable insertion of the device into the programmer's socket, the program
reads data from a specified range of the SST89V564RD device's memory and saves them in the file test.
bin.

Checksum.c

This example shows how to calculate a checksum of the data read out from a device. First, the program
checks the device insertion into the programmer's socket by calling the ACI_GetStatus(&Status)
function. After detecting correct and reliable insertion of the device into the programmer's socket the
program figures out a real size of the SST89V564RD device's flash memory by executing the

ACI _ExecFunction function then it assigns the buffer 'buf' in the host computer's memory in order to

accommodate the data read out from the device, moves the data to this buffer and calculates the
checksum of the buffer's content.
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7 Script Files

The program ChipProgUSB can execute so-called scriptfiles in a way similar to how DOS executes
the batch files. Use of script files is to automate usage of the ChipProg programmers. By means of
script files you can automate loading files to the programmer buffers, calculating checksum, launching
device programming, pausing programming in case of an error, manipulating windows and performing
many other operations. It is also possible to display various messages in the Console window or
other special windows generated by the script itself, including displaying graphical data in special
windows; to create user's custom menus, etc. The script language is similar to C program language,;
almost all C constructions are supported, except for structures, conjunctives and pointers. There are
also many built-in functions available, such as printf(), sin() and strcpy(). The extension of script source
file is .CMD.

When the ChipProgUSB program starts, it searches for the script with the reserved name START.CMD. So, if
you wish the ChipProgUSB program would automatically perform some operations immediately after you
launch the program, you can create a special script. The ChipProgUSB program begins searching for the
START.CMD in the current directory on the disc, then it searches for this script in the directory where the
ChipProgUSB.exe file resides. If the START.CMD is not located then a default ChipProg shell will open.

The scrips controls and associated dialogs and windows are concentrated under the Script menu.
The major dialog that controls scripts is the Script Files dialog.

See also:

Simple example of a script file

How to write a script file
How to start a script file
How to debug a script file

Description of Script Language

Script Language Built-in Functions

Script Language Built-in Variables

Difference Between the Script Language and the C Language

Alphabetical List of Script Language Built-in Functions and Variables

7.1 The Script Files Dialog

This dialog is used for controlling the ScriptFiles, it allows to start, stop and debug scripts.
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2 Script Files

Script filez list

L It | 2, Stopped, PC=0002 Teminate
"CHECESUM_2" 1d: 4. Stopped, PC=0

o

CHECKSUM_2

Terminate Al
Bestart

Debug

Start new zonpt file

Scipt file name: il Browse...
d:hmanualshop ruzziansonpt exampleshchecksunm_2 crd

Defines:

Hinclude-file directories:

Debug [open Script Source window]
Auto-zave schpt file sources

In the upper window of this dialog you see the list of loaded script files with the current state of each file.
Any script can be in one of the following states:

State of File Description

Stopped Execution of the script file is temporarily stopped.

Running The script file is being executed.

Waiting The script is waiting for an event. This state is initiated by calling certain

wait functions in the script file text (for example, Wait).

Cancelled The script execution is terminated, but the script file is not yet unloaded
from the memory.

To select a script file, highlight its name in the window. The four buttons on the right of the list control the
highlighted script:

Button Description
Terminate Unloads the selected script file if it can be unloaded. Otherwise, it sets up

the Unload Request flag for the selected script that then goes to the
Canceled state.

Terminate All Unloads all script files visible in the window.
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Restart Restarts a highlighted script file.

Debug Switches to the Debugger mode for the highlighted script file. This
command stops execution of the script and opens it in the source window
of the script for debugging. If the script is in the wait state, then execution
will immediately stop after the script returns from the Waiting status.

When you use several script files simultaneously and unload or restart some of them, remember that
script files can share global data and functions. If one script accesses data or the functions belonging to
another one that is already unloaded, then the script interpreter will issue error messages and the active
script file will be also be unloaded (terminated).

The buttons and fields in the lower part of the dialog box control the script files starting:

Elementofdialog Description
Script File Name Specifies a name of the script file to be loaded. You can either typed in the

file name with a full path to the box or to take it from the drop-down history
list or browse it from a computer disc.

Browse Opens the Load/Execute ScriptFile dialog for locating and loading script
files into the Script File Name box.

Defines Defines the processor text variables for compilation. For more information,
see below the Processor text variables.

#include-file Specifies the directories in which the script file will search for the files

Directories specified in the #include <file_name> directive(s). To specify more than

one directory, separate them by semicolons. The current directory is
scanned as well.

Debug (open Script If this box is unchecked, a script file automatically starts execution upon the

Source window) file loading. If the box is checked, then upon loading a script file, the
program immediately opens the window for debugging the script. See also
How to Debug a Script File.

Auto-save Script File If this box is checked when you click the Start button ChipProgUSB
Sources automatically saves the source texts of all script files visible in the Script
Source windows.

Start Starts the script file specified in the Script File Name box.
Processor text variables

The content of the Defines text box is equivalent to the #define directive in the C language. For example, if
you type DEBUG in this text box, the result will be as if the #define DEBUG directive is placed in the first line
of the script source text.

You can specify values for variables. For example, DEBUG=3 is equivalent to #define DEBUG 3.
You can list several variables in a line and separate them with semicolons. For example:
DEBUG ; Passes=3; Abort=No

Also, see Predefined Symbols at the Script File Compilation.

7.2 How to create and edit script files

Ascript file is similar to a source program text written in programming language (C, for example), e.g. a
script file can be created and edited either in the Editor window by the ChipProgUSB built-in editor or by
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any other editor. You can allocate script files in your work directory or in the directory where the
ChipProgUSB program is installed.

Normally the Editor toolbar that collects all the edit function buttons is hidden. To create a customized
editor toolbar right click on the blank area of the main toolbar, select the Customize line in the drop-down
menu and check the boxes of the editor functions which you would like to make visible.

To open a new script file for editing open the Script menu > Editor window > New. This will open a blank
window below. Right clicking within the window pops up the Editor command menu that includes the
buttons which you can bring up to the local Editortoolbar. Here the toolbar is shown above the window.

DHES | [arapaa [BREARB (RN B
Froname? (1,11 — — oaaal
8] ] Save 1SaveAs] 1 1 1 Faste ISearchiNextSrc] Repl ] '_:i_

3

ions | Statist

b save file Chrl45
B save file as...
(=3 Print. .
E-_ il _CFI4=&, SnirC+Lel
@Q i Paste Ctrl+Y, Shift+Ins
| [d SearchFor text... Chrl+F
- Algorithrn | "Palling” | Programming algarithm J5 Repeat search F3
o Nop 12.00% | High program voltage @ Search/Replace. .. Chrl+H, Chrl+P
e | B.0DY | Power supply voltage % Displaw mulki-File szarch resulks. Shift+-Fo
Display From line number. .. Chrl4L
H}.‘ Set bookmark... Ale+[
ii Retrieve bookmark, ., Alk+]
Socket Scheme | Hotes %y Condensed mods F1z
IDevice: Atmel ATBICH1 1 "ﬁ‘ Condensed mode setup Chri4+F12 |

Adapter]s]: DIP: None

PLCC. AE-P44.i51 Lo uiosys

PLCC: AE-P44.51.7 Match bra-ce,l'con'.ument . Ak,
TOFP: AE-T44-i51 o Return to last editing contex!
. Sockel schens . User Scripts Ei
Help on window. .. F1
Help on word under cursor Alt+F1
Properties k
2 |

Now you can compose your script right in the window.
Note that you should not use the punctuation characters (braces, dash, etc.) in the script file name.

When you complete the file composing click on the Save button on the window local toolbar or on the
Editortoolbar and the program will prompt you to name the script file and to specify its location.

7.2.1 The Editor Window

Commands of this menu refer to the currently active Edit window.

Button Command Description
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Text Edit

New

Open...

Save
SaveAs...

Print

Properties..
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Opens the Editor window for a new script file.

Opens the Open file dialog to load a script file for editing. The file
name and path can be either entered or browsed here.

Saves the file from the currently active window to a disc.

Opens the Save file as... dialog.

Opens the standard Print dialog for the default printer. You can
print an entire file or a selected text block.

The common properties for open files.

Commands of this menu refer to the currently active Edit window.

Button Command
@ Undo
B o
Cut
P
O Paste
)

Clipboard History/
Repository

Appendto
Clipboard

Cut& Appendto
Clipboard

FastCopy

FastMove

Block Off

Search

Next Search

Description

Undoes the last text editing action executed in this window. For

example, if the last action deleted a line, then the deleted line will be

restored. The number of steps provided by the Undo function is set
in the of the Configure > Editor Options > General tab.

Copies the marked block to the clipboard. The text format in the
clipboard is standard and the copied block is accessible to other
programs.

Removes the marked block to the clipboard..

Copies the block from the clipboard, starting at the cursor position.

Opens the Clipboard History/Repository dialog.

Copies and appends the marked block of text to the block in the
clipboard.

Cuts the marked block of text and appends it to the block in the
clipboard.

Copies a block to a specified position in the same window.

Moves a block from one position in the window to another position
in this window.

Unmarks a marked text block.

Opens the Search for Text dialog.

Repeats search with the parameters used in the previous search.
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S

s

W

b

Replace

Display Multi-file
Search Results

Display fromline
number...

Set bookmark...
Retrieve bookmark
Condensed mode

Condensed mode
setup

Line numbers on/off

Return to last
editing context

7.2.2.1 The Search for Text Dialog

Opens the Replace Text dialog.

Re-opens the last multi—file search results in the Multi-File Search

Results dialog.

Opens the Display from Line Number dialog for you to specify a line
number. Source text will be displayed from this line.

Opens the Set Bookmark dialog to set a local bookmark.

Opens the Retrieve Bookmark dialog to retrieve a local bookmark.

Toggles the Condensed display mode on and off.

Opens the Condensed Mode Setup dialog.

Toggles the availability of the line numbers on and off.

Activates the most recently edited Source window, and places the
cursor in its final position during the edit.

This dialog sets complex criteria and parameters for searching text in files. This dialog and the Replace
Text dialog have a number of common parameters, which function in the same way in both dialogs. To
specify file names, you can use one or several wildcards. Also, the names may contain paths. You can

search in more than one file at once by using parameters of the Multi-File Search area.

Element of dialog

Description

String to Search for

Case Sensitive

Whole Words Only

Regular Expressions

Global
Selected Text
From Cursor

Entire Scope

Perform Multi-File
Search

Search All Source

Specifies the text string to search for.

This box is unchecked by default. Checking this box specifies that the case of
the string is to be matched.

This box is unchecked by default. If checked, the editor will search only for
whole words: the string will be found only if it is enclosed between
punctuation or separation characters (spaces, tabulation symbols, commas,
guotation marks, etc.).

This box is unchecked by default. Checking of this box specifies that the
search string is a regular expression.

Search the entire file for the string. Enabled by default.
Search the string in the selected block.
Search from the current cursor position.

Search from the beginning or end of the file (depending on the search
direction). Enabled by default.

If this box is checked the editor will search in all project files (see the notes
below). If the box is unchecked, then the search will be performed in the
current Source window only.

If this box is checked the editor will search in all the source files included in
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Files in Project
Include Dependency
Files

Search Wildcard(s)

Search
Subdirectories

Starting Path

Notes

the project.

If this box is checked the editor will search in all the source files included in
the project and all files on which the source files depend, whether explicitly or
implicitly. For C language, these are the header files (*.h).

Check this box to search for one or several wildcards specifying the files to be
searched. Separate wildcards with semicolons. No quotes are required to
denote Windows-style long names. Example: * . txt;*._.c;c:\prog\*.h.
This option and the Search All Source Files in Project option act
independently of each other: you can search in all files of the project AND in
other files that comply with the specified wildcard(s).

If this box is checked the editor will search in subdirectories of all the
directories specified by the Search All Source Files in Project option and by
wildcards.

Begin search from the directory specified in this text box. This directory serves
as the common path and is useful when there are several wildcards such as
the following ones:

c:\prog\text\source\*.txt;c:\prog\text\source\*.doc

In this case, make use of wildcards (*.txt;*.doc) and common path
(c:\prog\text\source).

1. When you search in the file opened in the Source window, then only the window buffer will be searched,

not the file on disk.

2. Multi-file search is performed in all source files of the project. Upon finishing, the Multi-File Search
Results dialog remains open.

7.2.2.2 The Replace Text Dialog

This dialog sets the parameters for the search-and-replace operation. This dialog and the Search for Text
dialog have a number of common parameters, which function in the same way in both dialogs. To specify
file names, you can use one or several wildcards. Also, the names may contain paths. You can search in
more than one file at once by using parameters of the Multi-File Search area.

Element of dialog

Description

Text to Search for
Replace with

Case Sensitive

Whole Words Only

Regular
Expressions

Prompt at Replace

Specifies the text string to look for (search string).
Specifies the text string to replace the found one.

This box is unchecked by default. Checking this box specifies that the case of
the string is to be matched.

This box is unchecked by default. If checked the editor will search only for
whole words: the string will be found only if it is enclosed between
punctuation or separation characters (spaces, tabulation symbols, commas,
quotation marks, etc.).

This box is unchecked by default. Checking of this box specifies that the
search string is a regular expression.

This box is checked by default and if it is checked the editor will always pop
up the Confirm Replace dialog requiring your permission to replace the
found text. If unchecked the editor will automatically replace the searched-and
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Global
Selected Text
From Cursor

Entire Scope

Perform Multi-File
Search and Replace

Search All Source
Files in Project
Include Dependency

Files

Search Wildcard(s)

Search
Subdirectories

Starting Path

Notes

1. When you search in the file opened in the Source window, then only the window buffer will be searched,
not the file on disk.

found text.

Search the entire file for the string. Enabled by default.
Search the string in the selected block.

Search from the current cursor position.

Search from the beginning or end of the file (depending on the search
direction). Enabled by default.

This box is checked by default and if it is checked the editor will search in all
project files (see the notes below). If the box is unchecked, then the search
will be performed in the current Source window only.

If this box is checked the editor will search in all the source files included in
the project.

If this box is checked the editor will search in all the source files included in
the project and all files on which the source files depend, whether explicitly or
implicitly. For C language, these are the header files (*.h).

Check this box to search for one or several wildcards specifying the files to be
searched. Separate wildcards with semicolons. No quotes are required to
denote Windows-style long names. Example: *.txt;*.c;c:\prog\*.h.
This option and the Search All Source Files in Project option act
independently of each other: you can search in all files of the project AND in
other files that comply with the specified wildcard(s).

If this box is checked the editor will search in subdirectories of all the
directories, which are specified by the Search All Source Files in Project
option and by wildcards.

Begin search from the directory specified in this text box. This directory serves
as the common path and is useful when there are several wildcards such as
the following ones:

c:\prog\text\source\*_txt;c:\prog\text\source\*.doc

In this case, make use of wildcards (*.txt;*.doc) and common path
(c:\prog\text\source).

2. Multi-file search is performed in all source files of the project. Upon finishing, the Multi-File Search
Results dialog remains open.

7.2.2.3 The Confirm Replace Dialog

This dialog requires your permission to replace a found string. You can turn the prompt on/off by checking/

clearing the Prompt at Replace box in the Replace Text dialog.

Button
Yes

No

Function

Replace the found string.

Cancel this replacement. If the procedure is started with the ChangeAll
button for all occurrences in the search area, then the search-and-
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replace process will continue.

Non-Stop From this moment, replace all found strings in this file without prompt.
Cancel Cancel the search-and-replace process.

Skip this File Stop search in this file and switch to the next one.

Replace in All Files Replace all occurrences in all other files without confirmation.

Move cursor to the When this box is checked the cursor will be automatically placed on the
Yes/No Buttons Yes button on each inquiry for confirmation.

7.2.2.4 The Multi-File Search Results Dialog

This dialog displays the multi-file search results. To learn about the multi-file search, see the Search for
Text dialog.

The List of Matched Files shows the files where the search string is found. The file name is on the left and
its directory is on the right. The line with green text right under this box displays information about the file
selected in the box. "File in memory" means that the file is opened in the Source window. General
information from FAT means the file is on disk, not loaded. The Preview area shows the source line with
the found text string.

The SortFiles by area includes a radio button with four file sorting options. When the Consider Directory
box is checked, the files are sorted with respect to their directories.

The Edit button opens the selected file in the new Source window and places the cursor on the line with
the found string. The found string is marked with the background color. To check if there are other
occurrences of the sought string in this file, press Ctrl+R or use the Next Search command of the Edit
menu.

The Close button closes the dialog but the results are not lost. To reopen the dialog use the Display Multi-
file Search Results button. You can also use the same command of the Edit menu or press Shift+F5. The
files in the List of Matched Files box, which are opened in the Source window, will be marked with
asterisks on the left.

7.2.2.5 Search for Regular Expressions

The text editor supports "regular expressions," which can be used to search for special cases of text
strings. Regular expressions contain the control characters in the search argument string:

? Means any one character in this place. Example: if you specify ?ell as the search string,
then "bell," "tell," "cell," etc. will be found.

% Means the beginning of line. The characters following '%' must begin from column 1.
Example: %Counter - find the word "Counter," which begins at the first column.

$ The end of line. The characters preceding the '$' should be at the last positions of the
line. Example: Counter$ - find the word "Counter" at the line end.

@ Match the next character literally; ‘@' lets you specify the control characters as usual
letters. Example: @? - search for the question mark character.

\XNN The hexadecimal value of the character. Example: \XA7 - find the character with the
hexadecimal code of A7.

+ Indefinite number of repetitions of the previous character. For example, if you specify 1T
+2, then the editor will find the lines containing "1" followed by "2", which are separated
with any number of repetitions of the letter T.

[c1-c2] Match any character in the interval from c1 to c2. Example: [A-Z] means any letter from A to
Z
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[~c1-c2] Match any character whose value is outside the interval from c1 to c2. Example: [-A-Z]

means any character except for the uppercase letters.

textl|text2 The "|" character is the logical "OR" and the editor will look for either textl or text2.

Example: LPT|COM|CON means search for "LPT" or "COM" or "CON."

7.2.2.6 The Set/Retrieve Bookmark Dialogs

7.2.2.7

Bookmarks help you to return to a marked cursor position in a source file.

You can set and retrieve up to 10 local bookmarks. Every local bookmark has an individual numbered
button assigned to it.

To open the Set Bookmark dialog, press Alt+[. To open the Retrieve Bookmark dialog, press Alt+]. To
set/retrieve a bookmark, press its numbered button. The number of the bookmarked line, the bookmark
position in the line (in brackets) and the text of the line are shown at the right of the button.

Local bookmarks are stored in the configuration file and you can work with them in the next session.

Condensed Mode

In the Condensed mode, only lines that satisfy a specified criterion are displayed in the window. There are
two available criteria:

e the line must contain a given sub-string;

¢ the first non-space character in a line must be at a specified position (column).

Examples: (a) with the sub-string criterion and the sub-string set to “"counter,” only the lines containing the
word "counter” will be displayed; (b) with the second criterion and the position set to four, only the lines in
which text begins at column 4 will be displayed.

The Condensed mode brings the lines having some common feature to "one place." If you attentively follow
a rule to begin the declaration of data at position 2, procedures at position 3, and interrupt handlers at
position 4, then the Condensed mode will help you to find a necessary declaration. If you comment certain
lines with the same or similar comments and use the Condensed mode with sub-string, you will be able to
benefit from your composing style. In the Condensed mode, you can move the cursor just as in the normal
mode.

How to control

The criterion for display is set in the Main menu > Script > Text Edit > Condensed Mode Setup dialog. To
toggle the Condensed mode on/off, use the Edit menu command, the Condensed Mode command of the
local menu or the F12 hotkey. To exit the Condensed mode, press Esc. When you exit, the cursor returns to
the position at which it was before the mode was turned on. To exit the mode and remain in the line from
which you moved the cursor while in the mode, press Enter or begin editing the line.

7.2.2.8 The Condensed Mode Setup Dialog

This dialog sets up the parameters for the Condensed mode of the Source window.

The Display Lines of Text area has radio buttons for switching between two alternative criteria for
condensing text in the Source window: Containing String and Where First Non-blank ColumnIs:

1. If you check the Containing String radio button the Source window will display only the lines with text that
match the sub-string specified in the text box at the right. Additionally, you can specify that the case should
be matched the case, that whole words only should be used, and that the sub-string is aregular

expression.
2. If you check the Where First Non-blank Column Is radio button, the Source window will display the lines
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where text begins from the position specified in the Column box. Then you should select one of four
options by checking an appropriate radio button:

e Equalto - the first non-space character should be exactly in the specified column. For example, if you
specify position number 2, the window will display only the lines whose text begins in column 2.

e NotEqualto - the first non-space character should be in any column except the position specified here.
For example, if you specify position number 2, the window will not display all the lines beginning in this
column. All other lines will be displayed.

e Less than - display only the lines in which text begins at a position less than the specified one.

e Greater than - display only the lines in which text begins at a position greater than the specified one.

When you have completed setup click OK to switch the Source window to the Condensed mode.

7.2.2.9 Automatic Word Completion

It is normal for words (labels, names of variables) to be repeated within a limited part of a file. In such
cases, the Source window helps you finish typing the whole word.

If the cursor is at the end of line that is being composed, then upon typing a letter, the editor scans the
text above and below the current line. If a word beginning with the letters that you have just typed is found
in these lines, then the editor will "complete" this word for you by writing the remaining part of the word
from the current cursor position. If this word suits you, press Alt+Right (Alt+<right arrow>) and the editor
will append the remaining part of the word to the text as if you have typed it yourself. If the word doesn’t
suit you, just continue typing and the editor will accept whatever you type. At any point during the typing,
you may press Alt+Right to accept the editor's completion suggestion.

You can press Alt+Right at any time and not only when the editor offers you to complete a word. In this
case, the editor will open a list of words that begin with the typed letters. If the list does not include an
applicable word, just ignore the prompt. The right pane of the Source window, if it is open, also displays
the word completion list.

How to control

To disable automatic word completion, uncheck the Automatic Word Completion box in the Main menu
> Configure>Editor Options> General tab. When the box is checked, a number placed in the Scan
Range box defines the number of lines for the editor to scan. The default is 24 lines below and 24 lines
above the current line. When this parameter is greater than the total number of lines in the file (for
example, 65535), then program composing will become slower because the whole file will be scanned.

7.2.2.10 Syntax Highlighting

When the Source window displays the source text, it marks different C language constructions with
different colors. This feature improves readability. The following constructions are highlighted separately:
e Punctuation and special characters: ()[]1{}.,:; and so on.
e Comments that begin with / are highlighted. Comments enclosed in the /* */ character pairs are
highlighted, if the opening and closing pairs are placed in the same line.
Strings enclosed in double or single quotation marks.
Keywords of the C language (for, while, and so on).
Type names of the C language (char, float, and so on).
Library function names of the C language (printf, strcpy, and so on).

How to control

You can disable syntax highlighting through the Main menu > Configure>Editor Options> General
tab>SyntaxHighlighting flag In addition, you can change the color for each construction. To do the latter,
use any of the following items: Main menu > Configure> Environment > Colors tab.
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7.2.2.11 The Display from Line Number Dialog

Use this dialog to display the source file in the active Source window starting with a specified line. Enter
the line number or select any previous number from the History list. The number of the first line is 1.

7.2.2.12 The Quick Watch Function

The Quick Watch function works as follows: if you roll the mouse pointer over a variable name in the

Source window or the Script Source window, a small box containing the value of the variable will be

opened. This box disappears upon moving the mouse off the object.

7.2.2.13 Block Operations

Block operations apply an editing action to more than one character at once. The Source window
supports persistent blocks and performs a full range of operations with standard (stream), vertical
(column) and line blocks of text.

Non-persistent blocks In this mode, once a block is marked, you have to immediately carry out an
operation with it (delete, copy, etc.), because any movement of cursor takes the marking off the block. If a
block is marked, then any entered text will replace the block with the typed text.

Persistent blocks In this mode, the block remains marked until the marking is explicitly removed (hot
key Shift+F3) or the block is deleted (Ctrl+X). The Paste operation for persistent blocks has specifics.
Two additional block operations are available for persistent blocks: fast copy and fast move. These
operations do not use the clipboard and require fewer manipulations of the keyboard.

To enable the persistent block mode check the namesake box on the Main menu > Configure>Editor
Options> General tab.

Standard blocks The standard (stream) block contains a "text stream" that begins from the initial line
and column of the block and ends at the final line and column.

The Standard blocks is enabled by default.

Line blocks The line block contains whole lines of text. To mark a line block, put the cursor anywhere in
the first line and press Alt+Z; then put the cursor anywhere in the last line of the block and press Alt+Z
once more (the latter is not necessary if the block is to be immediately deleted or copied to the clipboard).

Line blocks are always available.

Vertical blocks The vertical block contains a rectangular text fragment. Characters within the block,
which goes beyond the end of the line, are considered to be spaces. Vertical blocks are convenient in
cases like the following example of source text:

char Timer0O far ;
char Timerl far ;
char Int0 far ;
char Intl far ;

Assume the word "far" is to be moved to the place right after the word "char" in each line. The stream
blocks are of little help here. However the task can be easily done with one vertical block. Mark the
persistent vertical block containing the word "far" in each line, place the cursor on the first letter of word
"TimerQ" and press Shift+F2 (fast move the block):
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char TimerO
char Timerl
char Intc0
char Intl

Checking/Clearing the Vertical Blocks box toggles between the vertical block and the stream block
modes in the the Main menu > Configure>Editor Options> General tab. The standard blocks are
enabled by default; i.e. the Vertical Blocks box in the Editor Options dialog is unchecked by default. The
line blocks are always accessible, irrespective of the status of the Vertical Blocks box.

To mark a block, either move the mouse while pressing its left button or use the arrow keys of the
keyboard while pressing the Shift key. To unmark the block, press Shift+F3.

Copying/movingblocks

Amarked block can be copied or moved within the same Source window in two ways: directly (fast
copying, fast moving) and through the clipboard (Copy/Cut-n-Paste). Copying and moving blocks
between the Source windows, or to another application should always be made through the clipboard.

Note. The result of copying the stream or vertical non-persistent block depends on the INSERT mode. If
the mode is enabled, then the block is inserted into the text, starting at the cursor position; otherwise the
copied block overwrites the text on an area of equivalent size.

Fastcopying/moving

Fast copying (moving) the blocks in the same window directly (without the clipboard) is convenient
because it requires pressing of keys only once per operation. Mark a persistent block, then place the
cursor at the destination position and press Shift+F1 to copy, or Shift+F2 to move.

7.3 How to start and debug script files

Starting scripts

Scripts can be started and restarted in several ways. The easiest one uses the commands of the Script
Files dialog:

o to start a new script enter the file name into Start new script file box and click the Start button in the
bottom part of the dialog box;

o to restart a stopped script highlight its name in the dialog window that displays all the loaded scripts
and click the Restart button.

Ascript can be also started by means of the StartCommandFile() function executed by another running
script.

Debugging scripts
Ascript can be started for an immediate execution (read above) and can be launched in the Debug mode
that usually is necessary while you master the script and need to check if it properly works and make
necessary corrections in it. To start the script debugging highlight its name in the ScriptFiles dialog window
and click the Debug button - the program opens the window with the script file's editable text. The window is
split in two panes: the left pane displays the script text, the right one is the AutoWatches pane. If you check
the Debug box then every time when you start a script it will automatically switch to the Debug mode, stop the
script execution and open the window with the script file.
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Scripk: checksum_2.cmd (5,42)

aaaa

0 Save | Step | Run |

| Break |+Watch| Origin |NewPC|Restart|

o Setup

A5 in a buffer.

#include <system.h>
#include <mprog.hc |

vold mainf)

i
S make value for "address space™ from b
int addr_space = ZubLevel(O, 0):

Run to cursar

Qrigin

Mew PC

Toggle breakpoint

Add ko Watches window
Restart

£ calculate checksum for data at addres
unsicmed char checksum = Checkfum(0, Ox1

AF place checksum at address 0x2000
SetByte(0xzZ000, addr_space, checksum):
Right pane on

A/ display checksum value
[ Line numbers

printf ("Checksum = %02¥", checksum):

Help on window, ..
CKSUM_2" 1d: £, Stopped, PC=0006002E ["CHECKSLUM,

Atmel ATBICH1

Device: Properties

/4 This example demonstrates how to calculate @ checksum for data

Help on word under cursor

checksun=0

o)

Crl+T

Chrl+U A

Fa - ||addr_space=0

Chrl+O S 5

CHrk+N SEh

2. Chrl4B checksum=0, addr_space=0
)

Sk checksun=0

Chrl+E

addr_space=0, checksum=0

—||checksun=0
o|[Checkauu=0=D01187F, checksum=0

3
—prrrraEnEthecking cell

Syntax constructions and the lines, which correspond to

the current PC value (blue strip) and the breakpoints

(red strips), are highlighted in the script file text (for more information, see Syntax Highlighting).

Local menu and toolbar

The local menu window contains the following commands, most of which are duplicated by the

corresponding buttons on the window toolbar:

Executes one operator of the script.

Starts continuous execution of the script in the

window. Then the script execution can be broken
either by hitting a set breakpoint or by the command

Executes the script up to the line where the caret is

positioned (the corresponding address).
Alternatively, you can double-click the line to carry

Stops the running script.

Displays the source text from the line whose

address corresponds to the script file Program
Counter. This operation is not available when
source text lines do not exist for the program

Sets the script file’s Program Counter value to the

address corresponding to the line where the caret is

Command Window Toolbar Description
Step Step
Run Run

Stop.
Runto Cursor

out this command.

Stop

Origin Origin

addresses.
New PC New PC

positioned.
Toggle Breakpoint Break

Sets up or clears the breakpoint at the address
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corresponding to the line where the caret is
positioned. When you execute the Run or Runto
cursor command the program execution will be
stopped at the breakpoint.

Add to Watches +Watch Opens the Watches window (if not yet opened) and
Window places the name at the caret position into it.
Restart Restart Restarts the highlighted script.

Note. To get help on a function or variable, point to the function or variable with the cursor and click. For
more information, see How to Debug a Script File and ScriptFiles.

For customizing the ChipProg user interface and debugging purposes scripts themselves can open two
types of additional windows: the User window and the I/O Stream window.

7.3.1 The AutoWatches Pane

The ChipProgUSB program displays a visible portion of the script in the Script window. The names of
variables, called AutoWatches, which belong to the visible script lines, are listed together with their
current values in the right pane of the window. When you scroll through the Script window the contents of
the AutoWatches pane automatically refreshes.

The AutoWatches can be presented in the pane in the binary, hexadecimal, decimal or ASCII formats. To
set the format you need to click the Setup button on the pane local toolbar or right click on the pane space
to open the local menu.

7.3.2 The Watches Window

While the AutoWatches pane of the Script window displays values of the script variables visible in the
current window scope you may want to monitor changing other explicitly specified script variables and
expressions. To do so the ChipProgUSB allows opening the Watches windows. For each variable, the
window displays its name, value, type and address, if any.

Anewly opened Watches window has one Main tab. You can add custom tabs (with the Display Options
command of the local menu) or rename any existing tabs. The tabs operate independently of each other;
each tab is functionally equivalent to a separate Watches window. However, if needed, you can open
several Watches windows.

Each of the above windows has the +Watch button on its toolbar. Clicking this button opens a dialog for
adding a selected object to the Watches window.
Grids in the Watches window

For better readability the Watches window can be divided in cells by vertical and horizontal grid lines.
Enable the grids to be visible within the Watches window by checking the corresponding boxes in the
Configure menu > Environment > Fonts tab.
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Local menu

The window local menu contains the following commands, most of which are duplicated by corresponding
buttons on the window toolbar.

Command

Add Watch

Delete Watch

Delete All Watches

Modify

Move Watch Up

Move Watch Down

Display Options

Description

Adds one or more objects to the window. Opens the Add Watch dialog to
choose an object by name. Also, you can enter an expression as a name.

Deletes a selected object from the Watches window.

Deletes all watches from the window.

Opens the Modifydialog to set a new value for a selected variable.
Alternatively, just enter the new value.

Moves a selected watch up the list.

Moves a selected watch down the list.

Opens the Display Options dialog to change the display settings for a
selected object and also to add/delete tabs to/from the window.

7.3.2.1 The Display Watches Options Dialog

Use this dialog to set the display options for the selected variable or expression in the Watches window.

Element of dialog

Description

Watch Expression

Display Format

Pop-up Description

Display Bit Layout

Display Bit Descriptions

Auto-size Name Field

Tabs
AddTab

Contains a selected expression. The drop—down list contains the
previously used expressions.

Specifies the format for displaying a selected expression (binary,
hexadecimal, decimal or ASCII).

Contains check boxes that let you choose formats for displaying pop-
up SFR descriptions.

If this box is checked the SFR bits will be displayed in the pop-up layout
descriptions.

Checking this box enables displaying the pop-up descriptions for the
SFR bits, if any.

When this box is checked and when the vertical grid is visible (see note
below), the window automatically adjusts the Name column width to fit
the longest record in the column.

Lists all the tabs present in the window.

Opens the Add New Tab to Watches Window dialog for entering a
new tab’s name. The window adds this new tab upon pressing OK.
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Remove Tab Removes the tab selected in the Tabs list.

Edit Tab Name Opens the Edit Watch Window Tab Name dialog for editing the tab
name.

Global Debug/Display Opens the Debug Options dialog.

Options

Note. To make grids visible in the Watches window open the Configure menu, the Environment dialog,
the Fonts tab and check corresponding boxes in the Grid field.

7.3.2.2 The Add Watch Dialog

Use this dialog box to add symbol names (for example, a variable name or an expression) to the Watches
window. The dialog contains a list of the symbol names defined in or known to the program.

Element of dialog Description

Name or expression to Enter into this box the symbol name or expression to be added. You

watch: can specify several names and expressions either manually
(separated with semicolons) or by selecting in the list with the Ctrl key
pressed.

History The list of previous names and expressions.

7.3.3 The User Window

The User window is a window that can be created by means of the built-in OpenUserWindow function
executed from the script itself. The User windows enable:

e drawing graphical objects (indicators, LEDs, buttons, arrows, etc. by means of the built-in graphical
output functions;

o displaying texts in the window;

e responding to the events displaying in the User windows (see WaitWindowEvent).

With this capability, you can organize window operations in the interactive mode. For more information,
see ScriptFiles.

All functions working with windows (including the User window) obtain the window identifier (handle) as
a parameter. Therefore, you can have several windows of this type opened at the same time.

The User windows do not have a local menu. They only have toolbars with 16 buttons (0...F), and each
button can be programmed to perform a certain function. Pressing a button generates the
WE_TOOLBARBUTTON event.
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7.3.4 Thel/O Stream Window

The 1/0 Stream window is a window that can be created by means of the built-in OpenUserWindow
function executed from the script itself. Script files use windows of this type to display I/O streams in the
form of text. The most usual examples of I/O streams are displaying the characters inputted from the PC
keyboard and text messages outputting by the scripts. Also, you can reassign I/O streams to files and
input data from files.

The functions, which operate with windows (including the I/O Stream window), receive the window
identifier (handle) as a parameter. Therefore, several windows of this type can be open at the same time.

When the text display function sends text to this window, the window displays the text from the current
cursor position. To begin the next line, this function outputs \n' (the line feed character).

The window features two text display modes: with the automatic line advance (Wrap) and without it. In the
automatic line feed mode, every text line that does not fit in the window is wrapped to the next line. In the
other mode, if the line does not fit in the window, its end will lie beyond the window border and will be
invisible. The Wrap button in the toolbar toggles the window between these modes. The Clear button
clears the window contents.

Windows of this type do not have a local menu.

8 References
8.1 Command line keys

The ChipProgUSB can be launched from the command line with addition of optional keys (parameters)
that vary the program default configuration and/or automatically executes some function.

The command line mnemonic is: UPROGNT2.EXE/Keyl/Key2... , where each '/Key' parameter specifies
a certain function as described in the table below. (more than one key can follow the executable file;
each '/KeyX' parameter should be separated by a space symbol from each other and from the
executable file). The '/KeyX' parameters below are case-insensitive. See the command line example
below.

Keys Description

/S<file> Opens the program with a pre-loaded Session configuration file, the name of
which is specified in the <> brackets. This Session configuration file is loaded
instead of the default one. The default session file UPROG.ses resides in the
ChipProgUsB folder.

/D<file> Opens the program with a pre-loaded Desktop configuration file, the name of
which is specified in the <> brackets. This Desktop configuration file is loaded
instead of the default one. The default session file UPROG.dsk resides in the
ChipProgUsSB folder.

/O<file> Opens the program with a pre-loaded Option configuration file, the name of
which is specified in the <> brackets. This Option configuration file is loaded
instead of the default one. The default session file UPROG.opt resides in the
ChipProgUsB folder.

/C"<device_name>" Opens the program with a pre-selected device type, which is specified in the <>
brackets. If the device_name does not exist in the ChipProg database the
program will immediately open the Select device dialog.

[L<file> Opens the program with a pre-loaded file, the name of which is specified in the
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[F<format>

IA

N

/11

n2

/ES<script_file>

IGANG
M

<> brackets. A full path to the file should be specified. If the specified file cannot
be found the program will immediately opens the LoadFile dialog.

This key works together with the '/L<file>' and specifies the format of the file to
be loaded.

Opens the program that is configured and ready for AutoProgramming. The
list of the functions preset for AutoProgramming is defined by the loaded
ConfigurationFiles.

This key is used when some external application controls the ChipProg
programmer and the ChipProgUSB window should be invisible. The command
line with the '/I' key starts the ChipProgUSB program but it works in the
background.

This key is similar to the '/I' key with the following addition - the program does
not write error messages to the console buffer.

This key is similar to the '/I1' key with the following addition - the program
copies error text to the system clipboard.

The ChipProgUSB executes a script file, the name of which is specified in the
<> brackets.

Starts the ChipProgUSB program in the multi-programming mode.
The Demo mode.

Note. The file names above must follow the parameter without a blank space.

Here is an example of the command line that controls the ChipProg:

"C:\Program Files\Chipprogusb\4_57_00\uprognt2.exe"/Lc:\work\program.hex/FH/A/12.

The command above starts the C:\Program Files\Chipprogusb\4_57_00\uprognt2.exe program in the
hidden mode, loads the file c:\\work\program.h in the Intel HEX format, starts AutoProgramming,
completes the application that controls the programmer and if there is an error then copies it to the

computer clipboard.

8.2 Errors Messages

Enter topic text here.

8.2.1 Error Load/ Save File

5005 "Error reading file"

5004 "CRC mismatch, loading terminated"

5003 "Invalid .HEX file format"

5043 "Address out of range”

5078 "End address should be greater than start address”

5151 "Invalid file format"
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5007 "Error writing file"
6899 "Cannot load file '%s": buffer #%u does not exist"
6900 "Cannot load file '%s": sub-level #%u does not exist"

7019 "Unable to open project file: '%s'".\n\nAfter start, the programmer attempts to load the most recent project.
This error means that the project file does not exist on disk."

8.2.2 Error Addresses

5189 "Device start address (0x%LX) is too large.\nMax. address is 0x%LX."
5190 "Device end address (0x%LX) is too large.\nMax. address is Ox%LX."
5191 “Buffer start address is too large"

4024 "Address %s is out of range (%s...%s)"

4106 "File format does not allow addresses larger than OXxFFFFFFFF"
4019 "Address in device: 0x%08X, Address in buffer: 0x%08X\n"

6626 "Buffer start address must be even"

6627 "Device start address must be even"

6628 "Buffer end address must be odd"

8002 "Buffer named '%s' already exists. Please choose another name for the buffer."

8.2.3 Error sizes

6372 "Buffer size is too small for selected split data option™

6495 "Requested buffer size (%lu) is too large”

6441 "Size of file is greater than buffer size:\nAddr = %08IX, length = %u"
6431 "Source block does not fit into destination sub-level”

6859 "File size is %u bytes that is less than header size (%u bytes), loading terminated. Probably, you have
specified an invalid file format."

4107 "Cannot allocate %Lu MBytes for the buffer, maximal buffer size is %Lu MBytes"

5192 ‘"Invalid number: '%s"
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8.2.4

8.2.5

8.2.6

8.2.7

Error command-line option

5329 "/%s command-line option: Device name required"
5330 "/%s command-line option: Missing file name"
5331 "/%s command-line option: Missing file format tag"
5332 "/%s command-line option: Invalid file format tag"
5333 "Command line: unable to determine the file format”
5334 "/%s command-line option: Invalid address value"

4104 "Command-line option /I ignored because /A option is not specified"

Error Programming option

6409 ‘"Invalid programming function or menu name:\n'%s"
6410 ‘"Invalid programming option name '%s"

6902 "Invalid '%s' programming option value string: '%s™

6411 "Programming option '%s' cannot be changed"”

6412 "Programming option string is too long.\nMax. length is %u."

6854 "Programming option '%s' has type of '%s'. Use '%s()' script function to get the value of this option."
5188 "Value %.2f is out of range of %.2f...%.2f for programming option '%s™

6561 "Value %ld is out of range of %ld...%Id for programming option '%s"

4001 "Not all of the saved auto-programming functions were restored. Check the auto-programming functions
list."

Error DLL

6499 "Cannot find bit resource with id 0x%X in DLL:\n'%s"
6500 "Error handling bit resource with id 0x%X in DLL:\n'%s™

6502 "Unable to find device '%s' in DLL:\n'%s"

Error USB

4015 "USB device driver error 0x%04X in '%s'.\n\nCannot recover from this error, exiting.\n\nPlease check if
the programmer power is on. If yes, disconnect the USB cable from computer and connect it again, then restart
the %s shell."

4016 "All sites reported USB device driver error.\n\nCannot recover from this error, exiting.\n\nPlease check if
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the programmer(s) power is on. If yes, disconnect the USB cable from computer and connect it again, then
restart the %s shell."

4017 "The following site(s):\n\n%s\n\nreported USB device driver error.\n\nThese site(s) will be removed from

the gang programming process.\n\nPlease check if the programmer(s) power is on. If yes, disconnect the USB
cable from computer and connect it again, then restart the %s shell."

8.2.8 Error programmer hardware

6546 "Source area does not fit into destination address space"

4005 "Attempt to read memory beyond buffer end: Addr = %s, len = %u bytes"

6988 "Unable to establish connection with programmer hardware. Please check if:\n\n"

4006 "Attached programmers have duplicate serial number '%s™

4010 "This programmer with serial number '%s' has been already assigned the site number = %u"

4011 "This gang programmer with serial number '%s' has been already assigned the site numbers = %u..%
o

4013 "The programmers attached are of different types and cannot be used for gang mode.\n\nExiting."
4014 "ExecFunction() does not work in Gang mode"

4020 "%s reported hardware error 0x%X, error group 0x%X. If problem persists, please contact Phyton."
4000 "The attached programmer with id = %u is not supported”

4102 "Device programming countdown value is zero%s"

8.2.9 Errorinternal

6527 "Internal error:\nCORE() for %s %s returned NULL.\nPlease contact your %s distributor."

4025 "Internal Error: Unable to allocate %u bytes for the buffer. Please contact Phyton."
8.2.10 Error configuration

6503 "No programmer configuration files found (prog.ini)"

5325 "The device type '%s %s' stored in configuration "
"or choosen from script file function 'SetDevice()' is not supported by %s.\n"
"The device '%s %s' will be selected.\n"
"Use 'Configure / Select device' to choose the device "
"you need to operate on."

4002 "The '%s' configuration option has been set to an illegal state due to the data read from file. Setting this
option to its default state ('%s")."
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8.2.11 Error device

5326 "Device selection error"

4018 "Device '%s' is not supported by the %s. Please choose another device."

8.2.12 Error check box

6852 "Error in check box option specification string: '=" expected"”

6853 "Cannot find check box option string '%s™

8.2.13 Error mix

5195 " Number of repetitions cannot be zero"

5206 "The 'View only' option is on; editing disabled. Click the 'View' button on toolbar to enable editing."
6501 "No power-on tests defined in:\n'%s™

6903 "%s'is a sub-menu name, not a function name"

6401 "No more occurences"

6387 "Invalid fill string"

5172 "Checksum = %08IX"

5311 "No more mismatches"

8.2.14 Warning

5338 "Warning: JEDEC file has no file CRC"
5339 "Warning: JEDEC file has invalid CRC"
6933 "Warning: no 'file end' record in file"

6845 "Attention! The %s %s device must be inserted into the programmer's socket shifted by %d row(s)
relative to the standard position as shown in the Device Information window."

6846 "Attention! Insert device into socket shifted by %d row(s) as shown on the picture."

8.3 Expressions

Expressions in the program are the mathematical constructions for calculating results with the use of one
or more operands. It supports various operations on expressions. The following operands are used:

e numbers
o example of expressions

© 2009 Phyton, Inc. Microsystems and Development Tools



158 ChipProg Device Programmers

When a number is required, you may use an expression; <%CM%> will accept the value of the expression.
For example, when using the Modify command in the Buffer window, you can enter the new value in the
form of a number or arithmetic expression.

Interpreting the expression result
The expression result is interpreted in accordance with the context in which it is used.

In the dialog box, when an address is required, the program tries to interpret the expression’s value as the
address. If you enter a variable name, the result of the expression will be the variable’s address but not the
value of the variable.

If the dialog expects a humber to be entered, the expression’s value will be interpreted as a number (for
example, the Modify Memory dialog box of the Buffer Dump window). If you enter a variable name there,
then the result will be the value of the variable, but not its address.

Nonetheless, you can follow the default rules:

If you need to use the variable’s value, where an address is expected, then you can write something like
var + 0. In this case, the variable’s value will be used in the expression.

If you need to use the variable address, apply the & (address) operation, that is, &var.

8.3.1 Operations with Expressions

The program supports all arithmetic and logical operations valid for the C language, as well as pointer
and address operations:

Designation Description
) Brackets (higher priority)
[1 Array component selector

8 Structure component or union selector
-> Selection of a structure component or a union addressed with a pointer
Logical negation

~ Bitwise inversion

- Bitwise sign change

& Returns address

* Access by address

(type) Explicit type conversion

(sizeof) (returns size of operand, in bytes)

* Multiplication

/ Division

% Modulus operator (produces the remainder of an integer division)
+ Addition
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- Subtraction

<< Left shift

>> Right shift

< Less than

<= Less than or equal to
> Greater than

>= Greater than or equal to
== Equal to

1= Not equal to

& Bitwise AND

n Bitwise XOR

| Bitwise OR

&& Logical AND

11 Logical OR

= Assignment

The types of operands are converted in accordance with the ANSI standard.
The results of logical operations are 0 (false) or 1 (true).

Allowed type conversions:
e Operands can be converted to simple types (char, int, ... float).
e Pointers can be converted to simple types (char *, int *, ... float *) and to structures or unions.
e The word "struct" is not necessarily (MyStruct *).

8.3.2 Numbers

By default, numbers are treated as decimals. Integers should fit into 32 bits; floating point numbers should
fit into the single precision format (32 bits).

The following formats are supported:
1) Decimal integer.

Example: 126889
2) Decimal floating point.

Examples: 365.678;2.12e-9

3) Hexadecimal.
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<%CM%> understands numbers in C format and assembly format.
Examples: OxF6D7; OF6D7H; OXFFFF1111

4) Binary.

Binary numbers must end with 'B'.
Examples: 011101B;111111111111111000011B

5) Symbol (ASCII).

Examples: "a"; "ab"; "$B%8".".

8.3.3 Examples of Expressions

Examples of expresions

#est#i + #test#j << 2
(unsigned char)#test#i + 2
sizeof(##array) > 200

main
i+j<<2/:CW0x1200
(unsigned char)i + 2
sizeof(array) > 200
(@a==b&&a<=4)||a>"3
sptr -> Member1 -> a]i]

P

*((char*)ptr)

8.4  Script Language

The program ChipProgUSB can execute so-called script files in a way similar to how DOS executes the
batch files.

The main objective of script files is to automate usage of the emulator. Using script files makes it
possible to load programs, set up breakpoints, start program execution, manipulate windows and
perform any actions available to you in automatic (batch) mode. It is also possible to display various
messages in the Consolewindow or other special windows, to create user's custom menus, etc. There
is the option of displaying any graphical data in special windows.

The script language is similar to C: almost all C constructions are supported, except for structures,
conjunctives and pointers. However, there are some differences. There are also many built-in functions

available, such as printf(), sin() and strcpy().

The extension of script source file is .CMD.

Simple example of a script file
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How to write a script file
How to start a script file
How to debug a script file

Description of Script Language

Script Language Built-in Functions

Script Language Built-in Variables

Difference Between the Script Language and the C Language

Alphabetical List of Script Language Built-in Functions and Variables

8.4.1 Simple example

This example shows how to load a file and automatically program it and display the result.

#include <system.h>
#include <mprog.h>

void main()
{

LoadProgram("test.hex", F_HEX, SubLevel(0, 0)); /I load file "test.hex" that is an Intel HEX
file I
to buffer 0, sub-level 0

InsertTest = TRUE; /I set testing of chip presence to "on"

if (ExecFunction("Auto Programming") == EF_OK) /I perform an automatic programming

{

if (ExecFunction("Verify", SubLevel(0, 0), 10) = EF_OK) /I verify 10 times
{
printf("Verify failed: %s", LastErrorMessage); /I display error message if verify failed
return; /l terminate script
}
printf("Verify ok."); /I display Ok result
}
else
printf("Programming failed: %s", LastErrorMessage); /I display error message
}

8.4.2 Description

The language used for writing the script files is similar to the C language. If you are familiar with the C
language, you can skip this chapter and switch to reading about the differences between the script
language and the C language.

This manual contains just a few examples of programming in the script language. To find more
examples, refer to books on the C language.

General Syntax of Script Language
Basic Data Types
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Data byte order

Operations and Expressions

Operators

Functions

Descriptions

Directives of the Script File Language Preprocessor
Predefined Symbols in the Script File Compilation

8.4.3 Built-in Functions

The script file system provides you with a large set of built-in functions intended for work with lines, files,
for mathematical calculations, and access to the processor resources. The system.h file contains
descriptions of these built-in functions. You should include the system.h file in the script file source text
with the #include directive:

#include <system.h>

You can use these built-in functions in the same way you use any function that you have defined.

Buffer access functions

Device programming control functions
Mathematical Functions

String Operation Functions

Character Operation Functions

Functions for File and Directory Operation
Stream File Functions

Formatted Input-Output Functions

Script File Manipulation Functions

Text Editor Functions

Control Functions

Windows Operation Functions and Other System Functions
Graphical Output Functions

I/O Stream Window Operation Functions

Event Wait Functions
Other Various Functions

Note. To get help on a function or variable, while editing the script source with the <%CM%> built-in
editor, point that function/variable name with the cursor and hit Alt+F1.

8.4.4 Built-inVariables

You can access script language built-in variables in the same way as regular global variables. However,
some built-in variables are accessible only for reading, and in case of attempt to write to such variable.

The built-in variables are declared in the system.h header file.

Programming variables:
InsertTest
ReverseBytesOrder
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BlankCheck
VerifyAfterProgram
VerifyAfterRead
ChipStartAddr
ChipEndAddr
BufferStartAddr
LastErrorMessage
DialogOnError

Text editor built-in variables:
InsertMode
CaseSensitive
WholeWords
RegularExpressions
BlockColl
BlockCol2
BlockLinel
BlockLine2
BlockStatus

CurLine

CurCol
LastFoundString

Miscellaneous variables:
WorkFieldwWidth
WorkFieldHeight
AppIName[]
DesktopName[]
SystemDir][]

errno

_fmode
MainWindowHandle
NumWindows
WindowHandles[]
SelectedString[]
LastMessagelnt
LastMessagelLong
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8.4.5

Difference between the Script and the C Languages

The script files are written in a C-type language and you should not expect it to meet standards. Many
features are not supported because they are not necessary and complication of the language can cause
compiler errors (the script file language compiler is not a simple thing).

Pointers are not directly supported. But arrays are supported, therefore a pointer can always be
built from an array and element number. Note that, for example, string operation functions, such as
strcpy, receive a string and a byte number (index) as parameters, which form the pointer. In function
declarations, index is equal to zero by default.

Pointers to functions are not supported. If necessary, a table call can always be replaced with the
switch operator.

Multidimensional arrays are not supported. If it is necessary, you can write a couple of functions,
such as:

int GetElement(int array[], int indexl, int index2);
void SetElement(int array[], int indexl, int index2, int value);

Structures (and unions) are not supported. In fact, you can always do without structures. Structures
may be required for APl Windows and user DLLs operations, but as a rule only experienced
programmers should do it, such as those who know how to reach structure elements. As a tip, there
are functions, such as memcpy, which receive a void "pointer").

Enumerated types (enum) are not supported #define.

Preprocessor macros, such as #define half(x) (x / 2), are not supported. The same operations
can be done with functions.

Conditional operators such as x =y ==27? 3: 4;, are not supported; the operator "comma" outside
variable declaration is not supported. For example,

int i =0, jJ =1; is supported, but
for (i =0, jJ =1; ...) is not supported.
User functions with a variable amount of parameters are not supported. However, there are many
system functions, such as printf, with a variable number of parameters.
Declaration of user function parameters such as void array[] is not supported. The system
functions such as memcpy, have such parameters.
Logical expressions are always fully computed. It is very important to remember it, as a situation
like
char array[10];
if (I <10 && array[i] = 0)
array[i] = 1;

will cause an error at the execution stage, if i is greater than 9, because the expression of array[i] will be
computed. In a standard compiler such an expression is not computed, because the condition of i > 10
would cancel any further processing of the expression.

Constant expressions are always computed during execution. For example, inti =10 * 22 will be
computed not during compilation, but during execution.

The const key word is absent.

Static variables cannot be declared inside functions.

But

Variables can be declared anywhere, not just in front of the first executed operator. For example:

void main()

{

Globalvar = 0;

inti =1; // will be OK as iIn C++
b

Nested comments are allowed.
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u Expressions like array = "1234" are allowed.

" Default parameter values in declared functions, as in C++, are allowed. For example, void func
(char array[],int index = 0);. Expressions can also serve as default values, for example void func(char
array[], intindex = funcl() + 1);.

N Expressions in global variable initializers are allowed. For example:

float table[] = { sin(0), sin(0.1) };

void main()

{
L

8.4.6 Script Language Built-in Functions and Variables

The list below includes all the names of the script language built-in functions and variables:

AllProgOptionsDefault
API
ActivateWindow
AddButton
AddWatch
AppINamel[]
BackSpace
BlankCheck
BlockBegin
BlockColl
BlockCol2
BlockCopy
BlockDelete
BlockEnd
BlockFastCopy
BlockLinel
BlockLine2
BlockMove
BlockOff
BlockPaste
BlockStatus
BufferStartAddr
CaseSensitive
CheckSum

ChipEndAddr
ChipStartAddr

ClearWindow
CloseProject
CloseWindow
Cr

CurChar
CurCol
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CurLine

Curcuit

DelChar

DelLine
DesktopName]]
DialogOnError
DisplayText
DisplayTextF
Down

Ellipse

Eof

Eol

ExecFunction
ExecMenu
ExecScript
ExitProgram

Expr

FileChanged
FillRect
FindWindow
FirstWord
FloatExpr
ForwardTill
ForwardTillNot
FrameRect
FreeLibrary
GetByte

GetDword
GetFileName
GetLine

GetMark
GetMemory
GetProgOptionBits
GetProgOptionFloat
GetProgOptionList
GetProgOptionLong
GetProgOptionString
GetScriptFileName
GetWindowHeight
GetWindowWidth
GetWord

GotoXY
InsertMode
InsertTest

Inspect

InvertRect
LastChar
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LastErrorMessage
LastEvent
LastEventint{1...4}
LastFoundString
LastMessagelnt
LastMessagelLong
LastString

Left

LineTo
LoadDesktop
LoadLibrary
LoadOptions
LoadProgram
LoadProject
MainWindowHandle
MaxAddr
MessageBox
MessageBoxEXx
MinAddr

MoveTo
MoveWindow
NumWindows
OpenEditorWindow
OpenStreamWindow
OpenUserWindow
OpenWindow
Polyline
ProgOptionDefault
Rectangle
RedrawScreen
RegularExpressions
ReloadProgram
RemoveButtons
ReverseBytesOrder
Right

SaveData
SaveDesktop
SaveFile
SaveOptions
Search
SearchReplace
SelectBrush
SelectFont
SelectPen
SelectedString[]
SetBkColor
SetBkMode
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SetByte
SetCaption
SetDevice
SetDWord
SetFileName
SetMark
SetMemory
SetPixel
SetProgOption
SetTextColor
SetToolbar
SetUpdateMode
SetWindowFont
SetWindowsSize
SetWindowSizeT
SetWord
SystemDir([]
TerminateAllScripts
TerminateScript
Text

Tof

Up
UpdateWindow
VerifyAfterProgram
VerifyAfterRead
WaitEprTrue
WaitGetMessage
WaitSendMessage
WaitWindowEvent
WholeWords
WindowHandles[]
WindowHotkey
WordLeft
WordRight
WorkFieldHeight
WorkFieldWidth
_GetWord
_ff_attrib

_ff_date

_ff nhame

_ff _size

_ff time

_fmode

_fullpath

_printf

abs

acos
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asin
atan
atof

atoi

ceil
chdir
chsize
clearerr
close
cos
creat
creatnew
creattemp
delay
difftime
dup
dup2
eof
ermo
exec
exit
exp
fabs
fclose
fdopen
feof
ferror
fflush
fgetc
fgets
filelength
fileno
findfirst
findnext
floor
fmod
fnmerge
fnsplit
fopen
fprintf
fputc
fputs
fread
freopen
frexp
fscanf
fseek

© 2009 Phyton, Inc. Microsystems and Development Tools



170

ChipProg Device Programmers

ftell
fwrite
getc
getcurdir
getcwd
getdate
getdfree
getdisk()
getenv
getftime
gettime
getw
inport
inportb
isalnum
isalpha
isascii
isatty
iscntrl
isdigit
isgraph
islower
isprint
ispunct
isspace
isupper
isxdigit
itoa

lock
locking
log

log10
Iseek
ltoa
memccpy
memchr
memcmp
memcpy
memicmp
memmove
memset
mkdir
movmem
mprintf
open
outport
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outportb
peek
peekb
poke
pokeb
pow
powl0
printf
pscanf
putc
putenv
putw
rand
random
randomize
read
rename
rewind
rmdir
scanf
searchpath
setdisk
setftime
setmem
setmode
sin
sprintf
sqrt
srand
sscanf
stpcpy
strcat
strchr
strcmp
strcmpi
strcpy
strcspn
stricmp
strlen
striwr
strncat
strncmp
strncmpi
strncpy
strnicmp
strnset
strpbrk
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8.5

8.5.1

strrchr
strrev
strset
strspn
strstr
strtol
strtoul
strupr
tan

tanh

tell
toascii
tolower
toupper
ultoa
unlink
unlock
wgetchar
wgethex
wgetstring
wprintf
write

In-System Programming for different devices

NOTE! Always carefully check connecting your ChipProg programmer to the target. Wrong
connecting may and probably will cause destruction of the programmer's and/or the target
system's hardware.

Most embedded microcontrollers have different algorithms for the ISP procedure. See the following
topics regarding the ISP for popular microcontrollers:

Specific of the in-system programming of the Microchip PICmicro

Specific of the in-system programming of the Atmel AVR microcontrollers

Specific of the in-system programming of the Atmel 8051 microcontrollers

Specific of programming PICmicro

1. Most of the PIC microcontrollers produced by Microchip Technology Corporation require a special
HV ISP Programming Mode (High-Voltage in-System Programming Mode). In this mode a relatively
high voltage of 13V is applied to the MCLR device pin. The user's equipment to be programmed
should be designed in the way tolerating a 13V signal to be applied to the MCLR device pin - in
particular this pin should not be connected to the Vcc pin of the device.
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2. Though the PIC microcontrollers are capable to work in a certain range on the Vcc voltage (the
range varies from 2 to 5V for some PICmicro derivatives) the device being under programming must
have the 5V voltage level applied to the Vcc device pin. If in the working mode the target
microcontroller works under the Vcc lower than 5V and the target cannot tolerate applying the 5V
voltage to the Vcc pin, then, if the user needs to program the PICmicro device in-system, it is
necessary to change the schematic to have an ability to connect 5V to the Vcc pin while the target
is under the programming. However, verification of the correct programming can be conducted under
the voltages allowed by the manufacturer (Vcc min - Vcc max).

8.5.2 Specific of programming AVR microcontrollers

Microcontrollers of the Atmel AVR series can be programmed in-system being under a normal Vcc
voltage. Practically all AVR microcontrollers require clocking while they are under in-system
programming. ChipProg programmers are capable to send clocks to the target microcontroller but
sometimes the systems based on AVR microcontrollers have their own built-in clock generators.

1. If the system has its own built-in clock generator then make sure that the clock line of the
ChipProg cable adapter is not connected to the clock input pin of the target microcontroller,
otherwise it may destroy either the target or programmer hardware. What you need in this case is
just to enter a value of the generator clock frequency in the Algorithm Parameters > Oscillator
Frequency field in the Device and Algorithm Parameters Editor window (see on the picture
below). By default the Oscillator Frequency value is 2.5 MHz. To change it double click the
Oscillator Frequency line displayed in blue color and enter the Fclk value into the popped up
dialog. If the actual clock frequency differs from the value set in the window the correct programming
will be impossible.

Device and Algarithm Paramieters Editor =E =]

Edit | 0 | Al Detault |
M ame Yalue Desclf@til:nn
Device Parameters  [Set all values to defaults|
Lock bits Lack bits
Calibration Bute 00k Calibration value far the internal BC Decillz
Algonthm Farameters
- Algarithm "Im-Spztemn Programming'’ | Programming algorithm
Dzcillator Freguency | 2600 kHz Ozcillator frequency
Wi B.00Y Fower supply woltage
Device n Formatior 2808
Socket Scheme | Naotes
Device: Atmel | ATmegal28L [ISF Mode]
Adapter[z]: In-System: AE-ISP-U1

Socket scheme

2. If the target system does not have its own built-in clock generator then, the target AVR device
needs to get clocks from the ChipProg built-in generator; thus the clock output wire of the cable-

adapter should be connected to an appropriate clock input pin of the target device. By default the
Fclk= 2.5 MHz. It can be set in the range of the Fclk allowed for a particular selected target AVR
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device in the Algorithm Parameters > Oscillator Frequency field in the Device and Algorithm
Parameters Editor window (see the picture above).

8.5.3 Specific of programming Atmel 8051 microcontrollers

Microcontrollers of the Atmel 8051 family (AT89 series) can be programmed in-system being under a
normal Vcc voltage. Practically all these microcontrollers require clocking while they are under in-
system programming. ChipProg programmers are capable to send clocks to the target microcontroller
but sometimes the systems based on the Atmel 8051 microcontrollers have their own built-in clock
generators.

1. If the system has its own built-in clock generator then make sure that the clock line of the
ChipProg cable adapter is not connected to the clock input pin of the target microcontroller,
otherwise it may destroy either the target or programmer hardware.

2. If the target system does not have its own built-in clock generator then, the target device
needs to get clocks from the ChipProg built-in generator; thus the clock output wire of the cable-
adapter should be connected to an appropriate clock input pin of the target device.
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ISP
ISP HV Mode 9
ISP Mode 9
JEDEC 75
List

Adapters connections 77
Load file

dialog 74
Load session 39
Load the file into the buffer 83
Log file 47
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Main menu
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Main menu bar 37
Mapping
hot keys 51
Marking bad blocks 89
MCS-51 microcontroller 174
Memory Dump Window Setup
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Menu
Project 40
View 39
Menu File
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save file 38
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tab 52
Microchip PICmicro microcontroller
Miscellaneous Settings 52
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dialog 72
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Multi-File Search Results

dialog 143
Multi-programming mode 96
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NAND 85
NAND Flash 85
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Large page 85
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Small page 85
NAND Flash memory
Programming NAND devices 85
NAND Flash programming
Access mode 90
Device and Algorithm Parameters
Device Parameters 90
Numbers 159
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Odd byte 63
On-line Help 34
Open Project 41
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Operations with Memory Blocks 72

Options
dialog 49
Optionsé&split
dialog 62, 98
Overview

User Interface 36

172

90

_P-

Packages/Adapters 43

POF 75
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PRG 75

Program a Device 82
Program Manager
Auto Programming 60, 98
dialog 60, 98
Operation Progress 60, 98
window 60, 97
Program, Write 56
Programmer 8
ChipProg-40 31
ChipProg-48 30
ChipProg-G4 32
ChipProg-ISP 33
work with 81
Programmers
ChipProgusB 12
comparison characteristics 12
Programmers ChipProg-40 16
Programmers ChipProg-48 13
Programmers ChipProg-G4 18
Programmers ChipProg-ISP 21
Programming
check blank 82
configure the device 83
duplicate a device 85
edit Information 83
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load the file 83
program a Device 82
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read a device 84
save the data 84
verify 84
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Programming adapters 77
Programming automation 103
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Reserved Block Area Parameters
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RBA parameters 95
Reserved Block Area 95
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Save file from buffer
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Save session 39
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menu 58
Script Files 135, 160
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Script Language Built-in Functions 162
Script Language Built-in Variables 162
Script source window
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Search for Text

dialog 140
Search mask 43
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Select device 43

dialog 43
Serialization 45
Serialization, Checksum, Log file
dialog 45
Set device into a socket 81
Set/Retrieve Bookmark
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Skip Block method
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Solid Area Parameters
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Sounds 49
Spare Area Usage
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Splitdata 63
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Support 34
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Undo Count 53
USB Drivers 27
User
window 151
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User Interface
overview 36
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Verify programming 84
View 39
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Watches
window 149
Watches Window
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Window
menu 59
Menu Window 59
Window Device Information 77
Window Dump Setup
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Window Editor 138
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Windows 59
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